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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an
overview of the COMSOL® environment with examples that show you how to use
the COMSOL Desktop® user interface and the Model Builder. It also provides a
quick introduction to creating applications using the Application Builder.

If you have not yet installed the software, install it now according to the
instructions at www.comsol.com/product-download.

In addition to this book, an extensive documentation set is available after
installation. Tutorials can be found throughout the COMSOL website, including
in the Video Gallery at www.comsol.com/videos and on the COMSOL Blog at
www.comsol.com/blogs.


http://www.comsol.com/product-download
www.comsol.com/video/
www.comsol.com/blogs

COMSOL Desktop®

QUICK ACCESS TOOLBAR — Use these
buttons for access to functionality such as file
open/save, undo/redo, copy/paste, and delete.

APPLICATION BUILDER —
Click this button to switch to

RIBBON — The ribbon tabs have buttons
and drop-down lists for controlling all
steps of the modeling process.
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MODEL TREE — The model tree
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model as well as processing the results.
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GRAPHICS WINDOW — The Graphics window presents
interactive graphics for the Geometry, Mesh, and Results

nodes. Operations include rotating, panning, zooming, and
selecting.

Table

INFORMATION W INDOWS — The Information windows will display vital
model information during the simulation, such as the solution time, solution
progress, mesh statistics, solver logs, and, when available, results tables.
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The screenshot on the previous pages is what you will see when you first start
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL
Desktop™ user interface provides a complete and integrated environment for
physics modeling and simulation as well as application design, providing you with
the tools necessary to build a user-friendly interface for your models. You can
customize the desktop to your own needs. The windows can be resized, moved,
docked, and detached. Any changes you make to the layout will be saved when
you close the session and available again the next time you open COMSOL
Multiphysics. As you build your model, additional windows and widgets will be
added. (See page 24 for an example of a more developed desktop.) Among the
available windows and user interface components are the following;:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo,
Redo, Copy, Paste, and Delete. You can customize its content from the Customize
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete
most modeling tasks. The ribbon is only available in the Windows® version of the
COMSOL Desktop environment and is replaced by menus and toolbars in the
OS X and Linux® versions. Click the Application Builder button to switch from the
Model Builder to the Application Builder and start building an application based
on your model.

Settings Window

This is the main window for entering all of the specifications of the model,
including the dimensions of the geometry, properties of the materials, boundary
conditions and initial conditions, and any other information that the solver will

8|



need to carry out the simulation. The picture below shows the Settings window for
the Geometry node.

Model Builder ~ *|| Settings
2 = v ETE =~ Geometry
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(B Results CAD kernel -
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| Automatic rebuild
Plot Windows

These are the windows for graphical output. In addition to the Graphics window,
Plot windows are used for visualizing results. Several Plot windows can be used to
show multiple results simultaneously. A special case is the Convergence Plot
window, an automatically generated Plot window that displays a graphical
indication of the convergence of the solution process while a model is running.

Information Windows
These are the windows for nongraphical information. They include:

* Messages: Various information about the current COMSOL Multiphysics
session is displayed in this window.

* Progress: Progress information from the solver in addition to stop buttons.

* Log: Information from the solver, such as the number of degrees of freedom,
solution time, and solver iteration data.

e Table: Numerical data in table format as defined in the Results node.

* External Process: Provides a control panel for cluster, cloud, and batch jobs.

| 9



Other Windows

 Add Material and the Material Browser: Access the material property libraries.
The Material Browser cnables editing of material properties.

* Selection List: A list of geometry objects, domains, boundaries, edges, and
points that are currently available for selection.

The Windows drop-down list in the Home tab of the ribbon gives you access to
all COMSOL Desktop windows. (On OS X and Linux®, you will find this in
the Windows menu.)

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is
located in the lower right-hand corner of the COMSOL Desktop interface.

Dynamic Help

The Help window provides context-dependent help texts about windows and
model tree nodes. If you have the Help window open in your desktop (by typing
F1, for example), you will get dynamic help (in English only) when you click a
node or a window. From the Help window, you can search for other topics, such
as menu items.

The Model Builder and the Application Builder

The two main components of the COMSOL Desktop environment are the Model
Builder and the Application Builder.

The Model Builder is the tool where you define the model and its components,
such as how to solve it, the analysis of results, and creating reports. You do that by
building a model tree. The model tree reflects the underlying data structure, the
model object, which stores the state of the model including settings for geometry,
mesh, physics, boundary conditions, studies, solvers, postprocessing, and
visualizations.

The Application Builder allows you to quickly create an application with a
specialized user interface that is easy to use. An application is typically based on a
model created with the Model Builder. The Application Builder provides two
important tools for creating applications: The Form editor and the Method editor.
In addition, an application can have a menu bar or a ribbon. The Form editor
includes drag-and-drop capabilities to easily access and include user interface
components, such as input fields, graphics windows, and buttons. The Method
editor is a programming environment that, for example, allows you to modity the
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model represented by the model object data structure. You can also use the
Method editor to add user interface logic and auxiliary functionality to an
application. The Java® programming language is used to write code in the Method
editor, which means that all Java® syntax and Java® libraries can be used.

In the Method editor, program code is stored in methods. A method is another
name for what is known in other programming languages as a subroutine,
function, or procedure. There are two types of methods: application methods and
model methods. Both types of methods can be used to modify the model object
data structure in the Model Builder. A model method is used for modifying the
model object of the current session, whereas an application method is used for a
variety of tasks including moditying the model object in a running application.

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction
to using the Model Builder and a quick introduction to the Application Builder.
For detailed information on how to use the Application Builder, including the
Form editor and Method editor, see Introduction to Application Builder.

Running Applications and COMSOL Server

The Application Builder is included in the Windows® version of COMSOL
Multiphysics. With a COMSOL Multiphysics license, applications can be run from
the COMSOL Desktop environment. Although applications cannot be built with
the macOS or Linux® versions of the software, applications can still be run with
COMSOL Multiphysics on those platforms.

With a COMSOL Server license, applications can be run in major web browsers
on a variety of operating systems and hardware platforms. In addition, you can run
applications by connecting to COMSOL Server with an easy-to-install COMSOL
Client for Windows®.

The COMSOL Client for Windows® allows a user to run applications that require
a LiveLink™ product for CAD (this functionality is not available when running
applications with a web browser).

Running applications in a web browser does not require any installation and no
web browser plug-ins are needed. Running an application in a web browser
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics
rendering in 3D are based on WebGL™ technology, which comes included with
all major web browsers.



To create an application based on your model, click

N . N . CJ 2 R EE
the Application Builder button, accessible from the b= HE
Home tab in thC ribbon Heome Definitions Get
. . . P; Param
For more information on creating COMSOL A < R
applications, refer to the section “Building an Application | Component | Functi

Application” on page 87 and the book
Introduction to Application Builder.

Preferences

Preferences are settings that affect the modeling environment. Most are persistent
between modeling sessions, but some are saved with the model. You access the
preferences from the File menu by selecting Preferences.
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Quick Access Tealbar
Remate Compiding 30 aves: ]
Results ;
Security Color legend: 3
Updates
Image export
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Rotation center
o Auto
1 Set with mouse middle-chick
visibility: | Abuays hide =
Mouse
4 3Dcenneion space mouse
Selections

Requane click in Graphics wandiw to actrste hovering
Fents
) Load system fants
Defauit font
Famiy: | Vera -

Sz Defaultsize =+ pt
Factrry Settings

Factory Settings for Al oK Cancel

L 4

In the Preferences window, you can change settings such as graphics rendering, the
number of displayed digits for results, the maximum number of CPU cores used
for computations, or paths to user-defined application libraries. Take a moment to
browse your current settings to familiarize yourself with the diftferent options.
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There are three graphics rendering options available: OpenGL®, DirectX®, and
Software Rendering. The DirectX® option is not available in macOS or Linux®, but
is available in Windows® if you choose to install the DirectX® runtime libraries
during installation. If your computer does not have a dedicated graphics card, you
may have to switch to Software Rendering for slower but fully functional graphics.
A list of recommended graphics cards can be found at:

www.comsol .C()m/systcm—rcquircmcnts

Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as
shown in the figure below.

o NE R

New

—
Mudel
Wizard

*

Ulank Model

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and
study type in a few steps:

13
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I Start by selecting the space dimension for your model component: 3D, 2D
Axisymmetric, 2D, 1D Axisymmetric, or 0D.
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2 Now, add one or more physics interfaces. These are organized in a number of
physics branches in order to make them easy to locate. These branches do not
directly correspond to products. When products are added to your COMSOL
Multiphysics installation, one or more branches will be populated with
additional physics interfaces.
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3 Select the Study type that represents the solver or set of solvers that will be used
for the computation.

e med@r

m Home  Defiitions  Geomelyy  Matenals Py Mesh
Select Study

4 i Presel Studies
laa Exgenfiequency
laa Ergenvalue
[ Staticnary
laa Thenmal Pertuibation, Eigentrequency
[ Thermal Pertuibation, Frequency Domain
[y Tieme Dependent

Added study:
= Stationsry
Adeled physics mterfaces:

Heat Translen in Sehds (ht)

B Phsics
Help () Concel [ Done

Finally, click Done. The desktop is now displayed with the model tree configured
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any
Component or Study. You can right-click the model tree to add a Component of a
certain space dimension, physics interface, or Study.

The Ribbon and Quick Access Toolbar

The ribbon tabs in the COMSOL Desktop environment reflect the modeling
workflow and give an overview of the functionality available for each modeling
step, including building simulation applications from your models.

o | [ EU S M - Untitled mph - COMSOL Multiphysics
_ [impon & i it
" d - x "oh Ty
A " o ek 5 B i B A = ey %
Agplication  Companent Buikd Add Heat Transfer  Add Build  Mesh Compute Study Add AddPlet | Windows Reset
Busddes z it Funti Al Materisl | in Sl Bhapsics b1 L Study Geoup = = Decp

The Home tab contains buttons for the most common operations for making
changes to a model, running simulations, and for building and testing
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applications. Examples include changing model parameters for a parameterized
geometry, reviewing material properties and physics, building the mesh, running
a study, and visualizing the simulation results.

There are standard tabs for each of the main steps in the modeling process. These
are ordered from left to right according to the workflow: Definitions, Geometry,
Materials, Physics, Mesh, Study, Results, and Developer.

Contextual tabs are shown only if and when they are needed, such as the 3D Plot
Group tab, which is shown when the corresponding plot group is added or when
the node is selected in the model tree.

Cut Line S

333 e £ Fost P v Cut Plars sl 8 Cut Pl

Modal tabs are used for very specific operations, when other operations in the
ribbon may become temporarily irrelevant. An example is the Work Plane modal
tab. When working with work planes, other tabs are not shown, since they do not
present relevant operations.

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model
tree in the Model Builder window. Most of the functionality accessed from the
ribbon is also accessible from contextual menus by right-clicking nodes in the
model tree. Certain operations are only available from the ribbon, such as selecting
which desktop window to display. In the COMSOL Desktop interface for macOS
and Linux®, this functionality is available from toolbars, which replace the ribbon
on these platforms. There are also operations that are only available from the
model tree, such as reordering and disabling nodes.

THE QuICcK ACCESS TOOLBAR

The Quick Access Toolbar contains a set of commands that are independent of the
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar
and add most commands available in the File menu, including commands for
undoing and redoing recent actions, as well as for copying, pasting, duplicating,
and deleting nodes in the model tree. You can also choose to position the Quick
Access Toolbar above or below the ribbon.
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MACOS AND LINUX®

In the COMSOL Desktop environment for macOS and Linux®, the ribbon is
replaced by a set of menus and toolbars.

s

The instructions in this book are based on the Windows® version of the COMSOL
Desktop environment. However, running COMSOL Multiphysics and the
COMSOL Desktop environment in macOS and Linux® is very similar, keeping in
mind that the ribbon user interface components can instead be found in the
corresponding menus and toolbars.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model
tree, adding nodes, and editing the node settings.

All of the nodes in the default model tree are top-level parent nodes. You can
right-click on them to see a list of child nodes, or subnodes, that you can add
beneath them. This is the means by which nodes are added to the tree.

When you click on a child node, you will see its node settings in the Settings
window. It is here that you can edit node settings.

It is worth noting that if you have the Help window open, which is achieved either
by selecting Help from the File menu or by pressing the function key F1, then you
will also get dynamic help (in English only) when you click on a node.

THE RooOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node (initially

labeled Untitled.mph), a Global Definitions Mode
node, and a Results node. The label on the root P

node is the name of the multiphysics model file, - ‘: Ig;t.g;db.:;;:ﬁrﬁgm
or MPH file, to which the model is saved. The Pi Parameters
root node has settings for author name, default & 2 Metersle
unit system, and more.

(ww)

T
(@]
1%

2
4
-

(

= v StEL S

The Global Definitions node has a Parameters

and Materials subnode by default. The Global Definitions node is where you define
parameters, variables, functions, and couplings that can be used throughout the
model tree. They can be used, for example, to define the values and functional
dependencies of material properties, forces, geometry, and other relevant features.
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The Global Definitions node itself has no settings, but its child nodes have plenty
of them. The Materials subnode stores material properties that can be referenced

in the Component nodes of a model.

The Results node is where you access the solution after performing a simulation
and where you find tools for processing the data. The Results node initially has five

subnodes:
 Data Sets, which contains a list of solutions
you can work with.

¢ Derived Values, which defines values to be
derived from the solution using a number
of postprocessing tools.

 Tables, which is a convenient destination for

the Derived Values or for Results generated
by probes that monitor the solution in
real-time while the simulation is running.

=

ode

~Aar
LI

® v =T E

4 & Untitled.mph (root)
4 (7)) Global Definitions
Pi Parameters
2 Materials
4 ([ Results
E Data Sets
£ Derived Values
EH Tables
Export

. . =3 Reports
 Export, which defines numerical data,

images, and animations to be exported to
files.

* Reports, which contains automatically generated or custom reports about the
model in HTML or Microsoft® Word format.

To these five default subnodes, you may also add more Plot Group subnodes that
define graphs to be displayed in the Graphics window or in Plot windows. Some of
these may be created automatically, depending on the type of simulations you are
performing, but you may include additional figures by right-clicking on the Results
node and choosing from the list of plot types.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described,

there are two additional top-level node types: Model Builder wr
= v STELE
Component nodes and Study nodes. These are - =
. 4 & Untitled.mph (root)

usually created by the Model Wizard when you © Global Definitions
create a new model. After using the Model T Component (compl)

- : : ~db Study 1
Wizard to specify what type of physics you are & Resuts

modeling and what type of Study (e.g.,

steady-state, time-dependent,

frequency-domain, or eigenfrequency analysis) you will carry out, the Model
Wizard automatically creates one node of each type and shows you their contents.
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It is also possible to add more
Component and Study nodes as you
develop the model. A model can
contain multiple Component and
Study nodes and it would be
confusing if they all had the same
name. Therefore, these types of
nodes can be renamed to be
descriptive of their individual
purposes.

If a model has multiple Component
nodes, they can be coupled to form a
more sophisticated sequence of
simulation steps.

Note that each Study node may carry
out a different type of computation,
so each one has a separate Compute
button =.

4 @ Untitled.mph [root)
() Global Definitions

i Component1 (comol)

1 Add Physics

Add Multiphysics

Insert Physics from Model
Add Mesh

Copy as Code to Clipboard
Copy

Delete

Rename

Settings

Properties

Help

Keyboard Shortcuts —

—— Del

F2

To be more specific, suppose that you build a model that simulates a coil assembly
that is made up of two parts, a coil and a coil housing. You can create two
Component nodes, one that models the coil and the other the coil housing. You
can then rename each of the nodes with the name of the object. Similarly, you can
also create two Study nodes, the first simulating the stationary or steady-state
behavior of the assembly, and the second simulating the frequency response. You
can rename these two nodes to be Stationary and Frequency Domain. When the
model is complete, save it to a file named Coil Assembly.mph. At that point, the
model tree in the Model Builder looks like the figure below.

In this figure, the root node is named Coil
Assembly.mph, indicating the file in which the
model is saved. The Global Definitions node
and the Results node each have their default
name. Additionally, there are two Component
nodes and two Study nodes with the names

chosen in the previous paragraph.

El

4 & Coil Assembly.mph (root)
() Global Definitions

i
|
~db Stationary

Coil {compl)

Coil Housing (comp2)

~dt Frequency Domain

& Results
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PARAMETERS, VARIABLES, AND SCOPE

Global Parameters

Global parameters are user-defined constant scalars that are usable throughout the
model. That is to say, they are “global” in nature. Important uses are:

» Parameterizing geometric dimensions.
¢ Specifying mesh element sizes.

* Defining parametric sweeps (simulations that are repeated for a variety of
different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in
constants, built-in and user-defined functions with global parameter expressions
as arguments, and unary and binary operators. For a list of available operators, see
“Appendix C — Language Elements and Reserved Names” on page 166. Because
these expressions are evaluated before a simulation begins, global parameters may
not depend on the time variable t. Likewise, they may not depend on spatial
variables like x, y, or z, nor on the dependent variables for which your equations
are solving.

It is important to know that the names of parameters are case sensitive.

You define global parameters in the Parameters node in the model tree under
Global Definitions.

- -
4 @ busbarmph frocel
4 ([ Global Defiritions - Parameters
P Parameters
i Materials " Mame  Expressicn Value Description
4 M Component ] (compl) L ofem] 000 m Length

= Definiticns e 1 imen] 0005 m Bok rarais
', Geometry 1 thb Smen] 0005 m Thickness
it Materials whh Sfem] 005 m Wiidth
= Blectric Currents (ec) mh fi[mem] 0.006 m Maximum elerment size
W Hest Transfer in Solids dht) e S[im~2/K] SW/(m'K)  Heat transfer caefficient
2 Muhiphysics ret 20[my] 002y Applied valtage
A Mesh 1
s Shudy 1
B Results
1Sved
Marme:
L
Expresion
Slem] =
Desciplion:

Length
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Results Parameters

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model.

Model Builder - ® | Settings
- ® - ETE S - Parameters
4 & busbar_l.mph froot)
) Global Definitions ¥ Parameters
@ Componentl (compl) <
~o Study 1 Narne Expression Value Description
4 @. Results iso_level 300.5[K] 3095K Isosurface level

Fi Parameters

Result parameters may depend on other parameters and built-in functions.

Variables

Variables have associated Variables nodes in the model tree and can be defined
either in the Global Definitions node or in the Definitions subnode of any Component
node.

Model Builder -
- v ETELS -
4 & continuous_casting.mph (root)
4 (7)) Global Definitions
Pi Parameters
a= Variables 2
2 Materials

%
(i)

I= Componentl (compl)
4 = Definitions
a= Variables 1
1=/ Boundary System 1 (sysI)
[ view1
A\ Geometry 1
Naturally, the choice of where to define the variable depends on whether you want
it to be global (that is, usable throughout the model tree) or locally defined within
a single Component node. Like a parameter expression, a variable expression may
contain numbers, parameters, built-in constants, and unary and binary operators.
However, it may also contain variables like t, x, y, or z; functions with variable
expressions as arguments; and dependent variables that you are solving for in
addition to their space and time derivatives.

Variables Used in Applications

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of a parameter. In addition, variables
to be used in applications can be defined in the Application Builder, in the
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application tree under the Declarations node. Such variables can also be used in
model methods.

Scope

The “scope” of a parameter or variable is a statement about where it may be used
in an expression. All global parameters are defined in the Global Definitions node
of the model tree as a Parameters subnode. This means that they are global in
scope and can be used throughout the model tree.

A variable may also be defined in the Global Definitions node, as a Variables
subnode, and have global scope, but they are subject to other limitations. For
example, variables may not be used in Geometry, Mesh, or Study nodes (with the
one exception that a variable may be used in an expression that determines when
the simulation should stop).

A variable that is instead defined under the Definitions subnode of a Component
node has local scope and is intended for use in that particular Component (but,
again, not in the Geometry or Mesh nodes). They may be used, for example, to
specify material properties in the Materials subnode of a Component or to specify
boundary conditions or interactions. It is sometimes valuable to limit the scope of
the variable to only a certain part of the geometry, such as certain boundaries. For
that purpose, provisions are available in the settings for a variable to select whether
to apply the definition either to the entire geometry of the Component or only to
a Domain, Boundary, Edge, or Point.
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The figure at left shows the definition

Label:  Variables 1

Geometric iy Selaction of two variables, q_pin and R, for
Geometic ey e | Boundosy . which the scope is limited to just two
i e . boundaries identified by numbers 15

15
13

Active

and 19.

Such a group of numbers is called a
Selection and can be named and then
; referenced elsewhere in a model. This
B Ao oo 2 wime2) kg Sotees et souce can be useful, for example, when

S i defining material properties or
boundary conditions that will use the
variable at certain boundaries but not
elsewhere. To give a name to the
Selection, click the Create Selection
button (% ) to the right of the Selection
list.

Although the variables defined in the

& Z @ o
41

= Variables

b Variables node under the Component >
apin Definitions subnode are intended to
Fepression: .
.'\Ijnlu-".quli'll‘lrlu'":'lqu'."lll'JI haVC local Scope’ they Can Stlll be
Descrpton accessed outside of the Component

Surface heal source

node in the model tree by being
sufficiently specific about their identity.
This is done by using a “dot-notation” where the variable name is preceded by the
name of the Component node in which it is defined and they are joined by a “dot”.
In other words, if a variable named foo is defined in a Component node named
MyModel, then this variable may be accessed outside of the Component node by
using MyModel. foo. This can be useful, for example, when you want to use the
variable to make plots in the Results node. Variables defined under the Declarations
node in the Application Builder are available globally in form objects and methods
but cannot be used in the Model Builder.

The following spread shows an example of a customized desktop with additional
windows.
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QUICK ACCESS

TOOLBAR

MODEL BUILDER
WINDOW

MODEL TREE —

4 W Component1 (comp)
Definitions
S\ Geometry 1
£i8 Materials
2 Turbulent Flow, k-z (spf)
|22 Heat Transfer in Fluids (ht)
<y Multiphysics
A Mesh1
8 Study 1

4 [ Results

4 #22 Derived Values

Heat Transfer Coefficient
¢ Inlet Pressure, Water
¥ Inlet Pressure, Air

B Tables

VBl Pressure (spf)

Tl Wall Resolution (spf)

W@ Temperature (ht)

~ Data

Data set: | Study 1/Solution 1 (solt) ~ | |
~ Expressions +- 5

" Expression Unit
aveopL(nitfL.awf_u)/(..| W/(m*..

Descriptic |

SETTINGS WINDOW RIBBON
P EHR O EOHED RN RS
Home | Definitions ~ Geometry  Materials  Physics  Mesh  Study  Results | Developer
gc P; Parameters [= Impor] e — 2
A a- Variables - '=_= R . & - e + ii '
Application  Component Build Add Turbulent _Add Build Mesh = Compute Study Add 30Plot  Ac
Builder - g Functions + | ] Material | Flow, k-z = Physics =~ Mesh 1+ 1< Study | Group9- G
i Model Definitions Geomet Materials Physics Mesh Stuc Result
—Model Builder SE-ﬁ""gS ~ & Graphics Convergence Plot 1
- b &~ =tE Global Evaluation QR o By !
4 4 shell_end_tube_heat_exchanger.mph (root) = Evaluate =
@ Global Definitions Label: | Heat Transfer Coefficient . SLEScE e

Prefssure (Pa)

4 0.2 0.4

b X

1 [ 346

4 z

4 Messages Progress Llog Table 1

] EEEB s VI EEBE

aveopl(nitfL.qwf_u)/(T_water-T_air) (W/{m"27K]}
4 as02s

-0.1 ]

0.

2

0.3 0.4 0.5 0.6

x-coordinate (m)

PLOT WINDOW — The Plot window is used to visualize Results
quantities, probes, and convergence plots. Several Plot windows
can be used to show multiple results simultaneously.
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DYNAMIC HELP — Continuously updated with online access to the
Knowledge Base and Application Gallery. The Help window enables
easy browsing with extended search functionality.

GRAPHICS WINDOW

| shell_and_tube_heat_excl mph - COMSOL Mutti

B F =

IdPlot  Windows Reset

roup ~ ~ Desktop +

; Layout

o =

nperature (K) Streamline: Velocity field = = Q
COMSOL Multiphysics > COMSOL Mdltiphysics Reference Manual

> Results Analysis and Plots > Derived Values and Tables >

Derived Value Types
Derived Value Types

In the Model Builder, under Results, right-click Derived Values (
232 ). Select an option from the list and continue defining each

derived value (see Table 20-9).

TABLE 20-9: DERIVED VALUE TYPES

LINKTOSECTION | DESCRIPTION E
Point Evaluation To evaluate expressions or variables define,
Global Evaluation To evaluate the numerical value of a global
Global Matrix To define the evaluation of the numerical v
Evaluzti s

in a madel with several ports
frequency-domain study.

Peint Matrix Evaluation | To define the evaluation of the numerical v
anisatropic material data in some pointsin

System Matrix To evaluate an Assemble or Modal node to

MORE DERIVED This submenu contains additional derived v

VALUES SUBMENU Aberration Evaluaticn, and Ray Evaluation.

Particle Evaluation To evaluate an expression for all, or a subse
model,

Aberration Evalustion | To compute Zemike coefficients far Zemiks
types of monachromatic aberration in ray <

Ray Evaluation To evaluste sn expression for sll,or 3 subst
- AVERAGE SUBMENU | Volume Average Surface Average and Line
Volume Average To evaluate an average over a set of domai
Surface Average To evaluate an average over a set of domai
INFORMATION WINDOWS af L — ;
< Previous Section Next Section »
143 GB | 146 GB O = =

PROGRESS BAR WITH CANCEL BUTTON
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Built-In Constants, Variables, and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and
functions. They have reserved names that cannot be redefined by the user. If you
use a reserved name for a user-defined variable, parameter, or function, the text
you enter will turn orange (a warning) or red (an error) and you will get a tooltip
message if you select the text string.

Some important examples are:
* Mathematical constants such as pi (3.14...) or the imaginary unit i or j

+ DPhysical constants such as g_const (acceleration of gravity), c_const (speed
of light), or R_const (universal gas constant)

e The time variable, t

+ First- and second-order derivatives of the dependent variables (the solution)
whose names are derived from the spatial coordinate names and dependent
variable names (which are user-defined variables)

e Mathematical functions such as cos, sin, exp, log, 1log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 166 for
more information.

The Application Libraries

The Application Libraries are collections of MPH files containing tutorial models
and runnable applications with accompanying documentation. Tutorial models
show how to use the Model Builder and have documentation that includes
theoretical background and step-by-step instructions. Runnable applications have
instructions on how to use the application. You can readily inspect and edit all
tutorial models and applications to make them your own. Each physics-based
add-on module comes with its own application library with examples specific to its
applications and physics area. You can use the step-by-step instructions and the
MPH files as a template for your own modeling.
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To open the Application Libraries window, select Application Libraries [ from the
Windows menu on the Home toolbar or from the File menu [i. Then, search by

application name or browse under a module folder name.

Application Libraries

* Refresh 57 Update COMSOL Application Librasies (£

3 COMSOL Muhiphysics
% AC/DC Medule
Acoustics Module
Btteries & Fuel Cells Module
4 {4 CFD Module
B applications

High Mach Nurnher Flow

Multiphase Benchmarks
Multiphase Tutarials
Maniscthermal Flow
Particle Tracing This exemple sohves the |
Single-Phase Benchmarks geometry. The visualizat
4 [ Single-Phase Tutorials
& hackstep
€ haffled_minee
© qravity_tuterial
& nan_nestonian_flaw
© ratating_disk
© turhulert_miving Mome L
& water_purification_reactor Used products c
B Thin-Film Flow q e
72! Chemical Reactinn Engineering Madule Fhysacs interfaces |
<, Comasian Module
B Design Madule Crealed in H -
[ ECAD Impert Madule Computation time 1|  APplicasion Library path
i Electrachemistry Module g
I Flartindannsition Mol Authar q
Last madified 4
Run Application | @ Open - |
Open POF Dacument i
HEDEL WiTARD
1 In the Madel Wi,
Help (9 Close : ' .':'P'

Click Open [#] , Run Application » , or Open PDF Document = . Alternatively,
select Help > Documentation from the File menu to search by application name or
browse by module. Note that the Run Application option is only available for MPH
files that are runnable applications.

The MPH files in the Application Libraries can have two formats — Full MPH
tiles or Compact MPH files:

» Full MPH files, including all meshes and solutions. In the Application
Libraries window, these appear with the @ icon. If the MPH file size
exceeds 25MB, a tip with the text “Large file” and the file size appears when
you position the cursor at the model’s node in the Application Libraries tree.

» Compact MPH files, with all settings for the model but without built meshes
and solution data to save space on the DVD or download image. Some MPH
files have no solutions for other reasons such that the computation time is
short and the results are easily regenerated. You can open these to study the
settings and to mesh and re-solve. It is also possible to download the full
versions — with meshes and solutions — of most of these when you update
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your Application Libraries. These appear in the Application Libraries window
with the ¢ icon. If you position the cursor at a compact file in the
Application Libraries window, a No solutions stored message appears. If a full
MPH file is available for download, the corresponding node’s context menu
includes a Download File with Solutions & option.
The Application Libraries are updated on a regular basis by COMSOL. To check
all available updates, click Update COMSOL Application Libraries [[] at the top of the
Application Libraries window. You can also find this option from the File > Help
menu (Windows® users) or from the Help menu (macOS and Linux® users). This
connects you to the COMSOL website, where you can access new applications
and the latest updates.

Application Libraries

C Refresh |7} Update COMSOL Application Libraries| () Application Gallery

Search

3 COMSOL Multiphysics

% AC/DC Module

1)} Acoustics Medule

41 Batteries & Fuel Cells Module

If your computer has an Internet connection, then you can click the Application
Gallery button to get access to a wide range of additional examples from the
COMSOL website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining
global variables to the final report of results, is displayed in the model tree.

h D
Wodel Builder T

4

4 & busbar.mph (root)
4 (7)) Global Definitions
Pi Parameters
2 Materials
4 m Componentl {compl)
= Definitions
A\ Geometry 1
4 iE Materials
22 Copper (matl)
2= Titanium beta-215 (mat2)
+\_ Electric Currents {ec)
i Current Conservation 1

[ S

S Electric Insulation 1
T Initial Values 1
mw Electric Potential 1
= Groundl

Bl Heat Transfer in Solids {ht)
i Solid1

T Initial Values 1

[ S

S Thermal Insulation 1
mw Heat Flux1

[ S

.{‘,’3 Multiphysics
x| Electromagnetic Heating1 {emhl)
A Mesh1
4 ~db Study 1
E Step 1: Stationary
[*r. Solver Configurations
4 ([ Results
H Data Sets
% Derived Values
Tables
Wi Electric Potential (ec)
W& Termperature (ht)
i Isothermal Contours (ht)
Current Density
Export
Reports

From top to bottom, the model tree defines an orderly sequence of operations.

In the following branches of the model tree, the node order makes a difference
and you can change the sequence of operations by moving the subnodes up or
down the model tree:

* Geometry
« Materials
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* Physics

* Mesh

e Study

* Plot Groups

In the Component > Definitions branch of the tree, the ordering of the following
node types also makes a difference:

* Perfectly Matched Layer

¢ Infinite Elements

Nodes may be reordered by these methods:

* Drag-and-drop

* Right-clicking the node and selecting Move Up or Move Down
» Pressing Ctrl + Up arrow or Ctrl + Down arrow

In other branches, the ordering of nodes is not significant with respect to the
sequence of operations, but some nodes can be reordered for readability. Child
nodes to Global Definitions is one such example.

You can view the sequence of operations presented as program code statements by
saving the model as a Model File for MATLAB® or as a Model File for Java® after having
selected Compact History in the File menu. Note that the model history keeps a
complete record of the changes you make to a model as you build it. As such, it
includes all of your corrections, including changes to parameters and boundary
conditions and modifications of solver methods. Compacting this history removes
all of the overridden changes and leaves a clean copy of the most recent form of
the model steps. In the Application Builder, you can use the Record Method option
to view and edit program code statements in the Method editor.

As you work with the COMSOL Desktop interface and the Model Builder, you
will grow to appreciate the organized and streamlined approach. However, any
description of a user interface is inadequate until you try it for yourself. In the next
chapters, you are invited to work through two examples to familiarize yourself
with the software.
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Example |: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL
Multiphysics®. For more fully-featured structural mechanics models, see the
Structural Mechanics Module application library.

At some point in your life, it is likely that you have tightened a bolt using a wrench.
This exercise takes you through a structural mechanics model that analyzes this
basic task from the perspective of the structural integrity of the wrench subjected
to a worst-case loading.

The wrench is, of course, made from steel, a ductile material. If the applied torque
is too high, the tool will be permanently deformed due to the steel’s elastoplastic
behavior when pushed beyond its yield stress level. To analyze whether the wrench
handle is appropriately dimensioned, you will check if the mechanical stress level
is within the yield stress limit.

This tutorial gives a quick introduction to the Model Builder workflow. It starts
with opening the Model Wizard and adding a physics option for solid mechanics.
Then a geometry is imported and steel is selected as the material. You then explore
the other key steps in creating a model by defining a parameter and boundary
condition for the load; selecting geometric entities in the Graphics window;
defining the Mesh and Study; and finally, examining the results numerically and
through visualization.

If you prefer to practice with a more advanced model, read this section to
familiarize yourself with some of the key features, and then go to the tutorial
“Example 2: The Busbar — A Multiphysics Model” on page 54.

Model Wizard

I To start the software, double-click the COMSOL
Multiphysics icon on the desktop, which will take you to

»
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the New window with two options for creating a new model: Model Wizard or

Blank Model.

If you select Blank Model, you can right-click the root node

in the model tree to manually add a Component and a Study.

.mgh

G

For this tutorial, click the Model Wizard button. Hoge
If the COMSOL Desktop user interface is already open,
you can start the Model Wizard by selecting New from the

File menu. Choose the Model Wizard.

“mph
Elank Model

The Model Wizard will guide you through the first steps of
setting up a model. The next window lets you select the

dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.

e m - 9

2D

EE Axisymmetric

2D

3 In Select Physics, sclect Structural
Mechanics > Solid Mechanics (solid)
Click Add.

Without add-on modules, Solid
Mechanics is the only physics interface
available in the Structural Mechanics
folder. In the picture to the right, part
of the Structural Mechanics folder is
shown as it appears when all add-on
modules are available.

Click Study @ to continue.
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i
1D

Axisymmetric gE LE

Select Physics

Search

Heat Transfer
Ife Optics
&) Plasma
4 Radio Frequency
25 Semiconductor
4 523 Structural Mechanics
=3 Solid Mechanics (solid) e
(7] Shell (shell)
[7] Membrane (mbrn)
&t Beam (beam)
Truss (truss)
@2 Multibody Dynamics (mbd)
143 Lumped Mechanical System (Ims)
)% Rotordynamics
55 Thermal Stress -
Add

m

Added physics interfaces:
£ Solid Mechanics (solid)

Remove

e @ sy

() spoce Dimerion



4 Click Stationary - under Preset
Studies. Click Done = once you have
finished.

Preset studies have solver and equation
settings adapted to the selected physics,
which is, in this example, Solid
Mechanics. A Stationary study is used in
this case — there are no time-varying
loads or material properties.

Any selection from the Custom Studies
branch ~» requires manual settings.

Geometry

Select Study

4 ~db Preset Studies
£ Bolt Pre-Tension
Eigenfrequency
Frequency Domain
Frequency Domain Modal
Linear Buckling
Modal Reduced-Order Model
Prestressed Analysis, Eigenfrequency
Prestressed Analysis, Frequency Domain
= Stationary
M Time Dependent
T Time Dependent Modal

FLEFREEE

()
1?‘\

Added study:

|7 Stationary
Added physics interfaces:

=5 Solid Mechanics (solid)

@) prysics o

Help (€ Concel | [3/]Done

m

This tutorial uses a geometry that was previously created and stored in the
COMSOL native CAD format, .mphbin. To learn how to build your own

geometry, see “Appendix A — Building a Geometry” on page 146.

File Locations

The location of the application library that contains the file used in this exercise
varies based on the software installation and operating system. In Windows®, the

file path will be similar to:

C:\Program Files\COMSOL\COMSOL53a\Multiphysics\applications.
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I In the Model Builder window, under Component I, right-click Geometry |
and select Import =.
4 & Untitled.mph (root)
() Global Definitions

4 i Compenent 1 fcompl)
= Definitions

G A Geometry 1

5 Materials | F8 Build All F8
4 521 Solid Mech

Tl LinearE = Import

T Freel | (7] Block
= Initial V]

A Meshl

Cone

As an alternative, you can use the ribbon and click Import = from the Geometry
tab.

2 In the Settings window for Import, from the Source list, select COMSOL
Multiphysics file.

* Import
Source:

COMSOL Multiphysics file -
Filename:
_Multiphysics\Structural_Mechanicsiwrench.mphbin

Browse... Import

3 Click Browse and locate the file wrench.mphbin in the application library folder
of the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL53a\Multiphysics\
applications\COMSOL_Multiphysics\ Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
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4 Click Import to display the geometry in the Graphics window.

aa

AGE Lk FOSEER SQEY ~EFENE- Moz aa

Rotate: Click and drag

Pan: Right-click and drag

Q0%

5 Click the wrench geometry in the Graphics window and then experiment with
moving it around. As you point to or click the geometry, it changes color. Click
the Zoom In @, Zoom Out &, Go to Default 3D View L, Zoom Extents 3], and
Transparency & buttons on the Graphics window toolbar to see what happens to
the geometry:

To rotate, click and drag anywhere in the Graphics window.
To move, right-click and drag.

To zoom in and out, click the mouse scroll wheel, continue holding it, and
drag.

To get back to the original position, click the Go to Default 3D View .- button
on the toolbar.

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 162 for
additional information.

The imported model has two parts, or domains, corresponding to the bolt and the
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.
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Materials

The Materials node = stores the material properties for all physics and all domains
in a Component node. Use the same generic steel material for both the bolt and
tool. Here is how to choose it in the Model Builder.

I Open the Add Materials window.

You can open the Add Materials

window in either of these two G xi Materials
4 07 Solid Mechz 527 Add Material from Library

ways: om

y :,- Linear £} Q Browse Materials
mw Freel
T Initial V2 525 Blank Material

- Right-click Component | >
Materials = in the Model Builder
and select Add Material from
Library :i

- From the ribbon, select the Home tab and then click Add Material.

2 In the Add Material window, click to - ex o
expand the Built-In folder. Scroll down ', 11 comonent = 4 Ade to Slection

to find Structural steel, right-click, and Search
select Add to Component |. £ Nimonic alloy 90
2= Nylon
3 Examine the Material Contents section i Polysilicon
. . . . =& Lead Zirconate Titanate (PZT-5H)
in the Settings window for Material to i Silica glass
. . £ il
see the properties that are available. $1 colde, 505n-40Pb
Properties with green check marks are e i Stee| ALSL1340
8 . . B o= Structural steel
used by the physics in the simulation. BT @ Addto Global Materials
i Ty
21 Wi I Addto Component1
X AC/D E
& Batter + Add to Selection
I Bioheat
4 Close the Add Material window.
¥ Material Contents
" Property Variable Value Unit Property group
[¥ | Density rho 7850[kg/m"3] | kg/m* Basic -
=4 Young's modulus E 200e9[Pa] Pa Young's modulus and Poisson's ratio
[+ |Poissen's ratio nu 0.30 1 Young's modulus and Poisson's ratio
Relative permeability mur_iso . |1 1 Basic
Hesat capacity at constant pressure Cp 4750/ (kg*K)] | W/ (kg:K) Basic L
Thermal conductivity k_iso; ki, 44 5[W/(m™K)] | W/ (m-K) Basic 3
Electrical conductivity sigma_iso.. 4.032eb[5/m] |5/m Basic
Relative permittivity . |1 1 Basic
Coefficient of thermal expansion 2 12.3e-6[1/K] 1/K Basic
Murnaghan third-order elastic moduli | -3.0el1[Pa] N/m® Murnaghan
Murnaghan third-order elastic moduli m -6.2el1[Pa] Nfm® Murnaghan
Murnaghan third-order elastic moduli n -7.2el1[Pa] Nfm* Murnaghan -
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Also see the busbar tutorial sections “Materials” on page 65 and
“Customizing Materials” on page 102 to learn more about working with
materials.

Global Definitions

You will now define a global parameter specifying the load applied to the wrench.

Parameters

I In the Model Builder, under Global Definitions @, choose Parameters -

>

4 @ Untitled.mph [root)
4 (7)) Global Definitions

Fi Parameters c

2 Materials
4 m Componentl {compl)

2 Qo to the Settings window for Parameters. In the Parameters table, enter these
settings:

- In the Name column or field, enter F.

- In the Expression column or field, enter 150[N]. The square-bracket notation
is used to associate a physical unit to a numerical value; in this case, the unit
of force in Newtons. The Value column is automatically updated based on the
expression entered once you leave the field or press Return.

- In the Description column or
field, enter Applied force.

~ Parameters

Name Expression Value Description
F [L50[N] 150.00 M Applied force

&

If you have a Parameters table with more than one entry, you can sort the
table with respect to a particular column by clicking on the corresponding
header.
The sections “Global Definitions” on page 59 and “Parameters, Functions,
Variables, and Couplings” on page 98 show you more about working with
parameters.
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So far, you have added the physics and

study, imported a geometry, added the Model Builder -
material, and defined one parameter. The = - StE S
Model Builder node sequence should now 4 [4® Unfitied.mph (roof
match the figure to the right. The default 4 () Global Definitions
feature nodes under Solid Mechanics arc Pi Parameters
indicated by a D in the upper-left corner s Materials
of the node icon i=. 4\m Component1 (camp)
= Definitions

The default nodes for Solid Mechanics are: 4 Y5 Geometry1
Linear Elastic Material, Free, and Initial [ Import 1 (imp3)
Values. Form Union (fin)

. 4 cof Materials
The node Linear Elastic Material is the £2 Structural steel (matl)
default material model for the Solid 4 = Solid Mechanics (solid)

1 Linear Elastic Material 1
]

m Freel

i Initial Values 1

Mechanics interface. The node Free is a
boundary condition that allows all

boundaries to move freely without a A Mesh1

constraint or load. The node Initial Values 4~ Study 1

is used for specifying initial displacement @E ST“—F’ 1: Stationary
esults

and velocity values for a nonlinear or
transient analysis (not applicable in this
case).

The default physics nodes cannot be removed. Instead, you specify physics settings
that deviate from that of the default nodes by adding additional nodes. These
additional nodes can override or contribute to the settings of the default nodes as
well as other nodes. For more information, see “Override and Contribution:
Exclusive and Contributing Nodes” on page 113.

At any time, you can save your model and then open it later in exactly the state in
which it was saved.

3 From the File Menu, select File > Save As. Browse to a folder where you have
write permissions, and save the file as wrench.mph.
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Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary

conditions.

I In the Model Builder, right-click
Solid Mechanics (solid)
Fixed Constraint = .

This boundary condition

constrains the displacement of each

point on a boundary surface to be
zero in all directions.

You can also use the ribbon and
select, from the Physics tab,
Boundaries > Fixed Constraint.

2 In the Graphics window, rotate
the geometry by clicking
anywhere in the window and then
dragging the wrench into the
position shown. Click on the
exposed front surface of the
partially modeled bolt. The
boundary turns blue indicating
that it has been selected. The
Boundary number in the Selection
list should be 35.

and select

4 & wrench.mph (root)
4 () Global Definitions
Pi Parameters
22 Materials
4 Tl Compenentl {compl)
I = Definitions
b YA Geometry 1
b 2 Materials
4 =2 Solid Mechanics (solid)
i Linear Elastic Material
T Freel
= Initial Values 1
£ Meshl
b~ Study 1

I B Results

v

EtEL S

Initial Values
Material Models
Volume Forces
Mass, Spring, and Damper

Domain Constraints

Free
Boundary Load
Fixed Constraint

Prescribed Displacement

3 Click the Go to Default View button ... on the Graphics toolbar to restore the

geometry to the default view.

Graphics

aa®s @

LrEkz @E@BBE R

®©E N

~EEE®?2

Ferea o=
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4 In the Model Builder, right-click Solid Mechanics (solid) = and select Boundary
Load. A Boundary Load node = is added to the Model Builder sequence.
4 % Solid Mechanics {solid)
= Linear Elastic Material 1
T Freel
i Initial Values 1

‘= Fixed Constraint 1
o ¥y Boundary Load 1
A Mesh1

The “warning” attribute displayed on the Boundary Load node indicates that its
boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the o
Zoom Box button @ on the
toolbar and drag the mouse to
select the square region shown in
the figure to the right. Release
the mouse button to zoom in on

the selected region. 9

6 Seclect the top socket face
(boundary 111) by clicking the
boundary to highlight it in blue
and add it to the Selection list.
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7 In the Settings window for
Boundary Load, under Force, sclect

~ Force

Total force as the Load type and G r”:;‘::’ce 3
enter -F in the text field for the z . .
component. The negative sign Foor 0 v | w
indicates the negative z direction e LA 2

(downward). With these settings,
the load of 150 N will be
distributed uniformly across the selected surface.

Note that to simplity the modeling process, the mechanical contact between the
bolt and the wrench is approximated with a material interface boundary condition.
Such an internal boundary condition is automatically defined and guarantees
continuity in normal stress and displacement across a material interface. A more
detailed analysis including mechanical contact can be done with the Structural
Mechanics Module.

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray, the exception being
when you use the material Appearance setting available in Materials; See page 69.
To select a boundary, first hover over it. This highlights the boundary in red,
assuming the boundary was previously unselected. Now, click to select the
boundary by using the left mouse button. The boundary now turns blue. Its
boundary number will appear in the Selection list in the Settings window of the
corresponding boundary condition. Once a boundary is selected and you hover
over it again, the boundary turns green. If you click a boundary highlighted in
green, the boundary is deselected and now turns gray again. The same technique
for selecting and deselecting is applicable to geometry objects, domains,
boundaries, edges, and points.

The figure below shows the different selection states for a boundary.

Highlighted for selection Selected Highlighted for deselection
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To select internal surfaces that are hidden behind the one closest to you, use one
of the following methods to cycle through the boundaries at the mouse pointer:
roll the mouse scroll wheel, use the keyboard up and down arrows, or use
two-finger drag on a touchpad.

Mesh

The mesh settings determine the resolution of the finite element mesh used to
discretize the model. The finite element method divides the model into small
elements of geometrically simple shapes, in this case tetrahedra. In each
tetrahedron, a set of polynomial functions is used to approximate the structural
displacement field — how much the object deforms in each of the three
coordinate directions.

In this example, because the geometry contains small edges and faces, you will
define a slightly finer mesh than the default setting suggests. This will better
resolve the variations of the stress field and give a more accurate result. Refining
the mesh size to improve computational accuracy always involves some sacrifice in
speed and typically requires increased memory usage.

I In the Model Builder, under Component I, click Mesh 1 4 . In the Settings window
for Mesh, under Mesh Settings, sclect Finer from the Element size list.

[E Build All

G Label: Mesh1 =]

v  Mesh Settings
Sequence type:
Physics-controlled mesh -

Elernent size:

| Finer A

Extremely fine
Extra fine

Fine
Normal

2 Click the Build All button m in the Settings window or on the Mesh toolbar.

The resulting mesh will require about 5GB to solve. If you have a computer
with less than 5GB of RAM you can sclect Fine from the Element size list (instead
of Finer.)

42 |



3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the
wrench to take a look at the element size distribution.
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Study

In the beginning of setting up the model, you selected a Stationary study, which
implies that a stationary solver will be used. For this to be applicable, the
assumption is that the load, deformation, and stress do not vary in time. To start
the solver:

I Right-click Study | ~ and select

4 b Study 1
Compute = (or press F8). —
P ( p ) _:-L; zt = Compute F8
1 )
After a few seconds of computation @i Rewt] 8 Parametric Sweep

time, the default plot is displayed in
the Graphics window. During
computation, a Progress window
shows progress information from the
solvers. After the computation you

Function Sweep
Material Sweep

Study Reference
Optimization

“ Parameter Estimation

can find other useful information Study Steps ,
about the computation in the " Show Default Solver
Messages and Log windows; Click the Y. GetInitial Value

Messages and Log tabs under the
Graphics window to see the kind of information available to you. The Messages
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window can also be opened from the Windows drop-down list in the Home tab of
the ribbon.

Messages Progress Log

aLVE

Started at T-Nov-2017 13:43:35.

Linear sclver

Humber of degrees of freedom solwved for: 412704.

Symmetric matrices found.

Scales for dependent warisbles:

Displacement field (material and gecmetry frames) (compl.u): 1

Orthonormal null-space function used.

Iter SolEst Damping Stepsize #Res #Jac #5cl LinErr LinRes
1 0.88 1.0000000 0.88 1 1 1 2.7e-007 5.2e-009

Solution time: 20 3.

Physical memory: 3.9 GB

Virtual memory: 4.44 GB

Ended at 7-Nov-2017 13:43:55.

————— Stationary Solver 1 in Study 1/Sclution 1 ({scll) >

Results

The von Mises stress is displayed in the Graphics window in a default Surface plot
with the displacement visualized using a Deformation subnode. Change the
default unit (N/m?) to the more suitable MPa as shown in the following steps.

I In the Model Builder, expand the Results > Stress

(solid) @ node, then click Surface | ™. “ & Results

Data Sets
£ Derived Values
EH Tables
4 @ Stress (solid)
™ Surfacel
= Export
=3 Reports

'

2 In the Settings window under

. o + Expressi v %
Expression, from the Unit list, select MPa R =h- %
(or type MPa in the field). Expression:

solid.mises
Unit:

© w -

= Description:

von Mise
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3 Click the Plot button = on the toolbar of the Settings window for the Surface
plot and then click the Go to Default 3D View button ... on the Graphics window
toolbar.

The von Mises stress distribution is shown in the bolt and wrench under an
applied vertical load.

005

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa,
which means that we are getting close to plastic deformation for our 150 N load
(which corresponds to about 34 pounds force). You may also be interested in a
safety margin of], say, a factor of three. To quickly assess which parts of the wrench
are at risk of plastic deformation, you can plot an inequality expression such as
solid.mises>200[MPa].

I Right-click the Results node @& and add a 3D Plot Group @ .

4 ~on Study 1
E Step 1: Stationary

I [Pre Solver Configurations

4 ([ Results

I ¥ Datz: Nl 3D Plot Group 0

£ Deri [
2D Plot Grou
B Tab e

4 i Stre 1D Plot Group
“)  Polar Plot Group

9= Smith Plot Group

Pi  Parameters
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2 Right-click the 3D Plot Group 2 node @ and select Surface ™.

4 ([ Results
E Data Sets
£ Derived Values
EH Tables
4 @ Stress (solid) Plot
h
Surfacel

Wl 2D Plot Group 2 PlotIn
Export ‘ Volume
E§| Reports =/ Arrow Volume
™ surface G
W Slice

3 In the Settings window for Surface,
click the Replace Expression button %
and select Model > Component| > Solid
Mechanics > Stress > solid.mises-von
Mises stress by double-clicking. When
you know the variable name
beforehand, you can also directly enter
solid.mises in the Expression ficld.
Now edit this expression to:
solid.mises>200[MPa].

AY
4

- Expression + -

Expression:
solid.mises> 200[MPa]
Unit:

[C] Description:

solid.mises=>200[MPa]

This is a boolean expression that evaluates to either 1 for true or O for false. In
areas where the expression evaluates to 1, the safety margin is exceeded.

4 Click the Plot button s .

5 In the Model Builder, click 3D Plot Group 2. Press F2 and in the Rename 3D Plot
Group dialog box, enter Safety Margin. Click OK.

The resulting plot shows that the stress in the bolt is high, but the focus of this
exercise is on the wrench. If you wished to comfortably certify the wrench for a
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150 N load with a factor-of-three safety margin, you would need to change the
handle design somewhat, such as by making it wider.

You may have noticed that the manufacturer, for various reasons, has chosen an
asymmetric design for the wrench. Because of that, the stress field may be different
if the wrench is flipped around. Try now, on your own, to apply the same force in
the other direction and visualize the maximum von Mises stress to see if there is
any difference.

Convergence Analysis

To check the accuracy of the computed maximum von Mises stress in the wrench,
you can now continue with a mesh convergence analysis. Do that by using a finer
mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps
below could be skipped at a first reading. In order to run the convergence
analysis below, a computer with at least 4GB of memory (RAM) is
recommended.

EVALUATING THE MAXIMUM VON MISES STRESS

I To study the maximum von Mises stress in the wrench, in the Results section of
the model tree, right-click the Derived Values :: node and select Maximum >
Volume Maximum .
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2 In the Settings window for Volume Maximum, under Selection, choose Manual and
select the wrench, domain 1, by clicking on the wrench in the Graphics window.
We will only consider values in the wrench domain and neglect those in the bolt.

3 In the first row of the Expressions table, in the Expression column, type
solid.mises. To find the expression for the von Mises stress, you can also click
the Replace Expression button % and browse to this variable.

4 In the Expressions table, type MPa as the Unit.

At
= Evaluate =
Label: Volurne Maximum 1
¥ Data
Data set: | Study1/Solution1 (soll) | |E
Selection

Selection: | Manual -
o) | 1 L]

g -
Active ':I':I 'g:']

..
~ Expressions +v S~
" Expression Unit Description
solid.mises MPa von Mises stress G

5 In the Settings window for Volume
Maximum, click Evaluate to evaluate the REesa0e) REDICey) (D) |Table
. . -85 L 5 % i

maximum stress. The result will be g s S es VT H
displayed ina Table WindOW and will bC von Mises stress (MPa)
approximately 375 MPa. 375.50 G

6 To see where the maximum value is
attained, you can use a Max/Min Yolume plot. Right-click the Results node = and
add a 3D Plot Group w . Next, right-click the 3D Plot Group 3 node @ and select
More Plots > Max/Min Volume ;.

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Volume
= node and select Selection and select the wrench domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type
solid.mises.
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9 In the Settings window under Expression, from the Unit list, select MPa (or enter
MPa in the field).

10 Click the Plot button @ . This type of plot simultaneously shows the location of
the maximum and minimum values and also their coordinate location in the

table below.

aamE - EE0 Be a&

¥ 2 e
OURITED 0007844 2448544 01
AR 45 A 000 173,50

PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while
solving and then finally plot the maximum von Mises stress vs. mesh size. First, we
define the parameters that will be used for controlling the mesh density.

I In the Model Builder, click Parameters  under Global Definitions ).
2 Go to the Settings window for Parameters. In the Parameters table (or under the
table in the fields), enter these settings:
- In the Name column or field, enter hd. This parameter will be used in the
parametric sweep to control the element size.
- In the Expression column or field, enter 1.
- In the Description column or field, enter Element size divider.
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3 Now, enter another parameter with

. Settings
Name h0, Expression 0.01, and WWEF
Description Starting element size.
This parameter will be used to define .

. . Name Expression  Value Description
the element size at the start of the F 100 150N Applid force
. hd 1 1 Element size divider e

parametric sweep. ho 001 001 Starting element size

4 In the Model Builder, under
Component |, click Mesh | 4 . In the
Settings window for Mesh, sclect User-controlled mesh from the Sequence type
list.

5 Under Mesh 1, click the Size node

6 In the Settings window for Size, under
Element Size, click the Custom button.

¥ Element Size Parameters

Maxirnum element size:

Under Element Size Parameters, cnter: ho/hd m
. . . Minimurm element size:

- h0/hd in the Maximum element size ficld. . G
- h0/(4*hd) in the Minimum element size Maximum element growth rate:

field. 13

Curvature factor:

- 1.3 in the Maximum element growth 01

rate ﬁeld, Resolution of narrow regions:

- 0.1 in the Curvature factor field. =

- 0.2 in the Resolution of narrow regions
field.

See page 77 for more information on the element size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS
As a next step, add a parametric sweep for the parameter hd.

I In the Model Builder, right-click Study | - and
select Parametric Sweep iii. A Parametric Sweep
node is added to the Model Builder sequence.

4 ~db Study 1
Parametric Sweep

Step 1: Stationary
4 [Tr. Solver Configurations

2 In the Settings window for Parametric Sweep,
under the table in the Study Settings section, click the Add button +. From the
Parameter names list in the table, select hd.
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3 Enter a range of Parameter values to
sweep for. Click the Range | button and

enter the values in the Range dialog box. = Compute © Update Solution

In the Start ficld, enter 1. In the Step Labek | Paremetric Sweep

field, enter 1, and in the Stop ficld, enter ~  Study Settings

6. Click Replace. The Parameter value list Sweeptype: | Specfied combinations -

will now dlsplay range(1,1,6). " Parameter name Parameter value st Parameter unit
. hd (Element size divider) = || range(1,1,6)

The settings above make sure that as the e

sweep progresses, the value of the
parameter hd increases and the maximum
and minimum element sizes decrease.

See page 128 for more information on defining parametric sweeps.

For the highest value of hd, the number of DOFs will exceed one million.
Therefore, we will switch to a more memory-efficient iterative solver.

4 Under Study | > Solver Configurations > Solution I, expand the Stationary Solver
I node [z, and right-click Suggested Iterative Solver] and select Enable.
Selecting an iterative solver option typically reduces memory usage but can
require physics-specific tailoring of the solver settings for efficient
computations.

5 Under General in the Settings window for Suggested Iterative Solver, change the
Preconditioning to Right. (This is a low-level solver option, which in this case will
suppress a warning message that would otherwise appear. However, this setting
does not affect the resulting solution. Preconditioning is a mathematical
transformation used to prepare the finite element equation system for using the
iterative solver.)

6 Click the Study I node and select Compute =, cither in the Settings window or
by right-clicking the node. You can also click Compute in the ribbon Home or
Study tab. The computation time will be a few minutes (depending on the
computer hardware) and memory usage will be about 4GB.

RESULTS ANALYSIS

As a final step, analyze the results from the parametric sweep by displaying the
maximum von Mises stress in a table.

I In the Model Builder under Results > Derived Values, sclect the Volume Maximum
I node wex.

The solutions from the parametric sweep are stored in a new Data Set named
Study |/Parametric Solutions |I. Now, change the Volume Maximum settings
accordingly:
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2 In the Settings window for Volume Maximum, change the Data set to Study
I/Parametric Solutions I.

3 Click the arrow next to the Evaluate button at the top of the Settings window
for Volume Maximum and select to evaluate in a New Table. This evaluation may
take 20 seconds or so.

4 To plot the results in the Table, click the Table Graph = button at the top of the
Table window.

hd wvon Mises stress (MPa) c-:.c: 2 & O ae

10000 [806.26 »
20000  408.35 ! T T T T :
30000 388.68

40000 38298

50000 377.35

60000 37545

It is more interesting to plot the maximum value vs. the number of DOFs. This
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node :: and select Global Evaluation .

6 In the Settings window for Global Evaluation, change the Data set to Study
I/Parametric Solutions |I.

7 In the Expressions ficld, enter numberofdofs.

You can type the first few characters of the variable name and then use
the keyboard shortcut Ctrl+Space to get a variable suggestion from the
list of available variables.

8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate
button and select the option to evaluate in Table 2. This displays the DOF values
for each parameter next to the previously evaluated data.

This convergence analysis shows that the computed value of the maximum von
Mises stress in the wrench handle will decrease from the high original value, for a
mesh with about 40,000 DOFs, to 375 MPa for a mesh with about 1,000,000
DOFs. It also shows that for about 500,000 DOFs the results have essentially the
same accuracy as for 1,000,000 DOFs.
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The figure below shows the associated Table Graph and Table Graph Settings
window.

o as A
@

Label: Table Graphl =
¥ Data
Table: Table2 | |3
x-axis data: Number of degrees of freedom (1) ~
Plot columns: Manual =
Columns:

hd
von Mises stress (MPa)
MNurnber of degrees of freedom (1)

Note that depending on the version of COMSOL Multiphysics that you are
running, the above values may vary slightly due to variations in the number of
elements generated by the meshing algorithm.

This concludes the wrench tutorial.
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Example 2: The Busbar — A Multiphysics Model

Electrical Heating in a Busbar

This tutorial demonstrates the concept of multiphysics modeling in COMSOL
Multiphysics using the Model Builder. You will learn how to use one of the many
preconfigured multiphysics combinations as well as subsequently add the effects
of physics phenomena not initially included in the analysis. At the end, you will
have built a truly multiphysics model.

The model that you are about to create analyzes a busbar designed to conduct a
high amount of direct current in an industrial setting (see picture below). The
current conducted in the busbar, from bolt 1 to bolts 2a and 2b, produces heat
due to the resistive losses, a phenomenon referred to as Joule heating. The busbar
is made of copper, while the bolts are made of a titanium alloy. Busbar bolts are
usually made of steel, but in this example, we will assume a highly corrosive
environment. Therefore, a titanium alloy was chosen.

Under normal operational conditions, the currents are predominantly conducted
through the copper. This example, however, illustrates the effects of an unwanted
electrical loading of the busbar through the bolts. The fact that there are different
materials is important because titanium has a lower electrical conductivity than
copper and will be subjected to a higher current density.

Titanium Bolt 2a

Titanium Bolt 2b  Titanium Bolt |

The goal of your simulation is to precisely calculate how much the busbar heats
up. Once you have captured the basic multiphysics phenomena, you will have the
chance to investigate thermal expansion that generates structural stresses and
strains in the busbar and the effects of cooling by an air stream.
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The Joule heating effect is described by conservation laws for electric current and
energy. Once solved for, the two conservation laws give the temperature and
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled
by natural convection in the air surrounding the busbar. You can assume that the
exposed parts of the bolt do not contribute to the cooling or heating of the device.
The electric potential at the upper-right vertical bolt surface is 20 mV and the
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds
to a relatively high and potentially unsafe loading of this type of busbar. More
advanced boundary conditions for electromagnetics analysis are available with the
AC/DC Module, such as the capability to give the total current on a boundary. A
more advanced model that includes multiple busbars in an assembly, as shown in
the figure below, can be found in some of the add-on products, including the
AC/DC Module and a few of the LiveLink™ products for CAD.

Busbar Model Overview

More in-depth and advanced topics included in this tutorial are used to show you

some of the many options available in COMSOL Multiphysics. The following

topics are covered:

» “Parameters, Functions, Variables, and Couplings” on page 98, where you
learn how to define functions and component couplings.

» “Material Properties and Material Libraries” on page 102 shows you how to
customize a material and add it to your own material library.
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» “Adding Meshes” on page 104 gives you the opportunity to add and define
two different meshes and compare them in the Graphics window.

¢ “Adding Physics” on page 106 explores the multiphysics capabilities by
adding solid mechanics and laminar flow to the busbar model.

» “Parametric Sweeps” on page 128 shows you how to vary the width of the
busbar using a parameter and then solve for a range of parameter values. The
result is a plot of the average temperature as a function of the width.

» “Parallel Computing” on page 140, gives you an overview of how to solve
on clusters.

* “COMSOL Multiphysics Client-Server” on page 143, gives you an
introduction to using the COMSOL Multiphysics client-server mode of
operation.

Model Wizard

I To open the software, double-click the COMSOL .
Multiphysics icon on the desktop. 0 Eg

COMSOL

Multiphysics

523

When the software opens, click the Model Wizard button.

You can also start the Model Wizard at any time by 0
selecting New from the File menu. Then, choose Model odel
Wizard.

“mEh

2 In the Select Space Dimension window, click 3D. Elanthicdsl

|
e & = 9 - | —
| |
2D 1D
EE Axisymmetric 4z Axisymmetric
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3 In the Select Physics window, expand

Heat Transfer > Electromagnetic Select Physics

Heating. Then, right-click Joule Heating S
+ and choose Add Physics. Click the X acic -
1) Acoustics
Study @ button. 53 Cherical Species Transport
1T Electrochemistry
You can also double-click or click the L Rt
Add button to add physics, 18 Heat Transfer in Solids (ht]

Heat Transfer in Fluids (ht)

m

: H S8 Heat Transfer in Pipes (htp)
(AllOther Way tO add phy51cs 1S to Open @ Local Thermal Mon-Equilibrium
H 3 @ Heat Transfer in Porous Media (ht)
thc Add PhySlcs WlndOW by . ) Bicheat Transfer (ht)
right-clicking the Component node in eﬁ Hes o s Trmsgon
the Model Builder and selecting Add = Conjugate Heat Transfer
. Radiation
PhYSICS 4 ) 4 %)) Electromagnetic Heating
. . 4 Laser Heating
Note that you may have fewer items in % Joue Hesing.
. . . =, Induction Heating
your physics list depending on the 1 Micronave Hesting -
add-on modules installed. The figure i phyis s A
on thC right iS ShOWn fOI' the case % Electric Currents (ec)
. 18 Heat Transfer in Solids (ht)
where all add-on modules are installed. 4 .5, Mutiphysics Couplings
=\ Electromagnetic Heating (emhi)
Remove

® spce imerion ©o-
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4 In the Select Study window, click to
select the Stationary - study type.

Click the Done button.

Choosing a stationary study means that
we are solving for the steady-state
temperature of the busbar when it has
reached thermal equilibrium with its
surroundings.

A preconfigured Study has solver and
equation settings adapted to the
selected combination of physics

interface; in this example, Joule Heating.

Select Study

4~ Presct Studies for Selected Physics Interfaces
T2 Small-Signal Analysis, Frequency Domain

4 |7 Stationary
[rc Stationary Source Sweep
T, Thermal Perturbation, Eigenfrequency
T2 Thermal Perturbation, Frequency Demain
T Time Dependent

4~ Preset Studies for Selected Multiphysics
T== Frequency-Stationary
T Frequency-Transient

5 Custom Studies

Added study:
|7 Stationary
Added physics interfaces:

X Electric Currents [ec)

Y

T8 Heat Transfer in Solids (ht]

m

4, Multiphysics Couplings
= Electromagnetic Heating (emh1)

Any selection from the Custom Studies =
branch ~» may require manual tuning.

Note that you may have fewer study
types in your study list depending on

the installed add-on modules.
o @

Help (€ Concel | [3/]Done

A physics interface is a user interface for a specific physics area that
defines the equations together with settings for mesh generation,
solvers, visualization, and results. A multiphysics interface is a
combination of physics interfaces together with multiphysics couplings.
The Joule Heating multiphysics interface consists of two physics
interfaces, Electric Currents and Heat Transfer in Solids, together with the
multiphysics coupling Electromagnetic Heating that appear in the
Multiphysics branch. This method of mixing physics is very flexible and
makes it possible to use all the capabilities of the participating
single-physics interfaces for multiphysics purposes.

4, Geometry 1
i Metesials
a4 M Electric Currents (ec)
Wl Currert Consenvation |
a Clectric Insulation 1
Bl Inisial Velues 1
4 | Hest Transfer in Solids (he)
i Sokd 1
i Tnitial Values 1
T Thermal Insulation 1
4, Multiphysics
5. Flectromagnetic Heating 1 (emb 1)
A Mesh1
i Stuely 1
17 Step 1: Statinary
B Results
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Global Definitions

To save time, it is reccommended that you A 2xrad_|
load the geometry from a file. In that case, N
you can skip to “Geometry” on page 62.

If, on the other hand, you want to draw the
geometry yourself, the Global Definitions
node is where you define the parameters.
First, complete steps 1 through 3 below to
define the parameter list for the model.
Then, follow step 4 and skip to the section
“Appendix A — Building a Geometry” on
page 146.

The Global Definitions node @ in the Model
Builder stores Parameters, Variables, and
Functions with a global scope. The model
tree can hold several model components
simultaneously, and the definitions with a
global scope are made available for all
components. In this particular example,
there is only one Component node in which the parameters are used. If you wish
to limit the scope to this single component, you could define, for example,
Variables and Functions in the Definitions subnode, available directly under the
corresponding Component node. However, no Parameters can be defined here
because Parameters that are defined under Global Definitions are always global.

Since you will run a parametric study of the geometry later in this example, define
the geometry using parameters from the start. In this step, enter parameters for
the length of the lower part of the busbar, L; the radius of the titanium bolts,
rad_1; the thickness of the busbar, tbb; and the width of the device, wbb.

You will also add the parameters that control the mesh, mh; a heat transfer
coefficient for cooling by natural convection, htc; and a value for the voltage
across the busbar, Vtot.

I Under Global Definitions ¢, choose Parameters r . In the Parameters table, click

&y

the first row under Name and enter L.

2 Click the first row under Expression and enter the value of L, 9[cm]. You can
enter the unit inside the square brackets.

3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot
according to the Parameters list below. It is a good idea to enter descriptions for
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variables in case you want to share the model with others and for your own
future reference.

¥ Parameters

" Name Expression Value Description
c L 9lcm] G 0.09 m Length

rad_1 6[mm] 0,006 m Bolt radius

thb 5[mm] 0,005 m Thickness

whb 5[cm] 0.05m Width

mh 3[mm] 0,006 m Maximum element size

htc S[W/m"2/K] 5 W/ (m*K) Heat transfer coefficient
e Vot 20[mV] 0.02v Applied voltage

Click the Save button i on the Quick Access Toolbar and name the model
busbar.mph or use the corresponding File menu option. Then, go to “Appendix
A — Building a Geometry” on page 146.

Auto Completion and Find for Parameters and Variables

The model tree contains a large number of parameters and variables. To make it
easier to find them, you can use auto completion and find tools as described
below.

AUTO COMPLETION

You can use Ctrl+Space for auto completion of parameter and variable names. For
example, in the Parameters table, click an empty Expression field and then press
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Ctrl+Space, you will get a list of parameters and variables, as shown in the figure

below.
htc S[W/m"2/K] 5 W/ (m*K) Heat transfer coefficient
Vot 20[mV] 0.02v Applied voltage
my_par |
mh - Maximum element size
rad_l - Bolt radius
4 Model
4 Componentl (compl) {compl}
Electric Currents
Global
Heat Transfer in Solids
Global Definitions
4 BuiltIn
4 Mathematical constants
eps - Machine epsilon
1 s i - Imaginary unit
MName: Inf - Infinity
rmy_par Jj - Imaginary unit
MNaM - Mot a number
Expression: pi - Pi,

Mathematical functinns

m

This functionality is also available for other edit fields in the Model Builder.

FIND

To find parameters and variables in the model tree, you can click the Find button
in the Quick Access Toolbar or use the keyboard shortcut Ctrl+F. This opens the

Find window.
rEo[ Find ]

All | Methods

Find:  current
[7] Exact match
[C] Regular expression

[C] Case sensitive

Close
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The results of the search are displayed in the Find Results window, as shown in the
figure below, coming from the completed busbar model.

Messages Progress Log  Find Results
' "current": 9 matches

MNode

Electric Currents (ec) {ec}

Electric Currents (ec) {ec}

Current Conservation 1 {cucnl}

Current Conservation 1 {cucnl}

Electromagnetic Heat Source 1 {(emhl) {emhl}

Boundary Electromagnetic Heat Source 1 (bemhl) {bemhl}
Temperature Coupling 1 (tel] {tcl}

Current Density {pgd}

Surface 1 {surfl}

Type
Mode
MNode
MNode
Mode
Setting
Setting
Setting
MNode
Setting

Text

Electric Currents

Electric Currents

Current Conservation 1
Current Conservation
Electric Currents (ec) {ec}
Electric Currents (ec) {ec}
Electric Currents (ec) {ec}
Current Density

Current density norm

You can double-click any of the rows in this window to open the corresponding

Settings window.

Geometry

This section describes how the geometry can be opened from the Application
Libraries. The physics, study, parameters, and geometry are included with the

model file you are about to open.

I Select Application Libraries [ from the
Windows drop down menu in the Home tab.
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Add Study

Add Material from Library
Material Browser
Application Libraries
Part Libraries
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Messages

Debug Log

Table

External Process
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2 In the Application Libraries tree under

COMSOL Multiphysics > Multiphysics, Application Libraries
SClCCt busbar geom.  Refresh | Update COMSOL Application Libraries (%) Application Gallery
Search
To open the file, you can: 4 5 Covsol e
. Applications
- Double-click the name % e
. . . [l Chemical Engineering E
- Right-click and select an option D o
Electromagnetics
from the menu [f] Equation Based
. [ifi Fluid Dynamics
- Click one of the buttons under the % Geophyics
tree [ifil Meshing Tutorials

4 [ffi] Multiphysics
busbar_box
busbar_geom
busbar

You can select No if prompted to save G
Untitled.mph.

The geometry in this file is

pid_control
thermal_actuator_jh
thermal_actuator_simplified =

L el NolY ]

parameterized. In the next few steps, I=
. . . . Run Application Open
we will experiment with different e ’
. Open PDF Documen
values for the width parameter, wbb. ’ (
3 Under Global Definitions @ , click the
¥ Parameters
Parameters node
In the Settings window for Parameters, . Name gE[xp'Tsm” ;;'g”e
. . . < cm 09 m
click in the Expression column for the rad 1 6[mm] 0.006 m
wbb parameter and enter 10[cm] to thb 3[mm] 0.005 m
change the value of the busbar width. e wbb [ Joam
mh 6[rmm] 0,006 m
4 In the Model Builder, under Component | htc SW/mA2/K] |5 W/mK)
Viot 20[mV] 0.02v

> Geometry |, click the Form Union node
and then the Build All button in the
Settings window @ to rerun the geometry sequence. You can also use the ribbon
and click Build All from the Geometry group in the Home tab.

Model Builder Settings
- cv B d< Form Union/Assembly
4 & bushar_geom.mph (root) ¥ Build Selected ~ [E Build All o
4 (7)) Global Definitions
P; Parameters Label: Form Union =
2 Materials .
4 [ Componentl (compl) ¥ Form Union/assembly
= Definitions Action:

4 YA Geometry 1

£ Work Planel (wpl) rormislunion hd
Lj.!, Extrudel (extl) Repair tolerance:
E Work Plane 2 {wp2) Automatic -

L_,.!, Extrude 2 {ext2)
2 Work Plane 3 (wp3)
L_,.!, Extrude 3 {ext3)

G Form Union (fin)

2 Materials

i
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5 In the Graphics toolbar, click the Zoom Extents button [ to see the wider busbar
in the Graphics window.

Graphics

aa@e@ v obyiz

©

wbb = 5cm wbb = 10cm

6 Experiment with the geometry in the Graphics window:

- To rotate the busbar, click and drag the pointer anywhere in the Graphics
window.

- To move it, right-click and drag.
- To zoom in and out, click the scroll wheel, continue holding it, and drag.

- To get back to the original position, click the Go to Default 3D View button .|..
on the toolbar.

Graphics

a a @& @ | [l by bz

7 Return to the Parameters table and

change the value of wbb back to 5[cm]. arameters

8 In the Model Builder, click the Form WD T Value
. . . L 9lcm] 0.09 m
Union node & and then click the Build rad 1 R 0.006 m
All button = to rerun the geometry thb S[mm] 0.005 m
sequence. 6 wo  [Sleml___ Joosm
mh 6[rmm] 0,006 m
9 On the Graphics toolbar, click the Zoom htc SIW/mA2/K] |5 Wi(mEK)
Extents button 7. Vtot 20[mV] 0.02v

64 |



I01f you built the geometry yourself, you are already using the busbar.mph file,
but if you opened the file from the Application Libraries, select Save As from the
File menu and rename the model busbar.mph.

After creating or importing the geometry, it is time to define the materials.

Materials

The Materials node = stores the material properties for all physics and geometrical
domains in a Component node. The busbar is made of copper and the bolts are
made of a titanium alloy. Both of these materials are available from the Built-In
material database.

I In the Model Builder, right-click Component 1 > Materials == and select Add
Material from Library . By default, the window will open at the right-hand side
of the desktop. You can move the window by clicking on the window title and
then dragging it to a new location. While dragging the window, you will be
presented with several options for docking.

4 [m Componentl {compl)
= Definitions
A\ Geometry 1
G i Materials
*_ Electric Cuf "=k Add Material from Library
[l Heat Trans Q Browse Materials

e Multiphysi

ey phy: .

A Mesh1 == Blank Material
~d Study 1 =5 Material Link

The Materials node will show a red x in the lower-left corner if you try to
solve without first defining a material, which we will go over in the next
few steps.
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2 In the Add Material window,

expand the Built-In materials Add Materia X
folder and locate Copper. =4 Addto Component + = Add to Selection
Right-click Copper == and select Eeaich
Add to Component l. H Alum!num 3003-H18 -
. 2= Aluminum 6063-T&3
Alternatively, you can £2 Alurninum
double-click. =2 American red oak
. zi Beryllium copper UNS C17200
A Copper node is added to the ix Brick
Model Builder. = Emim”
2= Concrete
3 In the Add Material window, 6 “: Copper
scroll to Titanium beta-21S$ in = ;FI“‘ (C("ﬂ @ Add to Global Materials
. . . 24 Glass (quz
the Built-In material folder list. i1 Granite |(M Addto Component 1
Right-click and select Add to iz High-stre 4 Add to Selection
zi Iron
component I =2 Magnesium AZ31B
4 In the Model Builder, collapse i Mica

the Geometry | node » to get
an overview of the model.

4 busbar.mph (root)
4 () Global Definitions
Pi Parameters
i) Materials
4 Il Component1 (compl)
= Definitions
G 4\ Geometry 1
4 558 Materials
== Copper (matl)
2= Titanium beta-215 (mat2)
+\_ Electric Currents {ec)
I8l Heat Transfer in Solids (ht)
iy Multiphysics
A5\ Mesh1
~db Study 1

@, Results

5 Under the Materials node, click Copper :: .

4 m Componentl {compl)
= Definitions

% Geometry 1

- Materials

e .= Copper (matl)

2= Titanium beta-215 (mat2)
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6 In the Settings window for Material, cxamine the Material Contents section.

4

Property Variable Value Unit Property group

[ | Electrical conductivity sigma_iso... | 5998e7[5/m] | 5/m Basic

[ |Heat capacity at constant pressure Cp 3B5[)/(kg™)] | W (kgK) Basic

G [# | Relative permittivity epsilonr_i.. |1 1 Basic

[+ | Density rho 8960[kg/m*3] | kg/m® Basic

[# | Thermal cenductivity ke iso; ki, | 400[W/(m*K)] | W/ mK) Basic
Relative permeahility mur_iso . |1 1 Basic
Coefficient of thermal expansion alpha_iso... |17e-6[1/K] 1K Basic
Young's modulus E 1109[Pa] Pa Young's modulus and Poisson's ratio
Poisson's ratio nu 0.35 1 Young's modulus and Poisson's ratio
Reference resistivity rhel 1.72e-8[chm.. | Q:m Linearized resistivity
Resistivity temperature coefficient alpha 0.0033[1/K] LK Linearized resistivity
Reference temperature Tref 298[K] K Linearized resistivity

The Material Contents section has useful information about the material
property usage of a model. Properties that are both required by the physics and
available from the material are marked with a green check mark =. Properties
required by the physics but missing in the material are marked with a warning
sign A . A property that is available but not used in the model is unmarked.

The Coefficient of thermal expansion, Young’s modulus, and Poisson’s ratio
in the table above are not used, but will be needed later when
heat-induced stresses and strains are added to the model.

Because the copper material is added first, by default, all parts have copper
material assigned. In the next step, you will assign titanium properties to the
bolts, which override the copper material assignment for those parts.

7 In the Model Builder, click Titanium beta-21$ :: .

4 m Componentl {compl)
= Definitions
A\ Geometry 1
4 oo2 Materials
22 Copper (matl)
e o= Titanium beta-215 (mat2)

*_ Electric Currents (ec)
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8 Select All Domains from the Selection list and then click domain 1 in the list. Now
remove domain 1 from the selection list.

To remove a domain from the selection list (or any geometric entity, such as

boundaries, edges, or points), you can use either of these two methods:

- Click domain 1 in the selection list found in the Settings window for Material.
Then, click the Remove from Selection button - or press Delete on your
keyboard.

- Alternatively, in the Graphics window, click domain 1 to remove it from the
selection list.

Settings -

Material

Label: Titanium beta-215

Geometric Entity Selection

Geometric entity level: | Domain - |
Selection: | All domains v|
&l s E

| 2 =] 8]
Active |4 Fl:l E

5 B

6

7
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To render the copper components in the actual color of the material, open
the Preferences window from the File menu. Then, on the Graphics and Plot
Windows page, select the Show material color and texture check box. This
will also enable material-true rendering of other materials.

9 In the Settings window
for Material, be sure to
inspect the Material
Contents section for the Label: | Titanium beta-215 5
titanium material. All of
the properties used by
the physics should have a
green check mark .

Geometric Entity Selection

Geometric entity level: | Domain -

Selection: Manual -

Active

. . R ST

Override
Material Properties

¥ Material Contents

T

Property Variable Value Unit
G [ Electrical conductivity sigma_iso ; 5. [7407e5[.. | S/m
[¥ | Heat capacity at constant pres... Cp TI00/ (ke | (kgeK)
[# | Relative permittivity epsilonr_iso.. |1 1
[ Density rho 4940[kg... |kg/m®
[ Thermal conductivity k_iso ; kil = k.. | T5[W/ L. | W/ (me..
Relative permeability mur_iso; m... |1 1
Coefficient of thermal expansion | alpha_iso ; al...| 7.06e-6[... |1/K
Young's modulus E 105e3[Pa] |Pa
Poisson's ratio nu 0.33 1
10 Close the Add Material window
either by clicking the iconinthe  add I/ateria v1x @
upper—right corner or by + Addto Component v =+ Add to Selection
clicking the Add Material toggle Search
button s in the Materials 25 Recent Materials .

[I§ Material Library
4 % Built-In

group of the ribbon Home tab.
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Physics and Boundary Conditions

Next, you will inspect the physics domain settings and set the boundary conditions
for the heat transfer problem and the conduction of the electric current.

In the Model Builder window, examine the default physics nodes of the multiphysics
interface for Joule Heating. First, collapse the Materials node. Then, click the arrows
next to the Electric Currents x , Heat Transfer in Solids i, and Multiphysics » nodes
to expand them.

WMaodel Builder -1
- ‘v - P
4 % busharmph (root)
4 (%) Global Definitions Label:  Electromagnetic Heating 1 =
Pi Parameters Name  emhl
22 Materials
4 [l Component1 {compl) ~ Domain Selection
= Definitions
S\ Geometry 1 Selection: | All domains =
22 Materials 1 .+
4 % Electric Currents (ec) Bos] | 5 =
T Current Conservation 1 = 3 =
n Active 3 |
S Electric Insulation 1 :
&
i Initial Values 1 5 -
4 |[@ Heat Transfer in Solids (ht) 7
= Solid1
3= Initial Values 1
S Thermal Insulation 1 v Boundary Selection
4 i Muliphysics Selection: | All boundaries =
= Electromagnetic Heating 1 (emhl)
1 w
A Meshl = -
o Study 1 : =]
1B Results Active 4 ®
5 @
6
1 -
2
v Equation
Show equation assuming:
Study 1, Stationary -
pCou-VT =V -(K¥T) +0,
Qe :J -E

The D in the upper-left corner of a node’s icon (&) means it is a default node.
The equations that are being solved are displayed in the Equation section of the
Settings windows of the respective physics nodes.

The default equation form is inherited from the study added in the Model Wizard.
For the Joule Heating multiphysics interface, the equations are for the temperature
and electric potential.

To always display the equations in the Settings windows, click the Show
button (#) on the Model Builder toolbar and select Equation Sections so
that a check mark appears next to it.
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The Heat Transfer in Solids and Electric
Currents nodes have the settings for heat
conduction and current conduction,
respectively.

Under the Electric Currents node, the
Current Conservation node represents the
conservation of electric current at the
domain level and the Electric Insulation
node contains the default boundary
condition for Electric Currents.

Under the Heat Transfer in Solids node,
the domain level Heat Transfer in Solids
node represents the conservation of heat
and the Thermal Insulation node contains
the default boundary condition for Heat
Transfer in Solids. The heat source for the
Joule heating effect is set in the

4 & busbar.mph (root)
4 (7)) Global Definitions
Fi Parameters
2 Materials
4 @ Componentl (compl)
= Definitions
Y4, Geometry 1
2 Materials
4 +\_ Electric Currents (ec)
i Current Conservation 1
S Electric Insulation 1
i Initial Values 1
4 |[E Heat Transfer in Solids (ht)
i Solid1
i Initial Values 1
S Thermal Insulation 1

[ S

b Multiphysics

x| Electromagnetic Heating1 {emhl)
A Mesh1
~db Study 1

& Results

Electromagnetic Heating node under the Multiphysics node. The Initial Values node,
found in both the Electric Currents and Heat Transfer in Solids interfaces, contains
initial guesses for the nonlinear solver for stationary problems and initial

conditions for time-dependent problems.

Now, define the boundary conditions.

I Right-click the Heat Transfer in Solids node i&. In the second section of the
context menu — the boundary = section — select Heat Flux.

4 & busbar.mph (root)
4 ([} Global Definitions I= Solid
p:
i Param.eters = Fluid
2 Materials

Domain section

4 [ Componentl (compl) I Phase Change Material
= Definitions I Heat Source

A Geom.etryl = Initial Values
2 Materials
el +\_ Electric Currents [ec) m Temperature

i Current Conservation 1
S Electric Insulation 1

B Initial Values 1 ) Outtiow
4 | I8 Heat Transfer in Solids (ht) | =@ Inflow
i Solid1 B |Symmetry
i Initial Values 1
= Thermal Insulation 1 i Clearine
4 5 Multiphysics = Open Boundary
2. Electromagnetic Heatin| o periadic Condition
A Mesh1
~db Study 1 = Boundary Heat Source
& Results = Thermal Contact

Thermal Insulation

————— Section divider

Boundary section

o
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2 In the Settings window for Heat Flux,

select All boundaries from the Bgune sy el

Selection list. Selection: | Manual - @
. Manual
Assume that the circular bolt [""D] All boundaries

boundaries are neither heated nor
cooled by the surroundings.

Active

In the next step, you will remove the
selection of these boundaries from
the heat flux selection list, which
leaves them with the default Thermal Insulation boundary condition for the Heat
Transfer in Solids interface.

3 Rotate the busbar to view the back. Move the mouse pointer over one of the
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to
remove this boundary selection from the Selection list. Repeat this step to
remove the other two circular bolt surfaces from the selection list. Boundaries
8, 15, and 43 are removed.

Cross-check: Boundaries 8, 15, and 43 are removed from the
Selection list.

[:%}
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4 In the Settings window for Heat Flux
under Heat Flux, click the Convective
heat flux button. Enter htc in the

Heat transfer coefficient ficld, /.

This parameter was either entered in
the Parameter table in “Global

Definitions” on page 59 or imported
with the geometry.

* Heat Flux

General inward heat flux

o @ Convective heat flux

Go=h(Tex-T)
Heat transfer coefficient:
User defined
Heat transfer coefficient:
h htc
External temperature:
T ext User defined
293.15[K]
Heat rate
Fa

%:Z

W/ (mK)

More advanced boundary conditions for heat transfer analysis are

available with the Heat Transfer Module. Examples include the

capability to give the total deposited power on a boundary or to set
boundary conditions for common natural convection scenarios such as
for a horizontal or vertical wall.

Continue by setting the boundary conditions for the electric current according

to the following steps:

5 In the Model Builder, right-click the Electric Currents node x . In the second
section of the context menu — the boundary section — select Electric Potential.
An Electric Potential = node is added to the model tree.

h, D
Ardal Biildar
Model Builde

A

4 & busbar.mph (root)

4 (7)) Global Definitions

Pi Parameters
2 Materials

4 m Componentl {compl)

= Definitions

4, Geometry 1

2 Materials
4 +\_ Electric Currents (ec)

i Current Conservat

S Electric Insulation
T Initial Values 1

4 |[@ Heat Transfer in Solidy

= Solid1

T Initial Values 1

S Thermal Insulatiol

mw Heat Flux1
4 5 Multiphysics

Current Conservation
External Current Density
Force Calculation
Piezoresistive Material
Current Source
Terminal

Initial Values

Ground

Electric Potential
Electric Insulation
MNermal Current Density
Boundary Current Source
Terminal

Floating Potential
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6 Move the mouse pointer over the circular face of the single titanium bolt to
highlight it and then click to add it (boundary 43) to the Selection list.

7 In the Settings window for Electric
Potential, enter Vtot in the Electric

potential ﬁCld Electric potential:
Vo Vtot v

¥  Electric Potential

The last step is to set the surfaces of
the two remaining bolts to ground.

8 In the Model Builder, right-click the Electric Currents node x . In the boundary
section of the context menu, select Ground. A Ground node = is added to the
model tree. The model tree node sequence should now match this figure.

4 +\_ Electric Currents {ec)
T Current Conservation 1
S Electric Insulation 1
i Initial Values1
mw Electric Potential 1
¥y Ground1 6
4 | I8 Heat Transfer in Solids {ht)
i Solid1
i Initial Values1
S Thermal Insulation 1
mw Heat Flux1
- .&. Multiphysics
x| Electromagnetic Heating 1 (emh1)

The “warning” attribute displayed on the Ground node indicates that its
boundary selection is empty. The next step will be to select boundaries.
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9 In the Graphics window, click one of the remaining bolts to add it to the
Selection list.
e Cross-check: Boundaries 8 and 15.

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the
selection list for the Ground boundary condition.

10 On the Graphics toolbar, click the Go to Default 3D View button ...

Graphics -
Q@@ @ BE X

©

More advanced boundary conditions for electromagnetics analysis are
available with the AC/DC Module, such as the capability to give the total
current on a boundary.

COMBINING PHYSICS INTERFACES MANUALLY

As an alternative to using the preconfigured Joule Heating multiphysics interface,
you can manually combine the Electric Currents and Heat Transfer in Solids
interfaces. For example, you can start by setting up and solving the model for
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Electric Currents and then subsequently add Heat Transfer in Solids. In that case,
you right-click the Multiphysics node to add the required multiphysics couplings.

4 +\_ Electric Currents {ec)
i Current Conservation 1
S Electric Insulation 1
T Initial Values 1

4 |[@ Heat Transfer in Solids (ht)
i Solid1
T Initial Values 1
S Thermal Insulation 1

4 'i:f‘- Multiphysics

Equilibrium Discharge Heat Source

de (o o
4~y g B Equilibrium Discharge Boundary Heat Source

|5 Thermoelectric Effect
& R

Electromagnetic Heating

Temperature Coupling

ST

Help F1

As an alternative, you can click the Add Multiphysics button in the Physics tab in the

ribbon and select a suggested multiphysics coupling in the Add Multiphysics
window.

Add Multiphysics “ L83
@ SR pnysics
Heat Transferin ~ Add Add + Add to Compenent
Solids (ht) = Physics Multiphysics
Physics (O Recently Used
4 Heat Transfer

4 %)\ Electrornagnetic Heating
_ % Joule Heating
Thermoelectric Effect
4 @) Plasma
- M Equilibrium Discharges
: Equilibrium DC Discharge

Select the physics interfaces you want to couple

Physics Couple
+\_ Electric Currents (ec) &4
[El| Heat Transfer in Solids (ht) [
Multiphysics couplings in study
Studies Solve
Study 1 =
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Mesh

The simplest way to mesh is to create an unstructured tetrahedral mesh, which is
perfect for the busbar model. Alternatively, you can create several meshing
sequences, as shown in “Adding Meshes” on page 104.

A physics-controlled mesh is created by default. In most cases, it is possible
to skip to the Study node and just solve the model. For this exercise, the
settings are investigated in order to parameterize the mesh settings.

I In the Model Builder, click the Mesh |
node 4 . In the Settings window for
Mesh, sclect User-controlled mesh from
the Sequence type list.

2 Under Mesh 1, click the Size node |

3 In the Settings window for Size, in
the Element Size scction, click the
Custom button.

Under Element Size Parameters,
enter:

- mh in the Maximum element size
field. Note that mh is 3 mm —

¥ Mesh Settings

Sequence type:

> | Physics-controlled mesh

User-controlled mesh
Physics-controlled mesh

Size
Free Tetrahedral 1

& Build Selected [§§ Build All
Label: Size

Element Size
Calibrate for:
General physics -

") Predefined MNaormal
@ Custom

¥ Element Size Parameters

Maximum element size:

mh m
Minimum element size:

mh-mh/3 m
Maximum element growth rate:

15

Curvature factor:

0.2

Resolution of narrow regions:

0.5
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the value entered earlier as a global parameter. By using the parameter mh,
element sizes are limited by this value.

- mh-mh/3 in the Minimum element size ficld. The Minimum element size is
slightly smaller than the maximum size.

- 0.21n the Curvature factor ficld. The Curvature factor determines the number
of elements on curved boundaries; A lower value gives a finer mesh.

The other two parameters are left unchanged.

The Maximum element growth rate determines how fast the elements should
grow from small to large over a domain. The larger this value is, the larger the
growth rate. A value of 1 does not give any growth.

For Resolution of narrow regions, a higher value will generally result in a finer
mesh.

indicates that the node is being edited.

4 Click the Build All button m in the Settings window for Size to create the mesh,
as in this figure:

You can also click Build Mesh in the Home tab of the ribbon.
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Study

I To run a simulation, in the Model
Builder, right-click Study I = and G ~ Study1

choose Compute = . You can also B Results | =
press E8 or click Compute in the
ribbon Home tab. 9

The Study node - automatically :
defines a solution sequence for the ::
simulation based on the selected =
physics and study type. In this case, I}Z

the simulation only takes a few
seconds to solve. During the

Compute
Parametric Sweep
Function Sweep
Material Sweep
Study Reference
Combine Solutions
Optimization

Parameter Estimation

solution process, two Convergence plots are generated and are available from tabs
next to the Graphics window. These plots show the convergence progress of the

different solver algorithms engaged by the Study.

Results

By default, in the Results node, three plot groups are
generated: a Multislice plot of the Electric Potential, a
Surface plot of the Temperature, and a plot named
Isothermal Contours containing an Isosurface plot of
the temperature.

Click Results > Temperature @ to view the
Temperature plot in the Graphics window. The
temperature difference in the device is less than 10 K
due to the high thermal conductivity of copper and
titanium. The temperature variations are largest in the
top bolt, which conducts double the amount of

4 & Resu]ts

E Data Sets
£ Derived Values
EH Tables
VB Electric Potential (ec)

H# Multislice 1
4 @ Temperature (ht)

h .9
Surface

[ S

4 @ Isothermal Contours (ht)

¥ Isosurface
Export
55 Reports

current compared to the two lower bolts. The temperature is substantially higher

than the ambient temperature of 293 K.
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I Click and drag the image in the Graphics window to rotate and view the back of
the busbar.

EE

EE]

2 In the Graphics toolbar, click the Go to Default 3D View button ...

You can now manually set the color table range to visualize the temperature
difference in the copper part.

3 In the model tree, expand the Results > Temperature node w and click the
Surface node ™.

4 In the Settings window for Surface, click Range to expand the section. Select the
Manual color range check box and enter 324 in the Maximum ficld (keep the
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default for Minimum and replace the default for Maximum). Click the Plot button
a in the Settings window for Surface.

Cn as -1
G [=3 Plot
Label: Surface =]
Data
Expression = %~
Title
~ Range

Manual color range
Minimum: 323

Maximum: | 324

<

5 On the Graphics toolbar, click the Zoom Extents button fF to view the updated
plot.

6 Click and drag in the Graphics window to rotate the busbar and view the back.

o

Suface: Tamperaturs (0 Surface: Tamparutirs ()

324

The temperature distribution is laterally symmetric with a vertical mirror plane
running between the two lower titanium bolts and cutting through the center of
the upper bolt. In this case, the model does not require much computing power
and you can model the entire geometry. For more complex models, you can
consider using symmetries to reduce the computational requirements.

Select Go to Default 3D View on the toolbar in the Graphics window L.

Then, generate a Surface plot that shows the current density in the device.

| 81



I In the Model Builder, right-click Results
@ and add a 3D Plot Group W .
Right-click 3D Plot Group 4 w and add a

Surface node ™. Wl Electric Potential (ec)
VBl Temperature (ht) —

Plot
i Isothermal Contc °
3D Plot Group 4 PlotIn

Export ‘ Volume
=3 Reports

=/ Arrow Volume

™ surface

2 In the Settings window for Surface under 4 Model

. . . 4 Component1

Expression, click the Replace Expression Definitions
4 Electric Currents
button %. Go to Model > Component | > 4 Currents and charge
Electric Currents > Currents and charge > Displacement current density
. External current density

ec.norm) - Current density norm and Induced current density

Current density

ec.nl - Mormal current density
G ec.nerm) - Current density norm

ec.rhoq - Space charge density

ecrhogs - Surface charge density

Electric
Energy and power

double-click or press Enter to select.

ec.normdJ is the variable for the magnitude,
or absolute value, of the current density
vector. You can also type ec.normdJ in the BT
Expression ficld when you know the variable eenorm)
name or, alternatively, use the auto
completion functionality by typing norm and
then pressing Ctrl+Space to get a variable
name suggestion.

+ Expression v B~

Unit:
Afm*2 -
= Description:

Current density norm

3 Click the Plot button .
The plot that displays in the Graphics window is almost uniform in color due to
the high current density at the contact edges with the bolts. The next step is to
manually change the color table range to visualize the current density
distribution.
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4 In the Settings window for Surface under Range, select the Manual color range
check box. Enter 1e6 in the Maximum field and replace the default.

~ Range

G [¥] Manual color range

Minimum: 019079

Maximum:  1e6

5 Click the Plot button = .

The resulting plot shows that the current takes the shortest path in the
90-degree bend in the busbar. Notice that the edges of the busbar outside of
the bolts are hardly carrying any current.

Surface: Curment dansity norm LA’}
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6 Click and drag the busbar in the Graphics window to view the back. Continue
rotating the image to see the high current density around the contact surfaces
of each of the bolts.

When you are done, click the Go to Default 3D View button .| on the Graphics
toolbar.

GETTING THE MAXIMUM AND MINIMUM TEMPERATURE

You can easily obtain the maximum and minimum temperature values in the
busbar, including their locations.

I Right-click Results > Temperature @ and sclect More Plots > Max/Min Volume.

188 Materials
®_ Flectric Currents (o) G Seatter Volume
'@ Heat Transfer in Salids (ht) ) Principal Stress Volume
Ay Multiphysi )
2 M""“:"‘ e 4 Coordinate System Valume
S— %% Max/Min Volume
4 { Resuts 3 Poincaré Map
Data Sets o
Far Field
237 Derived Values o ForFid
B Tables <l Pt L} [i Principal Stress Surface
i@ Flectric Patential { PlatIn v | [ Coordinate Syster Surface
i@ Temperature (k)
S lsothermal Conrod W Velume 7 MaxMin Surface
4 i 3D Pat Groupd | B4 Anrow Volume W Multislice
-
Susfacel ™ Surace Wl Streamiine Surface
B Fvpant
T Reports W sice +  Principal Stress Line

2 In the Settings window for Max/Min Volume under Expression, click the Replace
Expression button % . Go to Mode | > Component | > Heat Transfer in Solids >
Temperature > T - Temperature and double-click or press Enter to select. You
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can also search for Temperature in the search field above the tree of
postprocessing variables. Click Plot.

- & Graphics
e aaa@ L-x=:=EAE0 Qe ad
il Pt
Labet  Max/Min Valurne 1 =
- Data
Datacet: | From parent »| T
= Expression v % v
Eapressione Type filter test
v b Mesh
) 4 Camponent1
Unit Definiticns
v Grometry
| Description: Glehal
— Electric Cuments
Eretin puleni 4 Heat Transfer in Solids
e & Ambient data
b Domain fuses
Advanced ©  Enengy
» Coloring and Style ¢ Glakal
© Heat seurces
Colen Black b Mukﬂnlpmpemr«
4 Tempeiature
H
Backgreund calor: | MNane EE T e
] Show frame Tempersture gradent
- hi i - grachent
Inherit Style 5 Veluaty and pressure
b Velusity frekd -
Diuble-click or press Enter ta add selrcted mpressian.

The maximum and minimum values are plotted in the Graphics window and
their locations and values are displayed in the Maximum and minimum values
table. The values may vary a bit depending on the version you are running. For
a finer mesh the results will be the same regardless of version.

z=ME0 @e a&
Surface: Tamperature (6] Hasin Velume: Tamgerature ()

£+

.02

z
o) i
L.

Messsger  Progress Log  hassmum and i
o b L EmEE

X v z Tamparstues (1)
QEETIONGG  DOOM  NELA)

020800 DAL DS KL
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As an alternative to the method of plotting the maximum and minimum values
described above, you can use the Derived Values node for a pure numerical output.

3 In the Results section of the model tree, right-click the Derived Values :: node
and select Maximum > Volume Maximum ..

4 In the Settings window for Volume Maximum, under Selection, choose All
domains.

5 In the first row of the Expression table, enter T (unless it is automatically filled
out) for the temperature and click Evaluate at the top of the Settings window.

- & T Tl -
4 @ busbarmph froct) = Eusiuate *
4 (3 Globsl Delnitions.
¥i Parsmeters Label:  Volume Masimum 1

3 Matenals

i Componentl fcompl) ——
= Sludy 1 Datasel: | Study LiSclution 1 (zoll) «| [
4 i Results
Dt Sets y
4 1 Dewved Values SN
e Volume Masimum 1 Selectian: | All domains.
B Tables .
W Electric Potential (ec) H
W Tempersture [t} 3 L O
& Esothermnsl Centours (ht) Aetive g 5 &
W IO Plat Greup 4 5
3 Expont ?
T Reports
w Expressions - 5~

" Bxpression Uniz Description
T 3 Temperature e

The resulting maximum temperature is shown in Table 1.

Messages Progress Log Table 1
EMN N VT B

Temperature (K]

33041 G

As a next step, you will create a model thumbnail image.

CREATING MODEL IMAGES FROM PLOTS

With any solution, you can create an image to display when browsing for model
files. After generating a plot, in the Model Builder under Results, click the
corresponding plot node. Then click the root node (the first node in the model
tree). In the Settings window for the root node under Thumbnail, click Set from
Graphics Window.

There are two other ways to create images from a plot. One is to click the
Image Snapshot button g in the Graphics window toolbar to directly create an

86 |



image. You can also add an Image node & to the Export node to create an image
file. Right-click the plot group of interest and then select Add Image to Export.

Make sure to save the model at this stage. This version of the model,
busbar.mph, is reused and renamed during the next set of tutorials.

Building an Application

This section gives a brief introduction to creating an application based on the
busbar model. The application will have a specialized user interface dedicated to
interact with the busbar model and include input fields for the length, width, and
applied voltage. The outputs will be the maximum temperature and a temperature
plot.

You will learn how to use the New Form wizard to quickly create an application.
The New Form wizard is used to create a form with user interface components
called form objects. The wizard gives quick access to a subset of all of the form
objects available for creating applications with the Application Builder. In this
example, you will learn how to use the wizard to add input fields, numerical
output, graphics, and buttons. For detailed information on building applications,
see the book Introduction to Application Builder.

CREATING A NEW FORM

I To switch from the Model Builder to the Application Builder, click the
Application Builder button in the leftmost part of the Home tab in the ribbon.

e e HRE »
Heome Definit
A &
Application Component
Builder -

'
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2 To create a new form, click the New Form button in the ribbon.

alfhEHE

Hc:me
®C]C
M

Model  MNew
Builder Form Met

&

The wizard window appears.

It consists of three tabs for Inputs/outputs, Graphics, and Buttons. In the
Inputs/outputs tab, you can double-click the nodes in the tree to make these
available in the user interface of the application. For this application, we will
select a few of the parameters as input fields and the maximum temperature as

output.
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3 Double-click each of the parameters: Length (L), Width (wbb), and Applied

voltage (Vtot). Also, double-click the Volume Maximum under Derived Values.

The Preview section to the right displays the user interface layout.

B Masirrarn ared mimimum it
B Tabie:

Lersgtte v em
e 5 em
Apphedvomige 20 L
Tempuestare Q001K

e

4 Click the Graphics tab in the wizard and double-click the Temperature plot. A
graphics object placeholder appears in the Preview area.

, NewFeem
Fermue  Fom1
Ferm name:  forml

Inpeatu/catpts | Geaphecs | Buttom

[ ELLET-S

Labtls entep

Selected
P ST er—
= 0 R
B Tompamature (i)

Lengthe s em
Widkh: ] em

Apphed vetage 20 L
T

aaMBE LhkEE0 -
o aE
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5 Click the Buttons tab in the wizard and double-click Compute Study 1. A button
now appears in the Preview area beneath the graphics object.

, NewFeem ==

Fomtie | fomd Labst cntop

Formmume: [fomd

npops | Graphics | Busons

Avalatie Sadected: Largete 2 o

I 68 Commancs Py yrere— W s -
W Eorganr o st et =
Flet Geommetry 1 Temparature: QDI K
o b Pt QaAB LlEEEO -
[ yrr—— n @

W Pict Tempurature (41}
N Fict hiothermal Cantoun (M}
W Piot 30 Plot Geoup &

6 Finally, click OK to accept the settings and close the wizard.

After closing the New Form wizard, the Form editor is opened. The Form editor
allows you to drag-and-drop form objects and add new ones

° NeEHP» = B
@ [ St - T
i T Pecerd Methed [ Preiem s e
ri 4 53 .
Wadd New  New it et 8 Shewind Anminge
Bulder Form. Method hdce Tock | Gtject + b
[ Pwans
v
.
Length v o
it s m
Hophed vobage: L

Tempemwe  ODLIIS K

aa @l izl = 0

7 You can, for example, rearrange the user interface by dragging the graphics
object to the right of the input fields and the button directly under the input
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fields, as shown in the figure below. Blue guidelines will aid you in aligning the
objects.

[&) Preview [ forml x
¥
L

Lengtie B o BB LakEEEEL D o
Width: 5 om
Applied voltage: 20 mV

Tempeature: 00N K

You can make the graphics object larger by dragging the blue handles.
8 You can test the application by clicking Test Application in the ribbon.

()
> DO,
Test Preview Testin Web

Application Form  Browser -
Test

8

This creates a run-time copy of the application and lets you quickly try different
designs during the process of developing an application.

@ Untiled.mph - Parameterized Busbar ==

File

Lengthe [] m BERE LrxcEEOD0 @o @=

Wit H

wm Surface: Temperature (K} MawMin Velume: Temperatura (K] a
Applied voltsge 20 L
Tempenature: 307K

33

Compiste

3ia.68

9 Now, try a different Length value and click Compute.
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ADDING A BUTTON

You may wish to preview the geometry before starting the computation. This can
easily be done by adding a button. There are two ways to add button. Either use
the Insert Object menu in the ribbon, as shown in the figure below, or use the
Editor Tools window. In this example, you will use the latter.

Fc Input
1 Input Field [5%] Button [ Toggle Button
[¥ Check Box Combo Box
Labels
[ Text Label [m@] Unit Au Equation
— Line
Display
Data Display [5] Graphics [5] Web Page
a Image (3] Video == Progress Bar
[ Log [ Message Log Results Table
Subforms
E‘Form [ Form Collection Card Stack
Compaosite
& File Import [@] Information Card Stack ElArrayInput
2 Radio Button w Selection Input
Miscellaneous
[T] Text 5 List Box EEE Table
=¥ Slider 5 Hyperlink i Toolbar
Spacer

I First, make sure the Editor Tools window is visible by selecting the
corresponding button in the ribbon.

’. D “& Data Access
A

5 Record Method Preview
Model  MNew MNew ﬁ
Builder Form Method % Editor Tools 0
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2 In the Editor Tools tree, right-click the Geometry node and select Button.

Settings  Editor Tools
=g EditNode =T El

D Main Window
I U Forms
| u GUI Commands
b [ Libraries
4 & Model (root)
() Global Definitions
4 m Component1 (compl)
[ = Definitions
\\ Geometry 1
25 Materials [ Graphics
+\_ Electric Curre Button e
B Heat Transfel —_—
& Multiphysics S¢ EditNode
P A Meshl

3 Drag the Plot Geometry button to the left of the Compute button.

[G] Preview [ foemt 2

Length: L] cm e a MR EEEO =B &
Width: 3 em =
Apphed vollsge: 20 my

Temperature: 0001235 K

Fiot

i Lt
Geometry omp e

©

Behind each button is a command sequence that controls the action taken when
it is pressed. The command sequence is defined in the Settings window of the
button and you can open the Settings window (if not already opened) by
double-clicking the button.
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4 Double-click the Plot Geometry button to see its Settings window. Command
sequences appear below the tree in the section Choose Commands to Run.

Editor Toals - R K
Marive: button2 =
Teat: Plet Geometry
lean geometry_32png «| [#] =
Size Lerge

Tealtip:
Keyboard shurlcut:

~ Choose Commands to Run

4 Model (roet)
) Glabal Definitions

mponent 1 (zampl)
= Definitions
a4 Geometry 1

" Commend leon  Arguments
Plat Geametry 1 “  qraphics] o

In this case, the command sequence for the Plot Geometry has one command for
plotting the geometry. The input argument contains information on which
graphics window to send the geometry plot, in this case, the graphics object
graphicsi.

To automatically adjust the axis settings, you can add a Zoom Extents command.

5 In the Choose Commands to Run section, locate the Zoom Extents command
under GUI Commands > Graphics Commands. Double click to add it to the
command sequence.

6 Now, create the input argument to the Zoom Extents command. Click the white
field next to Zoom extents and click the Edit Argument button.

" Command Icon  Arguments
Plot Geometry 1 graphicsl

Zoom eterts —

t1s5aE+M@ O
~ Dialog Actions |Ec|it-'1\rgumenti
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7 This opens a dialog box with possible input arguments. Select graphicsl under
forml.

3 Edit Argument &J
4 Uim Forms

- Dforml
graphicsl o

E‘ Use as Argument

Selected argument:
[ graphicsl

oK Cancel

%

8 The command sequence is now complete.

L3
Command Icon  Arguments

Plot Geomnetry 1 A | graphicsl
Zoom extents forml/graphicsl G

o+

9 To make sure the new Plot Geometry button works, you can test the application
again by clicking Test Application in the ribbon.

METHODS

To perform a more advanced operation than what is possible to do with a
command sequence, you can use the Method editor to write code that defines the
actions to be taken when the user clicks a button, selects a menu item, etc. An easy
way to get started with the Method editor is to convert an existing command
sequence into a method.
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I Locate or open the Settings window for the Plot Geometry button again. Click
the Convert to New Method button below the command sequence.

" Command Icon  Arguments
Plot Geometry 1 forml/graphicsl

Zoom extents forml/graphicsl
tizgiE+#

. . Convert to New Method |
Dialog Actions

v

2 To open the method in the Method editor, click the Go to Method button below
the command sequence.

L3
Command Icon  Arguments

methodl B

Dialog Acti Go to Meth0d|

&

The Method editor now opens with the code for method| corresponding to the
Plot Geometry and the Zoom Extents commands in the previous command

sequence.

Application Builder
- £ El
4 [Z] busbar.mph froot)
D Main Window
4 Uim Forms

D forml
Events
= Declarations

4 Y Methods

methodl

i Model Methods

m]] Libraries

9% |

@ Preview

Dforml rethodl X

5
Zo:

£

Grophics(model.component("compl”).geom("geoml"), “"graphics1"};
mExtents ("forml/graphicsl™);



The Application Builder has several tools for automatically generating code. In
addition to converting a command sequence to a method, you can, for example,
click Record Code in the ribbon.

= 8 g

Goto Record Use
MNode Code  Shortcut

This will generate code for each operation performed in the COMSOL Desktop
windows. Click Stop Recording in the ribbon to stop recording and go back to the
Method editor.

You can record and create two different types of methods: application methods
and model methods. Application methods are used, among other things, for
modifying the model of a running application. Model methods are used for
modifying the current model. For both types of methods, you use the Method
editor for editing. To learn more about using the Form editor and the Method
editor, see the book Introduction to Application Builder. That book also
provides more information on model methods.

This completes the busbar example. To switch back to the Model Builder, click
the Model Builder button in the ribbon.

olhed

® M

Model Mew
Builder Form

The next sections are designed to deepen your understanding of the steps
implemented so far, and to extend your simulation to include additional effects
like thermal expansion and fluid flow. These additional topics begin on the
following pages:

¢ “Parameters, Functions, Variables, and Couplings” on page 98
» “Material Properties and Material Libraries” on page 102

¢ “Adding Meshes” on page 104

» “Adding Physics” on page 106

» “Parametric Sweeps” on page 128

» “Parallel Computing” on page 140

¢ “COMSOL Multiphysics Client-Server” on page 143

» “Appendix A — Building a Geometry” on page 146
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Advanced Topics

Parameters, Functions, Variables, and Couplings

This section explores working with parameters, functions, variables, and
component couplings.

The Global Definitions and Component > Definitions nodes contain functionality
that helps you to prepare model inputs and component couplings and organize
simulations. You have already used the functionality for adding parameters to
organize model inputs in “Global Definitions” on page 59.

Functions, available as both Global Definitions and Component > Definitions,
contain a set of predefined function templates that can be useful when setting up
multiphysics simulations. For example, the Step function template can create a
smooth step function for defining different types of spatial or temporal transitions.

To illustrate using functions, assume that you want to add a time-dependent study
to the busbar model, where an electric potential is applied across the busbar that
goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could use a step
function to be multiplied with the parameter Vtot. In this section, you will add a
step function to the model that goes smoothly from 0 to 1 in 0.5 seconds to find
out how functions can be defined and verified.

DEFINING FUNCTIONS

For this section, you can continue working with the same model file created in the
previous section. Locate and open the file busbar.mph if it is not already open on
the desktop.
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I Right-click the Global Definitions node @ and select Functions > Step .

4 & busbar.mph (root)

4 () Global Definitions
Pi Parameters a=  Variables .
0 == Materials o y | fo Analytic
W Componentl fcof ., . . )
~db Study 1 [# Thermodynamics “= Interpolation
4 [E Results Load Group M Piecewise
:EE=- Data Sets Constraint Group S Gaussian Pulse
ea: Derived Value z P e
B Tables Sometry Farts amp
Wi Electric Potent Mesh Parts » | Il Rectangle
#
TE Temperature Group by Type I Step
Wi Isothermal Co A | Tronat
ik 30 Plot Group Help F1 nangle
] Export W Waveform
B Reports W Random

2 In the Settings window for Step, enter 0.25 in the Location field to set the
location of the middle of the step, where it has the value of 0.5.

-

Plot| [E& Create Plot
Plot (F8) l
aber

L Stepl
Function name:  stepl

¥ Parameters
Location: 0.25
From: 0
To: 1
¥ Smoothing

Size of transition zone: 0.5

Number of continuous derivatives: | 2 -

3 Click Smoothing to expand the section and enter 0.5 in the Size of transition zone
field to set the width of the smoothing interval. Keep the default Number of
continuous derivatives at 2.

4 Click the Plot button @ in the Settings window for Step.
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If your plot matches the one below, this confirms that you have defined the
function correctly.

stepl @

0.9 e 1

0.8

0.5 yd
0.4 / .
0.3

w2k .

1] e L L i i L i i 1 L L M—
01 005 o 0.05 01 015 0.2 0.25 0.3 0.35 0.4 0.45 0s 0.55 05

You can also add comments and rename the function to make it more descriptive.
5 Right-click the Step | node r in the Model Builder and select Properties [=.

4 & busbar.mph (root)
- Global Definitions
Pi Parameters

" Step1 (stepd) e

2 Materials Copy as Code to Clipboard 3
I W Componentl (comp E
ESe

b~ Studyl B Copy
4 [B| Results [ Duplicate Ctrl+Shift+D

3 Data Sets I Delete Del

I &5 Derived Values

Disabl F3
b B Tables G e
I N Electric Potential =[ Rename F2

I N Temnperature (ht) Settings
I N Isothermal Contc .
b g 3D Plot Group 4 o=

H Help F1
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6 In the Properties window, enter any

. . . . Properties 2LV
information you want. Right-click
the Properties tab and sclect Close o
when you are finished. T S
Mame: stepl
Tag:  stepl

G ¥ Node Properties

Created: Sep 24, 2015 9:00:16 AM
Author:

Version:

FO[' the purpose Of thiS CXCI‘CiSC, Comments:  Created for the Introduction to
assume that you want to introduce a COMSOL Multiphysics
second component to represent an

electric device connected to the

busbar through the titanium bolts.

First, rename Component | to specify
that it represents the busbar.

I Right-click the Component | node m and select Rename =: (or press F2).
2 In the Rename Component window, enter Busbar. Click OK and save the model.

4 & busbar.mph (root)

() Global Definitions
G i Bushar (rompl)

~db Study 1

& Results

DEFINING COMPONENT COUPLINGS AND PROBES
Right-click the Definitions node = under Busbar

(compl) to introduce a component coupling 4 % busbar.mph (root)
that computes the integral of any Busbar # [0 Slobal Definitions

X . . i Parameters
(compl) variable at the bolt boundaries facing a= Variables1
the electric device. You can use such a coupling, < i::‘t’elri::e*’”
for example, to define a variable in a Variables 4 1 Busbar (comp1)
node under the Global Definitions node that 4 = Definitions

. . . Jdv Integration 1 {intop)
calculates the total current. This variable is then | Boundary System 1 (sys1)
globally accessible and could, for example, form o A Viewl
L. . 7, Geometry 1
a boundary condition for the current that is fed i2 Materials
to an electric device modeled as a second - X Electric Currents (eq)
I8l Heat Transfer in Solids (ht)
Component~ <ty Multiphysics
. . . £ Mesh1

The Component Couplings in Definitions have a ~ Study 1
wide range of uses. The Average « |, {E Results

Maximum «, and Minimum «« couplings have
applications in generating results as well as in
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boundary conditions, sources, sinks, properties, or any other contribution to the
model equations. The Probes # are for monitoring the solution progress. For
instance, you can follow the solution at a critical point during a time-dependent
simulation or for each parameter value in a parametric study.

You can find an example of using the average operator in “Parametric Sweeps” on
page 128. Also see “Functions” on page 172 for a list of available functions.

To learn more about working with definitions, in the Model Builder, click the
Definitions = or Global Definitions @ node and press F1 to open the Help
window @ . This window displays helpful information about the selected
item in the desktop and provides links to the documentation. It could take
up to a minute for the window to load the first time it is activated, but will
load quickly the next time it is opened.

Material Properties and Material Libraries

You have already used the functionality in the Materials node to access the
properties of copper and titanium in the busbar model. In the Materials node, you
are also able to define your own materials and save them in your material library.
You can also add material properties to existing materials. In cases where you
define properties that are functions of other variables, typically temperature, the
plot functionality helps you to verify the property functions in the range of
interest. You can also load Excel® spreadsheets and define interpolation functions
for material properties using LiveLink™ for Excel®.

The Material Library add-on contains over 2500 materials with tens of thousands
of temperature-dependent property functions. In addition, many of the add-on
products include material libraries relevant to their application areas.

First, investigate how to add properties to an existing material. Assume that you
want to add bulk modulus and shear modulus to the copper properties.

CUSTOMIZING MATERIALS
Let us keep working on the busbar.

I In the Model Builder, under Materials, click
Copper . Py

2= Materials
G == Copper (matl)

25 Titanium beta-215 (mat2)

Y Geometry 1
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2 In the Settings window for Material,

K . ¥ Material Properties
click to expand the Material

Properties section, which contains a Geomechanics Material :
. ~ Hyperelastic Material

list of all of the definable 4 Linear Elastic Material

properties. Anisotropic

Anisotropic, Voigt Motation

Expand the Solid Mechanics > Linear G Bulk Madulus and Shear Madulus

Elastic Material section. Right-click Cubic || | Add to Meterial :
amé Pararmerers

Bulk Modulus and Shear Modulus and Orthotropic

select + Add to Material. Orthotropic, Voigt Motation

Pressure-Wave and Shear-Wave Speeds
This lets you define the bulk T
modulus and shear modulus for the
copper in your model.

3 In the Copper node, locate the Material Contents section. Bulk modulus and Shear
modulus rows are now available in the table. The warning sign g indicates that
the values are not yet defined. To define the values, click the Value column. In
the Bulk modulus row, enter 140e9 and in the Shear modulus row, enter 46e9.

¥ Material Contents

Property MName Value Unit Property group
Bulk modulus K 1408 N/m? Bulk modulus and shear mod... | #
e A\ [Shear modulus G N.-"r'n2 Bulk modulus and shear mod...
[ Electrical conductivity sigma 5.998€7[5/... |5/m Basic
[¥ Heat capacity at constant pressure | Cp 385[)/(kg*... M(kgK) Basic
[ Relative permittivity epsilonr |1 1 Basic =
[ Density rho 8700[kg/m... kg/m®  Basic
[ Thermal conductivity k A400[W/ (m... W/(m-K) Basic
Relative permeability mur 1 1 Basic
Coefficient of thermal expansion alpha 17e-6[1/K] [1/K Basic
Young's modulus E 110e9[Pa] Pa Young's modulus and Poisson...
Poisson's ratio nu 0.35 1 Young's modulus and Poisson...|
Daformmen rarickisake rlaail 177 Qlals e Limmarimad racickisbe

By adding these material properties, you have changed the Copper material. You
can save this information in your own material library, but not in the read-only
Solid Mechanics materials library.

4 In the Model Builder, right-click Copper and seclect Add to User-Defined Library [i.

Geometry 1
4 32z Materials

22 Copper (matl)

it Titanium beta-2| i User-Defined Property Group

. Electric Currents (eq

'® Heat Transfer in Sol [[§ Add te User-Defined Library

& Multiphysics Copy a5 Codle to Clipboard
A Meshl
~dt Study 1 4 Wove Down
by -

To see this library, click the Browse Materials in the Materials tab in the ribbon.
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Adding Meshes

A model component can contain different mesh sequences for generating meshes
with different settings. A mesh sequence is an ordered set of instructions for
generating a mesh. Mesh sequences can be accessed by the study steps. In a study,
you can select which mesh you would like to use in a particular simulation.

In the busbar model, a second mesh node is now added to create a mesh that is
refined in the areas around the bolts and the bend.

ADDING A MESH

I Open the model busbar.mph that
. 4 & busbar Lmph (root)
was created earlier. 4 () Global Definitions

Pi Parameters

2 In order to keep this model in a

2 Materials
separate file for later use, select File e i Componentl fcompl]
> Save As and rename the model " Study 1 1 Add Physics
& Results

busbar_I.mph. 7 Add Multiphysics

3 To add a second mesh node,
right-click the Component | node
m and select Add Mesh 4, . (If you Copy as Codeto Clipboard
followed the instructions in
“Parameters, Functions, Variables, and Couplings” on page 98, the name of
Component | is Busbar instead.)

=3
& Insert Physics from Model
A Add Mesh

By adding another Mesh node, a Meshes parent node is created that contains
both Mesh I and Mesh 2.

4 Click the Mesh 2 node. In the
Settings window for Mesh under
Mesh Settings, sclect
User-controlled mesh as the
Sequence type.

¥ Mesh Settings

Sequence type:

| Physics-controlled mesh

User-controlled mesh
Physics-controlled mesh

A Size and Free Tetrahedral node
are now available under Mesh 2.
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5 In the Model Builder, under Mesh 2, click Size

- * | Settings
i~ Size
4 & busbar Lmph (root) & Build Selected |[E8 Build All G
4 (7)) Global Definitions
Pi Parameters Label:  Size =
2 Materials .
4 m Componentl {compl) Element Size
E__ Definitions Calibrate for:
A, Geometry 1 2 T
2 Materials Eneral physies
+\_ Electric Currents {ec) Predefined MNormal
Bl Heat Transfer in Solids {ht)
" . . - @ Custom
iy Multiphysics
4 £ Meshes * Element Size Parameters
A Mesh1
4 S Mesh2 Maximurn elerment size:

©

Size I*mh =
Free Tetrahedral 1 o .
Minimum element size:

~do Study 1
& Results G 2*(mh-mh/3) o

Maximum element growth rate:
15

Curvature factor:

02

Resolution of narrow regions:

0.5

The asterisk in the upper-right corner of a node icon indicates that the node is
being edited.

6 In the Settings window for Size, under Element Size, click the Custom button.
7 Under Element Size Parameters, enter:

- 2*mh in the Maximum element size ficld, where mh is 3 mm — the mesh control
parameter defined previously.

- 2*(mh-mh/3) in the Minimum element size ficld.
- 0.2 1in the Curvature factor ficld.
8 Click Build All = . Save the file as busbar_I.mph.

Compare Mesh | and Mesh 2 by clicking the Mesh nodes. The mesh is updated in
the Graphics window. An alternative to creating multiple meshes in this way is to
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run a parametric sweep of the parameter for the maximum mesh size, mh, that was
defined in the section “Global Definitions” on page 59.

Mesh | Mesh 2

Adding Physics

The distinguishing characteristics of COMSOL Multiphysics, particularly
adaptability and compatibility, are prominently displayed when you add physics to
an existing model. In this section, you will experience the ease with which this
seemingly difficult task is performed. By following these directions, you can add
structural mechanics and fluid flow to the busbar model.

STRUCTURAL MECHANICS

After completing the busbar Joule heating simulation, we know that there is a
temperature rise in the busbar. What kind of mechanical stress is induced by
thermal expansion? To answer this question, let us expand the model to include
the physics associated with structural mechanics.

To complete these steps, either the Structural Mechanics Module or the
MEMS Module (which enhances the core Solid Mechanics interface) is
required.

If you want to add cooling by fluid flow, or do not have the Structural
Mechanics Module or MEMS Module, read this section and then go to
“Cool by Adding Fluid Flow” on page 115.
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I Open the model busbar.mph that was created earlier. From the main menu,
select File > Save As and rename the model busbar_II.mph. Alternatively, you
could load the busbar.mph model from the Application Libraries as shown

4

carlier.

In the Model Builder, right-click
the Component | node m and
select Add Physics ;.

In the Add Physics window,
under Structural Mechanics, sclect
Solid Mechanics

To add this interface, you can
right-click and select Add to
Component or click the + Add to
Component button at the top of the
window.

Close the Add Physics window and
save the file.

4 & busbar_Lmph (root)
() Global Definitions
W Componentl fcompll
~d Study 1 2 Add Physics

& Results % Add Multiphysics
Insert Physics from Model

ic=3
A Add Mesh

Copy as Code to Clipboard

Add Physics

=+ Addto C.Dmponant = Add to Selection

ﬂ ﬂ Electrochemistry
= Fluid Flow
Heat Transfer
Ifie Optics
&) Plasma
¥ Radio Frequency
’:é Semiconductar
E=7 Structural Mechanics
E= Solid Mechanics (solid)

(32

[j Shell (shell) =+ Addto Component
] Membrane (mbr| =+ Add to Selection
L Beam (beam)

Truss (truss)

2 Multibody Dynamics (mbd)

3:53 Lumped Mechanical System (Ims)
:"?:é Roterdynamics

55 Thermal Stress

©

Search

When adding additional physics, you need to make sure that materials
included in the Materials node have all of the required properties for the
selected physics. In this example, all properties are already available for

copper and titanium.

You can start by adding the effect of thermal expansion to the structural

analysis.
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5 In the Model Builder, right-click the

4 523 Solid Mechanics (solid)

Multiphysics node .=, and select BB Linear Elstic Materil |
. m Freel
Thermal Expans'°n .. i Initial Values 1
. . El .f._’h. Multiphysics
A Thermal Expansion node is added ! Electrom| € Equilibrium Discharge Heat Source
to the model tree. “ﬁ)ﬁcﬁ?hl ¥ Piezoresistive Effect, Domain Currents
Y =2
. (@ Results G =8 Thermal Expansion
YOu can alSO use the rlbbon and E‘a Equilibrium Discharge Boundary Heat Source
SClCCt, from the Phys“:s tab) m Thermoelectric Effect
Multiphysics > Thermal Expansion. 2l Electromagnetic Heating
II[-? Temperature Coupling

6 In the Settings window for Thermal

Expansion, from the Selection list, ot
select All domains. This will enable

thermal expansion in the copper as label:  Thermal Expansion 1 5
well as in the titanium bolts. Name:  tel

The Thermal Expansion Properties = B SHEsE

section of this window shows G Section: (PTG =
information about the Coefficient of L

thermal expansion and the Strain 2

reference temperature (there are Active i

also some more advanced settings.) :

The Coefficient of thermal expansion 7

takes its value from the Materials

node. The Strain reference > i

temperature has a default value of ~ Model Input .S

293.15 K (room temperature) and
defines the temperature for which
there is no thermal expansion. The Input type:

coupled Interfaces section at the Secant coefficient of thermal expansion -
bottom of the Settings windows
shows which two physics interfaces
define the physics for heat transfer

¥ Thermal Expansion Properties

Coefficient of thermal expansion:
14 From material -

Strain reference temperature:

- g <t Tref  293.15[K] K
and solid mechanics. This is useful
in the case where there is more than = (FGEL SRS
one physics interface for heat 7] Thermoelastic damping
transfer or solid mechanics in the Ml
model component. Keep all default v Coupled Interfaces
settings in this window. Heat transfer:
Next, constrain the busbar at the Heat Transfer in Solids (ht) =
position of the titanium bolts. Shuctue:
Solid Mechanics (zolid) -
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7 In the model tree, right-click Solid Mechanics = and from the boundary level,
select Fixed Constraint = . A node with the same name is added to the tree.

Click the Fixed Constraint node = . In the Graphics _ -

. . . 4 ﬁ;‘ Solid Mechanics (solid)
window, rotate the busbar to view the back. Click the BB |inear Elastic Material 1
circular surface of one of the bolts to add it to the T Freel

. . T Initial Values1
Selection list.

o Fixed Constraint 1

Repeat this procedure for the remaining bolts to add
boundaries 8, 15, and 43.

Boundary Selection

Selection: | Manual v|
: .
15 E -
13 e -
Active F‘D ‘ﬁj

For easier management of e =
multiple boundary selections, you Section rame: [BotTop sifaces

can group boundaries into a ok [ Goncel |
user-defined selection. Once you
have selected boundaries 8, 15,
and 43, click the Create Selection button . and give it a name such as Bolt
top surfaces.

This selection is then added as a node under Component | > Definitions and
is accessible from the Selection list in the Settings window for all types of
boundary conditions. You can use this technique to group domains,
boundaries, edges, and points.

Model Builder - | Settings
- = - ETEL G- Fixed Constraint

< busbar_L.mph (root)
@ Global Definitions
<4 Im Component1 (compI)
4 = Definitions
& Bolttop surfaces Selection: | Bolt top surfaces -|
| Boundary System 1 (sys1)
Viewl 8 b
}‘)\ Geometry 1 g % -
8 Materials Active B &
+\_ Electric Currents (eg) b
|18 Heat Transfer in Solids (ht) N
rl @ Solid Mechanics (solid)
T Linear Elastic Material 1

Label: Fixed Constraint 1

Boundary Selection
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Next, we update the Study node to take the added physics into account.

SOLVING FOR JOULE HEATING AND THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar,
assuming temperature invariant materials, small deformations, and ignoring the
effects of electric contact pressure. This means that you can run the simulation
using the temperature as merely an input to the structural analysis. In other words,
the extended multiphysics problem is weakly coupled. As such, you can solve it in
two separate study steps to save computation time — one for Joule heating and a
second one for structural analysis. In a more advanced analysis, you can include all
of the aforementioned effects.

For this example, you can skip these steps and just click Compute.
However, the following technique can be useful for saving computational
time and memory resources, especially for larger simulations.

I In the Model Builder, right-click Study | - and select
Study Steps > Stationary > Stationary - to add a 4 ;d;:.p 1: Stionary

second stationary study step. G [~ Step 2: Stationary 2
[*r. Solver Configurations

K

When adding study steps, you need to manually connect the correct
physics with the correct study step. We start by disabling the structural
analysis from the first step.

2 Under Study 1, click the Step I: Stationary node !

4 ~db Study 1
3 In the Settings window for Stationary, locate the E S—
. . . —, Step 2: Stationary
Physics and Variables Selection. . Solver Configurations

4 In the Solid Mechanics (solid)

row under Solve for. click to ¥ Physics and Variables Selection
b

Changc the check mark + to Medify model configuration for study step
an [] to remove Solid " Physics interface Solve for Discretization
Mechanics frOIn study step 1 Electric Currents (ec) ™ Physics settings =

Heat Transfer in Solids (ht) ™ Physics settings =

Solid Mechanics (solid) EI Physics settings =

In the Multiphysics section,
keep all of the default c
settings.

Now, repeat these steps to remove Electric Currents (ec) and Heat Transfer in
Solids (ht) from the second study step.

5 Under Study I, click Step 2: Stationary 2 '-. 4 o Study 1
E Step 1: Stationary

6 E Step 2: Stationary 2

[*r. Solver Configurations

K

K
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6 Under Physics and Variables
Selection, in the Electric
Currents (ec) and Heat

¥ Physics and Variables Selection

[T] Modify model configuration for study step

"

Transfer in Solids (ht) rows, Physics interface Solve for Discretization
. . Phveics cetti -
Clle to Change thC ChCCk 2 Electric Currents (ec) O ysics settings
! : Phveics setti -
mark & to an [] to remove Heat Transfer in Solids (ht) EI ysics settings
Solid Mechanics (solid) ™ Physics settings =

Joule heating from Step 2:
Stationary 2.

7 Right-click the Study |
node ~» and select Compute = (or press F8 or click Compute in the ribbon) to
solve.

4 ~cn Study ]
G E Stg = Compute F8
[= ste ' Update Solution F5

e So

{E Result! 22 Parametric Sweep

Save the file as busbar_II.mph, which now includes the Solid Mechanics interface
and the additional study step.

RESULTING DEFORMATION

Now that a physics interface has been added, additional plots for Selid Mechanics
need to be added manually. First, a displacement plot.

I Under Results > 3D Plot Group 4, click the Surface | node ™.

4 ([ Results
H Data Sets

£ Derived Values
EH Tables
VB Electric Potential (ec)
W& Termperature (ht)
i Isothermal Contours (ht)
VB 3D Plot Group 4
G ™ Surfacel

Export

55 Reports
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2 In the Settings window for Surface in the

A R R ~ Expression + - G-
Expression section, click the Replace .
. pre;smn:
Expression button . G oidiep
Unit:
mm -
Description:
Total displacerment
From the context menu, select Model > 4 Model
Component | > Solid Mechanics > 4 Component1
. . . Definitions
Displacement > solid.disp - Total Electric Currents
displacement. Geometry
. . . Global
You can also enter solid.disp in the Heat Transfer in Solids
. Multiphysics
EXPI’ESSIOH ﬁeld 4 Solid Mechanics
Now, change to a more suitable unit. In Acceleration and velocity
. . . 4 Displacement
the Settings window under Expression, Curl of displacement (Material)
from the Unit list, select mm (or type mm in G solid.disp - Total displacement
h f ld Displacement field (Material)
the fic ) Energy and power
Geometry
Global

Heating and losses
3 Click Range to expand that section. Click
to clear the Manual color range check
box.

Title

¥ Range

e Manual color range

The local displacement due to thermal expansion is displayed as a surface plot.
Next, we will add information about the busbar deformation.

4 In the Model Builder, under Results > 3D Plot Group 4, right-click the Surface |
node ™ and add a Deformation node =s. The plot automatically updates in the
Graphics window. Click the Go to Default 3D View button .. so your view appears
similar to the plot shown below.
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The deformations shown in the figure are highly amplified to make the
very small distortions that actually take place more visible.

Surface: Total displacement [mm)

5 Save the busbar_II.mph file, which now includes a Surface plot with a
Deformation.

You can also plot the von Mises and principal stresses to assess the
structural integrity of the busbar and the bolts.

OVERRIDE AND CONTRIBUTION: EXCLUSIVE AND CONTRIBUTING NODES

The model tree nodes for a physics interface are traversed in a downward sequence
starting from the top. Depending on the selection, a node can totally or partially
override, or shadow, a node that comes earlier in the sequence. There are two
types of physics interface nodes: exclusive and contributing. How the nodes are
treated depends on the type.

A constraint boundary condition is a typical example of an exclusive node.
Examples of constraint boundary conditions include Electric Potential or Fixed
Constraint. In the case of Electric Currents, for example, if there are two or more
Electric Potential nodes for the same boundary, then the last Electric Potential node
in the sequence will override the settings of the other nodes. The Ground node is
also an exclusive node and will similarly override the boundary conditions specified
by any previous node.
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The figure below shows the Override and Contribution section in the Settings
window for Electric Potential. The Overrides list indicates that this boundary
condition takes precedence over the default Electric Insulation boundary condition.

viodel Builde -3
- } =~ TtE -
4 G busbar Lenph froot) - -
a4 ([} Global Definitions Lateek | Electric Povential =
Fi Parameters .
i Miterials * Bowndary selection
4 @ Component1 feomp1) Selection: | Manual -
= Definiticns
Geemetry 1 H 4 &
i1 Matesials 'm =
4 3% Electric Cuments (e} Active B B

W Cument Censeration 1
% Flectric Insulation 1
T Initial Values 1
s Flectric Potential 1
= Ground 1 = Owernde and Contribution
K& Hrat Transfer in Salids (ht)
£ Solid Mechanies (sadid) Uvemdiden by:
A Multiphysics
A Meshl
o Stisdy 1
& Results

Owverrides:
Blectng Insulstion 1

A flux boundary condition, such as one specifying a heat flux, is a typical example
of a contributing node. You can stack several heat flux boundary conditions and
they will all contribute to the total heat flux. The figure below shows an example
where a Heat Flux 2 boundary condition overrides the default Thermal Insulation

boundary condition and contributes to the heat flux together with Heat Flux 1.

vicdel Builder T
- = LWl
4 @ bushar Lenph (rmat)

4 3 Glokal Definitians

Py Parameters

Label:  Heat Flee 1

i Matesials * Boundary Seledtion

4 @ Companent1 frompi)

Selection: | Manual -
= Definitions
Geometry 1 2
i Matesials :
22 Plectric Currents (rg) Active g
4 |K& Heat Transfer in Salids (ht) 6
& Solid1 7
B Titial Valaes 1 ?'frjrl_-!PF'-lcwleli'_ -
g Theemal Insulation 1 T
w Heat Fhux 1 = Overnde and Contribution
£ Saliel Mechanics (soid)
Ay Muiphysics Overiidden by:
A Mesh1
s Study 1
R Results
Orverrides:

Thermal Insulation 1

In the model tree, the override and contribution relationships are indicated by a
red arrow and an orange circle, respectively.
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CooL BY ADDING FLUID FLOW

After analyzing the heat generated in the busbar and possibly the induced thermal
expansion, you might want to investigate ways of cooling the busbar by letting air
flow over its surfaces. These steps do not require any additional modules, as the
model only includes Joule heating without the previous thermal expansion
analysis.

If you have the CFD Module, the Non-Isothermal Flow multiphysics interface
is available. If you have the Heat Transfer Module, the Conjugate Heat
Transfer multiphysics interface is available. Either one of these two interfaces
automatically defines coupled heat transfer in solids and fluids including
laminar or turbulent flow, whereas in this example, this is done manually and
with limited functionality.
Adding fluid flow to the Joule heating model creates a new multiphysics coupling.
To simulate the flow domain, you need to create an air box around the busbar for
the external flow. You can do this manually by altering the geometry from your
tirst model or by opening an Application Library file. To save time, open a file with
the box already created.
After loading the geometry, you will learn how to simulate air flow according to
this figure:

Air outlet

a1

Air inlet

DEFINING INLET VELOCITY

Start by loading the geometry and adding a new parameter for the inlet flow
velocity.
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I If you have just reopened the software, close the New window that opens
automatically by clicking the Cancel button & .

2 Click the Home tab, and from the Windows menu select Application Libraries [ .
Navigate to COMSOL Multiphysics > Multiphysics > busbar box. (You can also
open the Application Libraries directly from the File menu.)

Double-click to open the file, — . .
which contains the geometryin  Application Libraries
addition to the physics

' Refresh rﬂﬂ Update COMSOL Application Libraries (7)) Application Gallery

modeling steps completed | et
through the end of the section 4 [3 COMSOL Multiphysics .
“Customizing Materials” on % reeons |
coustics £l
page 102 [l[i Chemical Engineering
[ifii Diffusion

[I[ii Electromagnetics
[[[fi Equation Based
[Ifii Fluid Dynamics

[l Geophysics
[I[fi Heat Transfer
[l Meshing Tutorials

4 [[[l Multiphysics
6 @ busbar_box
O busbar_geom
® busbar -

Run Application Open

Open PDF Document

3 Under Global Definitions, click the Parameters node -« .

4 In the Settings window for Parameters, click the empty row just below the Vtot
row. In the Name column, enter Vin. Enter 1e-1[m/s] in the Expression column
and a description of your choice in the Description column, such as Inlet
velocity.

Model Builder - ® | Settings
- = v STE G~ Parameters
4 4 busbar_box.mph (root)
4 (7 Global Definitions ¥ Parameters
e Fi Parameters
== Materials " Name Expression Value Description
4 [ Componentl fcompl) L 9[cm] 009 m Length
= Definitions rad_1 6[mm] 0.006 m Bolt radius
4 Geometry1 thh S[mm] 0.005 m Thickness
{§ Work Plane (wp1) whb 5[cm] 0.05m Width
[E] Extrudel fextl) mh 3[mm] 0.003 rn Maximum element size
& Work Plane 2 (wp2) hte S[W/ " 2/K] 5 W/ (m*K) Heat transfer coefficient
[F] Bxtrude2 (ext2) Vtot 20[mV] 002V Applied voltage
E Work Plane 3 (wp3) Vin le-1[m/s] 01 m/fs Inlet velocity o

o Extrude3 [(ext3)
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5 Select File > Save As and save the model with a new name, busbar_box_I.mph.

ADDING AIR

The next step is to add the material properties of air.

I From the Home tab, select Add Material i (or right-click the Materials node and

select Add Material from Library.)

2 In the Add Material window, expand
the Built-In node. Right-click Air and
select Add to Component 1. Close the
Add Material window.

3 In the Model Builder under Materials,
click the Air node .

4 oo2 Materials
I» £z& Copper (matl)
[» &g= Titanium beta-215 (mat2)

e [» aga Air (mat3)

4 On the Graphics window toolbar, click
Zoom Extents [7].

5 In the Graphics window, click the air
box (domain 1) to add it to the
Selection list, which changes the
color to blue. This step assigns the
air material properties to the air box.

Settings
Material
Label:  Air

Geometric Entity Selection

Geometric entity level: |M
Selection: |W
: %

-
Active ﬁ:l E

&

ADDING FLUID FLOW
Now, add the physics of fluid flow.

Add Materia
=+ Addto Component » < Add to Selection

I 425 Recent Materials =
I+ [ Material Library
4 @ Built-In

“as Air
sas Ac
sas Alg
sas Alg

sas Alg

) Add to Global Materials

@ Addto Component1

=4 Add to Selection

I In the model tree, right-click Component | @ and sclect Add Physics ;.
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2 In the Add Physics window under
Fluid Flow > Single-Phase Flow,
right-click Laminar Flow - and
select + Add to Component.

. . (O Recently Used
Laminar Flow will appear under X AgDC
Component | in the model tree. 22 Gt Soscies Transgort
Close the Add Physics window. L] Electrochemistry

4 == Fluid Flow
4 == Single-Phase Flow

Add Physics vEX

Ad

+ Add to Component + Add to Selection

Search

3 In the Graphics toolbar, click the
Creeping Flow (spf)

Transparency button &. In G = L R )

addition CliCk thC Wireframe Turbulent Flow =+ Addto Component
> I Rotating Machinery - p4q g Selection
Rendering button m. These two 2 Pipe Flow (610
settings make it easier to see inside
the box. Toggle these on and oftas

needed during the modeling process to control the type of rendering used.

m

Now that you have added fluid flow to the model, you need to remove the air
domain (domain 1) from the Electric Currents (ec) interface (assuming that the
air has no electric conductivity and hence no currents) and then couple the heat
transfer part of the Joule Heating multiphysics interface to the fluid flow.

4 In the model tree, select the

Electric Currents (ec) node et
x . In the Graphics window, :
move the mouse pointer ‘ |
over the air domain and '
click to remove it from the . L
selection list. At this point, c e
only the busbar should be '
selected and highlighted in
blue.

0.1
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5 In the Model Builder, right-click Heat Transfer in Solids & . In the first section of
the context menu, the domain level &, select Fluid.

-

,'é: Materials

[ +\_ Electric Currents [ec) Solid

4 |[@ Heat Transfer in Solids (ht) Fluid o
i Solid1
Bm Initial Values 1 Phase Change Material
S Thermal Insulation 1 Heat Source

= Heat Flux1
4 == Laminar Flow (5pf)
il Fluid Properties 1

Initial Values

Temperature
i Initial Values1
T Walll

4§ Multiphysics
| Electromagnetic Heatin

Thermal Insulation

Outflow

vy unnuw

Inflow

6 In the Graphics window,
click the air domain
(domain 1) to add it to
the Selection list.

Now, couple the fluid
flow and heat transfer
phenomena.

7 In the Settings window for

Fluid in the section Model Inputs, v Model Inputs 4

select Velocity field (spf) from the Temperature:

Velocity field list. Then, select T | Temperature (ht) |

Absolute pressure (spf) from the o Absolute pressure:

Absolute pressure list. Pa | Absolute pressure (spf) -]
.. . Velocity field:

This identifies the flow field and o u [V a

pressure from the Laminar Flow
interface and couples it to heat transfer.

Now, define the boundary conditions by specifying the inlet and outlet for the
heat transfer in the fluid domain.
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8 In the Model Builder, right-click Heat Transfer

*_ Electric Currents (ec)

in Solids 1=. In the second section of the 4 B Heat Transfer in Solids (ht)
context menu, the boundary section w , select i Solid1
T " i Initial Values1
emperature. S Thermal Insulation 1
A Temperature node is added to the model = :e?; i'“"l
= Flui

tree. G ¥y Temperature 1

4 == Laminar Flow {spf]

i Fluid Properties 1

T Initial Values1

T Walll

4 5 Multiphysics
x| Electromagnetic Heating1 {emhl)
9 In the Graphics window,

click the inlet boundary,
boundary number 2, to add

it to the Selection list. o™

This sets the inlet |
temperature to 293.15 K, |
the default setting. 0

The graphics should look N
like the image to the right. 'm-.____
(It may look slightly N
different depending on
whether you have
Transparency and Wireframe
Rendering on or oft.)
Continue by defining the
outlet.

10In the Model Builder, right-click Heat Transfer in Solids = . At the boundary level,
select Outflow. An Outflow node = is added to the model tree.

i Materials

+\_ Electric Currents (ec) = Solid

4 | I8 Heat Transfer in Solids (ht) = Fluid
Dmm H
ww oolid1 - .
PR [nitial Values 1 & Phase Change Material
S Thermal Insulation 1 {= Heat Source
o Heat Fluxl 1= Initial Values
= Fluidl
= Temperature 1 = Temperature

4 == Laminar Flow {spf) = Thermal Insulation
P— ;
::: F|.Lll.d Properties 1 = Outflow @
ww [nitial Values1
T Walll = Inflow

4y Multiphysics = Symmetry
* . .
x| Electromagnetic Heating = Heat Flux

A Mesh1
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Il In the Graphics window,
click the outlet boundary,
boundary number 5, to
add it to the Selection list.
Use the mouse scroll wheel
to scroll in and highlight
the boundary before
selecting it, or use the up
and down arrow keyboard
buttons.

o

The settings for the busbar, the bolts, and the Electric Potential | and

Ground | boundaries have retained the correct selection, even though you
added the box geometry for the air domain. To confirm this, in the model
tree under Electric Currents, click the Electric Potential 1 and the Ground |

nodes to verify that they have the correct boundary selection.

Settings

Electric Potential

Label: Electric Potential 1
Boundary Selection

Selection: | Manual

=k

Active

Cverricde and Contribution
Equation
¥ Electric Potential

Electric potential:

Vo Vot

e
B

[

i

Label: Groundl
Boundary Selection

Selection: | Manual

on )| (13
20

Active

Cverricde and Contribution

Equation

e

[

Next, continue with the flow settings. You need to indicate that fluid flow only
takes place in the fluid domain and then set the inlet, outlet, and symmetry

| 121



conditions. Do this by first removing all domains from the selection and then
adding the air domain.

I In the model tree, click the Laminar Flow node =-. In the Settings window for
Laminar Flow, click the Clear Selection button .

Settings
Laminar Flow

Label:  Laminar Flow
Mame:  spf

Domain Selection

Selection: | All domains -
o) | |1 L]

; B -
Active |4 = [Tj .'E:I] G

5 e

6

7

a —

2 In the Graphics window, click the air box (domain 1) to add it to the Selection.

It is good practice to verify that the Air i s Mater
X . == Materials
material under the Materials node has all of 51 Copper (matl)
the properties that this multiphysics i@ Titanium beta-215 {mat2)
. . . o= Air (mat3)
combination requires. In the model tree
under Materials, click Air. In the Settings
window for Material under Material Contents, verify that there are no
missing properties, which are marked with a warning sign 4 . The section
“Materials” on page 65 has more information.

Now, we continue with the boundaries.

3 In the Model Builder, right-click Laminar Flow - and at P
. = Laminar Flow (spf)
the boundary level, select Inlet. An Inlet node = is BB Fluid Properties 1

added to the model tree. = Initial Values 1
O Wall1

e y Inletl
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4 In the Graphics window,
click the inlet (boundary 2)
to add it to the Selection list.

5 In the Settings window for
Inlet under Velocity in the U,
field, enter Vin to set the
Normal inflow velocity.

- Velocity

@ MNormal inflow velocity

() Velocity field

Uy  Vin mfs

6 Right-click Laminar Flow
and at the boundary level, select
Outlet =. In the Graphics
window, click the outlet
(boundary 5) to add it to the
Selection list. Use the mouse
scroll wheel or keyboard arrows
to scroll in and highlight the
boundary before selecting it.

The last step is to add symmetry
boundaries. For simplicity,
assume that the flow just outside
of the faces of the channel is
similar to the flow just inside
these faces. This assumption can
be correctly expressed by the
symmetry condition.

7 Right-click Laminar Flow - and select Symmetry. A Symmetry node = is added
to the sequence.
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8 In the Graphics window, click each of the blue faces in the figure below
(boundaries 1, 3, 4, and 48) to add all of them to the Selection list. You may need
to use the mouse scroll wheel or rotate the geometry to select all of them.

Save the busbar_box_I.mph

file, which now includes the

Air material and Laminar Flow
interface settings.

(87

When you know the

boundary numbers, you can D Paste Selection o
click the Paste Selection Selection:  1.3.4,48]

button i and enter the [ ok Cancel
information. In this m—

example, enter 1,3,4,48 in
the Paste Selection window.
Click OK and the boundaries are automatically added to the Selection list.

COARSENING THE MESH

To get a quick solution, we will change the mesh slightly and make it coarser. The
current mesh settings would take a relatively long time to solve, and you can
always refine it later.

I In the Model Builder, cxpand the Mesh | node 4 and
click the Size node gi. o it

@ Free Tetrahedral 1
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2 In the Settings window for Size
under Element Size, click the
Predefined button and ensure ) Build Selected [ Build Al
that Normal is selected.

ettings M

Label: Size

Element Size

Calibrate for:

General physics -

G @ Predefined MNormal -

) Custom

3 Click the Build All button m . The geometry displays with a mesh in the Graphics
window (you may need to turn Transparency off to see the picture below.)

You can assume that the flow velocity is large enough to neglect the influence of
the temperature increase in the flow field.

It follows that you can solve for the flow field first and then solve for the
temperature using the results from the flow field as input. This is implemented
with a study sequence.

SOLVING FOR FLUID FLOW AND JOULE HEATING

When the flow field is solved before the temperature field, it yields a weakly
coupled multiphysics problem. The study sequence described in this section
automatically solves such a weak, or one-directional, coupling.
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I In the model tree, right-click Study | - and select Study Steps > Stationary >
Stationary - to add a second stationary study step to the Model Builder.
(Bl Heat Transfer in Solids (ht)

= Laminar Flow (spf)
ity Multiphysics

£ Mesh1
4 b Sty
=] = Compute F8
T
[ Re Parametric Sweep
i) Function Sweey
) ) g 4 ~db Study 1
IS MalzralSa=ep E Step 1: Stationary
o
~on Study Reference G E Step 2: Stationary 2
[« Optimization [*r. Solver Configurations
]/_/‘ Parameter Estimation
Study Steps 3 Stationary b | [= Stationary
Time Dependent » ]g: Stationary Plug Flow
Show Default Sobver P = ry Flug
5 Get Initial Value Eigenfrequency v & Bidirectionally Coupled Particle Tracing
Copy as Code to Clipboard ' Frequency Domain v | Bidirectionally Coupled Ray Tracing
E Delete Del Other b | [== Frequency-Stationary
El] Rename B t Stationary, Fluid
= Stationary, Solid
Settings
IE Properties
Help F1

Next, the correct physics needs to be connected with the correct study step.
Start by disabling the Electric Currents (ec) and Heat Transfer in Solids (ht)
interfaces associated with Joule heating from the first step.

2 Under Study 1, click Step I: Stationary .

© ©

4~ Studyl ~ Physics and Variables Selection

E Step 1: Stationary

[= Step 2: Stationary 2 [T Medify model configuration for study step

[*r. Solver Configurations "
Physics interface Solve for Discretization
Electric Currents (ec) O Physics settings =
Heat Transfer in Solids (ht) EI Physics settings =
Laminar Flow (spf) ™ Physics settings =

3 In the Settings window for Stationary, locate the Physics and Variables Selection
section. In both the Electric Currents (ec) and the Heat Transfer in Solids (ht)
rows, click to change the check mark @ to an [0 in the Solve for column,
removing the Joule heating effect from Step 1.
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4 Repeat the step. Under Study I, click Step 2: Stationary 2 . Under Physics and
Variables Selection, in the Laminar Flow (spf) row, click in the Selve for column to
change the check mark = to an 7.

¥ Physics and Variables Selection

Medify model configuration for study step

Physics interface Solve for Discretization
Electric Currents (ec) ™ Physics settings =
Heat Transfer in Solids (ht) ™ Physics settings =

G Laminar Flow (spf) EI Physics settings =

5 Right-click the Study I node - and select Compute = (or press F8 or click
Compute in the ribbon). This will now automatically create a new solver
sequence that solves for laminar flow and then Joule heating.

4 ~cn Study ]
E Stg = Compute F8 o
[= ste ' Update Solution F5
e So

{E Result! 22 Parametric Sweep

6 After the solution is complete, select the Temperature (ht) plot under the Results
node in the Model Builder. If you do not already have transparency on, click the
Transparency button & on the Graphics toolbar to visualize the temperature field
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inside the box. To zoom, middle-click and hold down the mouse button (or
scroll wheel) while dragging the mouse.

Surface: Temperature (K}

Y._I!x

o

The Temperature Surface plot that displays in the Graphics window shows the
temperature in the busbar and in the surrounding box. You can also see that the
temperature field is not smooth due to the relatively coarse mesh. A good
strategy to get a smoother solution would be to refine the mesh to estimate the
accuracy.

7 At this point, save the busbar_box_I.mph file so you can return to it at any time.
The next steps use the original busbar.mph file.

Parametric Sweeps

SWEEPING A GEOMETRIC PARAMETER

It is often useful to generate multiple instances of a design with the objective of
meeting specific constraints. In the previous busbar example, a design goal might
be to lower the operating temperature or decrease the current density. We will
demonstrate the former. Since the current density depends on the geometry of the
busbar, varying the width, wbb, should change the current density and, in turn,
have some impact on the operating temperature. Let us run a parametric sweep on
wbb to study this change.
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ADDING A PARAMETRIC SWEEP

I From the File menu, open the 4 % busbar.mph (root)

model file busbar.mph. If you (@ Global Definitions

did not save the model, you can G E Etzr;:f”e”tl fcompl)

also open it from the Application 4 [Bi Results) = Compute P8
Libraries: File > Application & Dat & ypdate Solution s
Libraries > COMSOL Multiphysics > i o[l Porametic weep
Multiphysics > busbar. W Eled 709 Function Sweep

In the Model Builder, right-click
Study | = and select Parametric Sweep iii. A Parametric Sweep node is added to
the Model Builder sequence.

2 In the Settings window for Parametric Sweep, under the empty parameter table,
click the Add button +. From the Parameter names list in the table, select wbb.

Model Builder Settings =

- F v oot

4 < busbarmph {root) = Compute C' Update Solution
() Global Definitions
I Componentl (compl) Label: Parametric Sweep =

4 oo Study 1 -
G Parametric Sweep ¥ Study Settings

L Step 1: Stationary

Sweey e: | Specified combinations -
[P=. Solver Configurations il B
" Parameter name Parameter value list Parameter unit
whb (Width A
&1 Derived Values 6 GG |
B Tables L (Length)
Wi Electric Potential (ec) rad_1 (Bolt radius)
i'.* Temperature (ht) tbb (Thickness)
i [sothermal Contours (ht) whb (Width) bed
h (Maximum element size)
Current D m
Wl Current Density htc {Heat transfer coefficient)
Vtot (Applied voltage)

[T Plot

Plot group: | Electric Potential (ec)

The Sweep type is used to control parametric sweeps with multiple
parameters. You select between sweeping for All combinations of the
given parameters or a subset of Specified combinations.
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3 Enter a range of parameter values to sweep the width of the busbar from 5 cm
to 10 cmin 1 cm increments. There are different ways to enter this information:

- Copy and paste or enter range (0.05,0.01,0.1) into the Parameter value list
field.

- Click the Parameter value list ficld

and then click the Range |..| button Q) Range =
and enter the values in the Range Entry method:
dialog box. In the Start field, Step =
enter 5e-2. In the Step field, enter Start:
1e-2, and in the Stop ficld, enter 5e-2
1e-1. Click Replace. Step:
- In any of the methods, you can e
also use length units to override Slt:pll

the default SI unit system using
meters. Instead of 5e-2, you can

Function to apply to all values:

enter 5[ cm]; similarly, 1[cm] e -

instead of 1e-2 and 10[cm] Replace || Add || Cancel e
instead of 1e-1. You can also -

change the default unit system + stucy Settings

from the Settings window of the Swecp type | Speciied combinations B
root node in the model tree. " Parometer name _ Parameter vaue s Parameterurit

Next, define an Average component
coupling that can be used later to
calculate the average temperature in the busbar.
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4 Under Component I, right-click Definitions =

Average . .

4 & busbar.mph (root)

I (7 Global Definitions
4 m Componentl {compl)

= Definitions

and select Component Couplings >

A\ Geometry 1
2 Materials
+\_ Electric Cur
B Heat Transfi
.{;3. Multiphysig
P A Meshl

4 ~on Study 1
Parametric
Step 1: Sta
I e Solver Conf

I {8 Results

2= Variables

Variable Utilities

View

Functions

Probes

Compoenent Couplings
Selections

Pairs

Coordinate Systems
Moving Mesh

Infinite Element Domain

Perfectly Matched Layer

Group by Type

/= Update Probes

General Extrusion
Linear Extrusion
Boundary Similarity
Identity Mapping

General Projection

Linear Projection

' Integration

Average
Maximum

Minimum

5 In the Settings window for Average, sclect All domains from the Selection list.

Wodel Builder
- =+ =t
4 & busbar.mph (root)

I (7 Global Definitions

4 m Componentl {compl)

4 = Definitions
o

& Tibolts

1=/ Boundary System 1 (sysI)

; View1
A\ Geometry 1
2 Materials

.{;3. Multiphysics
A Mesh1
4 ~on Study 1

This creates an operator called aveop1. This operator is now available to

Averagel (aveopl)

+\_ Electric Currents {ec)
Bl Heat Transfer in Solids {ht)

2 Parametric Sweep
]/_. Step 1: Stationary

¥ /| Settings
]S Average
Label: Average 1
Operator name:  aveopl

Selection:

Active

©

B N Y

Source Selection

Geometric entity level:

¥ Advanced

Domain

All domains

bt}

calculate the average of any quantity defined on the selected domains. Later, we
use this tool to calculate the average temperature, but it can also be used to

calculate average electric potential, current density, and so forth.

6 Sclect File > Save As to save the model with the new name, busbar_III.mph.
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7 Right-click Study | ~» and select Compute = to run the sweep or click Compute
in the Home tab.

PARAMETRIC SWEEP RESULTS
Click the Temperature (ht) 1 node (the second

4 ([ Results
temperature plot node) located under Results in the b i DataSets
model tree. &2 Derived Values

EH Tables

The plot that displays in the Graphics window shows
the temperature in the wider busbar using the last
parameter value, wbb=0.1[m] (10[cm]). Select Zoom
Extents [7] from the Graphics window toolbar so that
you can see the entire plot. The resulting plot is rather = othermal Contours (ht) L
uniform in color, so we need to change the maximum Export

color range. B4 Reports

Wi Electric Potential (ec)
VB Temperature (ht)

i Isothermal Contours (ht)
W& Current Density

VB Electric Potential (ec) 1
il Termperature (ht) 1

whb(8)=0.1 Surface: Temperature (K]

36

3

312

311

310

i NS

I Under the Temperature (ht) 1 node, click the Surface node ™.

I\l Electric Potential (ec) 1
4 @ Temperature (ht) 1

h
Surface
i Isothermal Contours (ht) 1
Export
55 Reports
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2 In the Settings window for Surface, click J—
Range to expand the section. Select the Ml color ance
Manual color range check box. Enter i 3 19429
309.5 in the Maximum field (replace the N S
default). lal

3 The Temperature (ht) 1 plot is updated @ Maximum:
in the Graphics window for wbb=0.1[m] ]
(10[cm]).

309.4

wbb(6)=0.1 Surface: Temperature (K}

308.27

The plot may look a bit different depending on which version you are running.
Compare the wider busbar plot to the temperature for wbb=0.05[m] (5[cm]).
For this purpose, you can reuse one of the previously defined plot groups.
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I In the Model Builder, click the first Temperature (ht) node w.
4 ([ Results

E Data Sets
£ Derived Values
EH Tables
- Wi Electric Potential (ec)
G il Termperature (ht)
i Isothermal Contours (ht)
W& Current Density
VB Electric Potential (ec) 1
4 @ Temperature (ht) 1
™ Surface
% Isothermal Contours (ht) 1
Export
Reports

2 In the Settings window for

3D Plot Group, sclect ot
Study I/Parametric Solutions
| from the Data set list. This
data set contains the results Labek | Temperature (i)
from the parametric sweep. - baE

3 In the Parameter value list, Data set: Study 1/Parametric Solutions1  ~ | |4
select 0.05 (which represents e Parameter value (wbb): | 0.05 =

wbb=5 cm). Click the Plot
button @ . Click the Zoom
Extents button [ on the Graphics window toolbar.
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The Temperature (ht) plot is updated for wob=0.05[m] (5[cm]). Note that if you
have updated the color range for this plot already, your plot should look similar to
the one below. If not, follow the subsequent steps.

whb(1)=0.05 Surface: Temperature (K)

— 3232

322.4

Like the wider busbar, the plot may be quite uniform in color, so change the
maximum color range.

I Under the first Temperature (ht) node, click the Surface node ™.

2 In the Settings window for Surface, click Range to expand the section (if it is not
already expanded). Select the Manual color range check box.

3 Enter 323.25 in the Maximum field (replace the default).

The Temperature (ht) plot is updated in the Graphics window for wbb=0.05[m]
(5[cm]).

Click the first and second Temperature plot nodes to compare the plots in the
Graphics window. The maximum temperature decreases as the width of the
busbar increases from 5 cm to 10 cm.

ADDING MORE PLOTS

To further analyze these results, you can plot the average temperature for each
width.

| 135



I Right-click Results = and add a ID Plot Group ..

4 [ Results
Data §@l 3D Plot Group

Deriy M 20 Plot Group

B Tabl
Wi Elect 1D Plot Group G
Wl Tem| &) Polar Plot Group

* =
r’ Isoth ®2 Smith Plot Group
Wi Curr
VB Elect Pi Parameters
B Tem
= lsoth

8.85
ez

Plot All

v v v v v v

Close All Plot Windows

Copy as Code to Clipboard 3

H Help F1

2 In the Settings window for 1D Plot Group, sclect Study I/Parametric Solutions |
from the Data set list.

Settings

D Plot Group
Plot

Label: 1D Plot Group 8

¥ Data
6 Data set: | Study 1/Parametric Selutions 1 v| |E|
Parameter selection (whb): | All v|
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3 In the Model Builder, right-click 1D Plot Group 8 and add a Global = node.

©

Model Builder

- ‘= v =t

4 9 busbar ILmph (root)
() Global Definitions

@ Componentl (compl)

~db Study 1
- @, Results
Data Sets
ea: Derived Values
EH Tables

Wi Electric Potential (ec)

VB Temperature (ht)

i Isothermal Contours (ht)

W& Current Density

VB Electric Potential (ec) 1
VB Temperature (ht) 1
i Isothermal Contours (ht) 1

4 7 1D Plot Group 8

(&) Globall
Export
Reports

@

-1

Settings
Global
[ Plot
Label: Globall
¥ Data

Data set: | From parent

¥ y-Axis Data

" Expression Unit
aveopl(T) K

S|
v B~
Description
Average 1 o

4 In the Settings window for Global under y-Axis Data, click the first row in the
Expressions column and enter aveop1(T). This is the operator that we defined
on page 131 for later use. You use a similar syntax to calculate the average of
other quantities.

You can also use autocompletion by using Ctrl+Space after clicking the

first row.

v y-Axis Data

L -
Expression

4 Model

4 Component 1{compl}
4 Definitions

4 Component couplings

aveopl(expr) - Average 1

ec.int_We(expr) - Integration

Functions

To use a coupling operator without solving, you can select the option
Update Solution that is available by right-clicking a Study node.

~ct Study 1

& Results | =

Compute

=+ Continue

' Update Solution

F5
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5 Click the Plot button = and save the busbar_III.mph model with these
additional plots that use the parametric sweep results.

Glabal: Average 1 (K] o
T T T T r T T T T - :
N\
PIRN ] Average 1 |4
N
mf L ]
320} \\ ]
; ™
318 f \ 4
\h.
.
ne - ]
.
\\
g Y AN 1
L ms e ]
5 “
& \
8 ~
o e 4
\\\
£ \ 4
.
\\\
313 g 4
~
n2 . ]
11 ]
310 e 4
. . ' . . . . . . ™
0.05 0.05% 0.06 0.065 007 0.075 0.08 0.085 0.08 0.085 0.1
whl (Width}

In the plot, the average temperature decreases as the width increases.

PARAMETERS IN RESULTS

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model. The
following example shows how you can animate over a Parameter defined under
Results.

I Right-click the Results node and select Parameters.

4 ([ Results
I+ & Data \@ 3D Plot Group

£ Deri
2D Plot Grou
& oo B 3

i Elect 7w 1D Plot Group
W Tem ‘:B Polar Plot Group

#* .
T.”E sot ®2 Smith Plot Group
Wi Curr

Wi Elect Pi Parameters a

Plot All

Clear Plot Data

Copy as Code to Clipboard 3

Help F1




2 Define a parameter, iso_level, with Expression 309.5[K].

Model Bu ~ * | Settings
- - Parame
4 &b busbar_L.mph froot)
I () Global Definitions ¥ Parameters
[ Compenent1 {compl) "
[+~ Study 1 Name Expression Value Description @
4 B Results iso_level | 309.5[K] 309.5 K Isosurface level

Fi Parameters

3 For the Isothermal Contours (ht) | plot group, in the Settings window for the

Isosurface plot, change the Entry method to Levels. For the Levels expression
field, type iso_level.

I N Temnperature (ht) 1 oo
4 @ Isothermal Contours (ht) 1 * Levels
3 Isosurface
b~ 1D Plot Group § Entry method: | Levels =
Export Levels: iso_level K |bed
;| Reports
[] Interactive
Shift: 0

4 In the same Settings window, click Plet.

whblfl=0.1 Isosurface: Temperature (K] e

<\°Q
¢

I
.. . o
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5 Generate an Animation by ecither selecting the Player option in the Animation
menu of the Isothermal Contours (ht) | tab in the ribbon, or right-click the
Export node and select Animation > Player.

Model Builder Settings M
- S o Hi i v Animation
4 9 busbar ILmph (root) E Show Frame
() Global Definitions
@ Componentl (compl) Label:  Animation 1 =
~db Study 1
4 [E Results > SEEE
’f‘i Parameters Subject: Isothermal Contours (ht) 1 - |Z
Data Sets
£ Derived Values v Target
B Tables
Wi Electric Potential (ec) Target: | Player = 6
W& Termperature (ht)
i Isothermal Contours (ht) ¥ Animation Editing
W& Current Density
Wi Electric Potential (ec) 1 Sequence type: Result parameter - G
Wi Temperature (ht) 1 Parameter: iso_level (lsosurface le
4 k& Isothermal Contours (ht) 1
& Isosurface Siait 309 &
~w 1D Plot Group 8 Stop: 310 K

4 Export

[ Animation1 “ Unit: K

55 Reports
¥ Frames

Number of frames: 50

Frame number: 50

iso_level: 310K

6 In the Settings window for Animation, change the Sequence type to Result
parameter and select the iso_level parameter. Type 309 for Start and 310 for
Stop. Click the Play button in the Graphics toolbar or the Show Frame button in
the Settings window for the Animation. To get a smoother animation, change the
Number of frames to a higher number; for example, 50.

The subject of parametric sweeps raises the question of parallel computing; it
would be efficient if all parameters were solved simultaneously.

Parallel Computing

COMSOL Multiphysics and COMSOL Server support most forms of parallel
computing, including shared memory parallelism for multicore processors and
high-performance computing (HPC) for clusters and clouds. All COMSOL
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licenses are multicore enabled. For cluster or cloud computing, including
parallelized sweeps, a Floating Network License (FNL) is needed.

You can use clusters or clouds with one of two options: cither for Cluster Sweep or
for Cluster Computing. If you have a Floating Network License, these two options
are available by right-clicking the Study node. However, you first need to enable
Advanced Study Options by clicking the Show button = on the Model Builder toolbar

and selecting Advanced Study Options.

h, D
Andal Rriilda
Model Builde

- ® v StEL =

4 @ busbar Il v Equation Sections

g Global Equation View

Il Compy

~db Study] ¥ Override and Contribution
(B Results Discretization

Stabilization

Advanced Physics Options
v Advanced 5tudy Options

Advanced Results Options

CLUSTER SWEEP

The Cluster Sweep option is used for solving several models in parallel where each
model has a different set of parameters. This can be seen as a generalization of
Parametric Sweep. Right-click the Study node to add a Cluster Sweep node.

Maodel Builder Settings -1
- T StELZ e o
4 & busbar I.mph (root) = Compute C' Update Solution []
) Global Definitions
Label:  Cluster Sweep =

@ Componentl (compl)

4 ~ci Study 1 X
'\ZT Cluster Sweep v Study Settings
IZ_. Step 1: Stationary = P—
Sweg e | Specified combinations A
[fr. Solver Configurations il E
?:'J Job Cenfigurations " Parameter name  Parameter value list Parameter unit

& Results whb (Width) =

The Study Settings for Cluster Sweep are similar to that of Parametric Sweep, but
additional settings are required for the cluster or cloud being used. The picture
above shows how the top of the Settings window for Cluster Sweep would look for
the same sweep as defined in “Parametric Sweeps” on page 128. To run a cluster
sweep in this case, you would first remove the Parametric Sweep node.
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CLUSTER COMPUTING

You can also utilize a cluster or cloud to solve a single large model using

distributed memory. For maximum performance, the COMSOL software cluster
implementation can utilize shared-memory multicore processing on each node in
combination with the message passing interface (MPI) based distributed memory
model. This is also known as hybrid parallelism and brings a major performance

boost by making the most out of the computational power available.

Right-click the Study node to add a Cluster Computing node. A Cluster Computing
node cannot be used in combination with a Cluster Sweep. You will be asked if you

want to remove the Cluster Sweep before proceeding. Select Yes.

The Settings window for Cluster Computing, shown below, helps to manage the
simulation with settings for the cluster or cloud.

Model Builder

A

® v =

4

4 9 busbar ILmph (root)

Fi

Fi
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() Global Definitions
1 Componentl {compl)
= Definitions
A\ Geometry 1
2 Materials
4 +\_ Electric Currents {ec)
i Current Conservation 1
S Electric Insulation 1
i Initial Values 1
mw Electric Potential 1
= Groundl
4 | I8 Heat Transfer in Solids {ht)
i Solid1
i Initial Values 1
S Thermal Insulation 1
mw Heat Flux1
4 5 Multiphysics
x| Electromagnetic Heating1 {emhl)
A Mesh1
~db Study 1
%% Cluster Computing
E Step 1: Stationary
[*r. Solver Configurations
r;r'l Job Configurations

& Results

A

Label: Cluster Computing =
¥ Batch Settings
Filename: batchmodel.mph

Generate solver sequence in external process
Mumber of nodes: 1

Use batch license

Cluster computing settings
Settings: User controlled -
Scheduler type: General -
Host file:
Bootstrap server
Directory: Browse...

| Specify server directory path

Directory: Browse...

| Specify external COMSOL batch directory path

Directory: Browse...

| Specify external COMSOL installation directory path

Directory: Browse...

Number of job restarts: 0

Alive time (seconds): 300

Cluster Settings
Remote and Cloud Access

Study Extensions



You choose the type of cluster job you want to perform from the Scheduler type
list. COMSOL Multiphysics and COMSOL Server support General, Windows®
HPC Server (HPCS) 2008,/2012 /2016, Open Grid Scheduler/ Grid Engine
(OGS/GE), SLURM, or Not distributed. The General option is a multipurpose
option for Linux® clusters. Additional cluster and scheduler settings, such as
Prepend command and Postpend command, arc available in the Preferences window
available from the File menu.

To learn more about running in parallel, see the Reference Mannal.

COMSOL Multiphysics Client-Server

When using COMSOL Multiphysics with a Floating Network License (FNL), it
is possible to use a client-server mode of operation to access remote computing
resources for solving large models, while still using the graphics card on a local

machine to display graphics. (This mode of operation should not be confused with
the COMSOL Server product for use with COMSOL applications. )

Using the COMSOL Multiphysics client-server mode can have some significant
advantages, since engineering and scientific computing problems involve working
with large amounts of data — anywhere from megabytes to gigabytes of data are
commonly generated during a simulation. To generate and store this data, you
may want to use computers with fast processors, large amounts of Random Access
Memory (RAM), and a large hard drive. To visualize large data sets, it is important
to have a high-end graphics card on your local computer.

Under ideal conditions, you would always be working on a high-end computer
with more than enough memory and processing power for all of the simulation
steps. But if this is not the case and you need to solve larger models, you may
instead access a shared computing resource across a network.

At any time while using COMSOL Multiphysics, it is possible to connect to a
remote computing resource via the client-server mode of operation. This is a
two-step process. First, log onto the remote system and invoke the COMSOL
Multiphysics server, which will start the COMSOL Multiphysics server process
and open a network connection. Second, on the local machine, simply enter the
network connection information into an open session of COMSOL Multiphysics.
The software then transparently streams the model data and results back and forth
over the network and uses the remote computing resource for all computations.

There are several ways to start a COMSOL Multiphysics server session. In
Windows® 7, you can, for example, start a server session from the start menu
under COMSOL Multiphysics 5.3 > Client-Server. In Windows® 10, you can start a
server session from the COMSOL Launchers option from the Windows start menu.
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In Linux® , you can use the comsol mphserver command. The server and client
sessions can be run on different operating systems. For example, the server can run

in Linux® and the client session in Windows®.

The first time you start a COMSOL Multiphysics server on a computer, you are
asked for a username and password that are associated with the client-server mode
of operation and stored for future connections. The figure below shows the
command window for starting a server session in Windows.

3 COMSOL Multiphysics Server

The figure below shows how to connect to a server session from the COMSOL
Desktop user interface. To connect, from the File menu, select COMSOL
Multiphysics Server > Connect to Server.

b IDEHR>» " cEBBHDE \c| S |
Home | Definitions  Geometry  Materials  Physics ~ Mesh  Study
™ New Ctrl+N

{\”‘ P; Parameters —

>

[ Run Application a= Variables +

- = [ Add A Builc
Open Cileo [ Component-  figFunctions - Al

Wodel Definitions
Recent |

[[l Application Libraries

%] Open Recovery File

[ save Ctrl+S

7! saveas

ES Revert to Saved

5] Compact History

COMSOL Multiphysics Server » =a Connectto Server

Help 3 Disconnect from Server
Licensed and Used Products Import Application from Server

Remove Applications from Server
5] Preferences PF

Exit

-

%]
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You are now prompted for the username and password that you gave the first time
you started a server session.

3 Connect to COMSOL Multiphysics Server ﬁ
Server User
Server:  myserver.address.com Username:  paul
Port: Default M Password:  esssss

Remember username and password

oK Cancel

L

For more information on running the COMSOL Multiphysics client-server, see
the Reference Manual.
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Appendix A — Building a Geometry

This section details how to create the busbar geometry using the built-in geometry
tools in COMSOL Multiphysics. The step-by-step instructions take you through
the construction of the geometry using the parameters set up in the Global
Definitions section.

All geometry operations under the geometry node in the model tree are organized
in a parametric sequence of operations called a geometry sequence. Using
parameterized dimensions helps to produce what-if analyses and geometric
parametric sweeps.

As an alternative to building the geometry using the tools available in COMSOL
Multiphysics, you can import a geometry created with a CAD package. The
optional CAD Import Module and Design Module support many CAD file
formats. Moreover, several add-on products are available that provide
bidirectional interfaces to common CAD software packages. See “Appendix E —
Connecting with LiveLink™ Add-Ons” on page 187 for a list. Note that the
Design Module, in addition to the features available in the CAD Import Module,
adds 3D functionality for loft, fillet, chamfer, midsurface, and thicken.

If you have not done so already, start with “Example 2: The Busbar — A
Multiphysics Model” on page 54. Follow the steps in the section “Model Wizard”
on page 31 to add the physics and study and then follow the steps under Global
Definitions to add the parameters. Return to this section to learn about geometry
modeling. The first step in the geometry sequence is to draw the profile of the
busbar.
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I Under Component I, right-click
Geometry | » and sclect Work Plane = .
In the Settings window for Work Plane:

- Sclect xz-plane from the Plane list (the
last option in the list).

- Click the Show Work Plane button £
on the Settings window for Work

Plane toolbar.

Continue by editing the axis and grid
settings in Work Plane 1.

2 In the Model Builder, expand the View 2
node [+ and click Axis [x.

4 %A Geometry 1
4 [E] Work Plane1 (wpl)

* Form Union (fin)

3 In the Settings window for Axis:

Under Axis:

Label: Work Plane 1

¥ Plane Definition

Plane type: Quick
Plane: xz-plane
Offset type: Distance

y-coordinate: 0
Local Coordinate System

¥  Unite Objects

Unite objects

Repair tolerance: | Automatic

w Selections of Resulting Entities

Contributeto: | Mone -
|| Resulting objects selection
Show in physics: | Boundary selection

Selections from plane geometry

[] Show in physics

- In the x minimum and y minimum fields, o @ Update

enter -0.01.

- In the x maximum and y maximum

fields, enter 0.11.
Under Grid:

- Select the Manual Spacing check box.
- In the x spacing and y spacing fields,

enter 5e-3.

4 Click the Update button ¢ on the

toolbar.

Note that the values you type will
automatically adjust slightly after you
click Update to adapt to the screen aspect

ratio.

Label:  Axis

© -

xminimum:  -0.01
* maximurn: 0,11
y minimum: 001
y maximum: 011

View scale: None
 Grid

Manual spacing

wspacing:  Se-3

yspacing:  5e-3
Extrax:

Extra y:

[ Build Selected ~ [E§ Build All Objects

Mew

m L
m |
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You can use interactive drawing to create a geometry using the drawing tools from
the Work Plane tab in the ribbon while pointing and clicking in the Graphics
window.

K33 : L]
m e g b et I
- v bageerce L gt vemiry : o
i

Work Plane Tab

" Quadratic ’:I
© A/ Cubic :
Line R Rectangle Circle Primitives

= Point - -

Draw Primitives

Geometry Primitives

You can also right-click the Plane Geometry node » under Work Plane 1 = to add
geometry objects to the geometry sequence.

In the next few steps, we create a profile of the busbar.

5 In the Model Builder under Work Plane |, right-click Plane Geometry . and select
Rectangle .

In the Settings window for Rectangle

under Size, enter: -
- L+2*tbb in the Width ficld.
- 0.1[m] in the Height field. Label:  Rectanglel
Click the Build Selected button & . - TR
Type: | Solid .

~ Size and Shape

e Width:  L+2"tbb m

Height 0.1 m
~ Position

Base: | Corner -

o 0 m
yw 0 m

¥ Rotation Angle
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6 Create a second rectangle. Under Work
Plane I, right-click Plane Geometry
and select Rectangle .

Under Size, enter:

- L+tbb in the Width field

- 0.1[m]-tbb in the Height field.

Under Position, enter: G
- tbb in the yw field.

Click the Build Selected button & .

Use the Boolean Difference operation to
subtract the second rectangle from the
first one.

7 Under Work Plane 1, right-click Plane
Geometry . and sclect Booleans and

= Bu\‘;IS;‘E(tEd -
Label: Rectangle 2
* Object Type
Type: | Solid

¥ Size and Shape
Width:  L+tbb
Height: 0.1-thb
* Position

Base: | Corner
X0 1]
yw:  tbb

* Rotation Angle

{5 Build Al

Partitions > Difference . In the Graphics window, click r1 (the larger of the two
rectangles) to add it to the Objects to add list in the Settings window for

Difference.

To help select the geometry, you can display geometry labels in the
Graphics window. In the Model Builder under Geometry |1 > WorkPlane 1,
click the View 2 node. Go to the Settings window for View and select the

Show geometry labels check box.
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8 Click the Difference node. In the
Settings window for Difference, click the
Active selection button to the left of the
Objects to subtract list. Select the
smaller rectangle, r2, by using the
mouse scroll wheel or arrow keys to
cycle through the overlapping
rectangles to first highlight it and then
click on it to select it.

Click Build Selected 5 .

Another way to select r2 in the Graphics
window is to use the Selection List
feature. Go to the Home tab in the
ribbon and select Windows > Selection
List. In the Selection List, click to
highlight r2 (solid). Then, right-click
r2 (solid) in the list and select Add to
Selection to add it to the Objects to

subtract list. Right-click on the Selection List window title and select Close.

After building the selected geometry, you should have a backward-facing,

Label: Differencel

~ Difference

Ohbjects to add:

% Build Selectedl = | [E Build All

[ OFF il

Active

Objects to subtract:

an )| |2

Active

L-shaped profile. Continue by rounding the corners of the L-shaped profile.

a Q| eE - AEescn ®8EY

o

0 1
. o
oz pol 0 a0l boz oe3  ood

al
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9 Under Work Plane 1, right-click Plane Geometry

and select Fillet

Select point 3 (in the inner-right corner) to add it to the Vertices to fillet list.

There are different ways to add points:

- In the Graphics window, click point 3 to add it to the Vertices to fillet list.

- From the Home tab, sclect Windows > Selection List. In the Selection List
window, click 3. The corresponding point is highlighted in the Graphics
window. Click the Add to Selection button + in the Settings window for Fillet

or right-click in the Selection List.

[ Build Selected ~ [E§ Build All
Label: Fillet1
¥ Points

Wertices to fillet:

O -
3 —

Active

~ Radius

@ Radius:  tbb m

10 Enter tbb in the Radius field. Click Build Selected .

This creates a fillet at the inner corner.

Il For the outer corner, right-click Plane
Geometry . and select Fillet

12 In the Graphics window, click point 6, the
outer corner, to add it to the Vertices to
fillet list.

I3 Enter 2*tbb in the Radius field. Click
Build Selected & .

{;tt f—gs -1

[® Build Selected ~ [E§ Build All
Label:  Fillet 2
¥ Points

Vertices to fillet:

m 4 fill
6 -

Active il
,,

¥ Radius

Radius:  2*tbb m
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The result should match this figure:

Qe BGH L PemEEn MNGEE «~BEE> @@

@ .01 P r

Next, extrude the work plane to create the 3D busbar geometry.

I In the Model Builder, right-click Work Plane | = and select Extrude .. In the
Settings window for Extrude, enter wbb in the Distances from Plane table (replace
the default) to extrude to the width of the profile.

¥ Distances
Specify: | Distances from plane v

L
Distances (m)

[ whb

The table allows you to enter several values in order to create sandwich

structures with different materials. In this case, only one extruded layer is
needed.
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2 Click Build Selected = and then click the Zoom Extents [F] button on the Graphics
toolbar. Click the Save button @ and name the model busbar.mph (if you have
not already done so).

Next, create the titanium bolts by extruding two circles drawn in two work
planes.

3 In the Model Builder, right-click Geometry | . and add a Work Plane .. A Work
Plane 2 node is added. In the Settings window for Work Plane, under Plane
Definition, sclect Face parallel as the Plane type.

Model Builder Settings M
- 1 = v =t f v Vork
4 3 busbar.mph (root) E [ Build Selected ~ [E8 Build All Objects

4 () Global Definitions

Fi Parameters Label: Work Plane 2

i Materials o
4 W Component1 (compl) ¥ Plane Definition
4 i 2_::?:;:51 Plane type: Face parallel - e
& Work Plane 1 fwp1) Planar face:
[EL Extrude fextl) )
= on [
e 4 Work Plane 2 {wp2) -
#, Plane Geometry e
Y Vi ctive
iy N @

* Form Union (fin)
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4 In the Graphics window, click face 8, as shown in the figure below, to add it to
the Planar face list in the Settings window for Work Plane.

Face 8 is now highlighted in blue and the work plane is positioned on top of the

face.

5 Click the Show Work Plane button & to draw the first circle representing the
position of the first bolt. Click the Zoom Extents button [# on the Graphics

toolbar.

6 Under Work Plane 2, right-click
Plane Geometry - and select Circle

In the Settings window for Circle:

- Under Size and Shape, in the
Radius field, enter rad_1.

- Under Peosition, lcave the default
xw and yw coordinates (0, 0).

Click Build Selected 5 .
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':' é;ild Selected = [ Build All
Label: Circlel
¥ Object Type
Type: | Solid -
¥ Size and Shape
Radius: rad_1 m
Sectorangles 360 deg
¥ Position
Base: Center =
w0 m
yw: 0 m

¥ Rotation Angle



Continue creating the bolt by adding an extrude operation.

I In the Model Builder, right-click Work Plane 2 = and select Extrude .. In the
Settings window for Extrude, in the first row of the Distances from Plane table,
enter -2*tbb to extrude the circle.

Model Builder Settings -
“ t =~ i~ Extrude
4 3 busbar.mph (root) [ Build Selected ~ [E8 Build All Objects
4 () Global Definitions
Pi Parameters Label: Extrude2 E
2= Materials
4 W Component1 (compl) ¥ General
= Definitions
Iy Geometry 1 Extrude from: Work plane -
E Work Plane1 (wp1) Work plane: Work Plane 2 (wp2) | |3
[EL Extrude fextl) _
4 & Work Plane 2 (wp2) Input objects:
4 4 Plane Geometry [ongy| we2
Circle1 fcl) - _
[ View 3 .
G Extrude 2 (ext2) Getive
[ Form Union (fin)
2= Materials
+\_ Electric Currents (ec)
E :E:ilizii:”n solids (ht) Input object handling: | Unite with -
A5\ Mesh1 :
o Study 1 ¥ Distances
@, Results

Specify: | Distances from plane v

L .
Distances (m)

[Ztbb ] G
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2 Click the Build Selected button = to create the cylindrical part of the titanium
bolt that runs through the busbar.

Draw the two remaining bolts.

3 Right-click Geometry | » and sclect Work Plane = . A Work Plane 3 node is
added. In the Settings window for Work Plane, for Work Plane 3, sclect Face
parallel as the Plane type.

4 In the Graphics window, click face 4, as shown in the figure, to add it to the
Planar face list in the Settings window for Work Plane.

5 Click the Show Work Plane button £ on the Settings window for Work Plane and
the Zoom Extents button [ on the Graphics toolbar to get a better view of the
geometry.

To parameterize the position of the two remaining bolts, add the circles that
form the cross sections of the bolts.
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6 Under Work Plane 3, right-click Plane Geometry

In the Settings window for Circle:

- Under Size and Shape, enter rad_1 in
the Radius field.

- Under Position, enter -L/2+1.5[cm]

in the xw field and -wbb/4 in the yw
field.

Click Build Selected & . c

Copy the circle that you just created to
generate the third bolt in the busbar. c

7 Under Work Plane 3, right-click Plane
Geometry . and select Transforms >
Copy .

8 In the Graphics window;, click the circle
c1 to select and add the circle to the
Input objects list in the Settings window
for Copy.

9 In the Settings window for Copy under
Displacement, enter wbb/2 in the yw

field. (8

o
0
yws  whhb/2

Settings

‘:' é;ild Selected -
Label: Circlel

¥ Object Type
Type: | Solid

~ Size and Shape
Radius: rad 1
Sectorangle: 360
~ Position

Base: | Center
W -Li2+1.5e-2

yw: -whbb/d

¥ Rotation Angle

Settings

[® Build Selected ~
Label: Copyl
> Input

Input objects:

and select Circle .

[E& Build All

[E Build All

il

Active

Keep input objects
~ Displacement

0
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10 Click Build Selected = and click the Zoom Extents button [ on the Graphics
toolbar.

Your geometry, as shown in the work plane, should match this figure so far.

-1
fEmEon SEEF «~EERE> ae
s L L s L L L L .
al
2.0
0.0257 F
A
b
0.01 /
0.017 AN / F
—
0.00%
v
0,005 i
oor] Y L
9,017 b y o
e
@ 4.0257 - s “F
£.0%
0,035 T T T T T T T
£.04 £.03 .02 £.01 o .01 a.02 el .04 .05

Continue by extruding the circles.

158 |



I1 In the Model Builder, right-click Work Plane 3 = and select Extrude .. In the
Settings window for Extrude, in the first row of the Distances from Plane table,
enter -2*tbb (replace the default). Click Build All Objects = .

Model Builder Settings iz
= t Se i i Extrude
4 <@ busbar.mph (root) ¥ Build Selected ~ & Build All Objects
4 Global Definitions o
Pi Parameters Label:  Extrude3 |E|
538 Materials o
4 [l Component 1 (comp1) ~ General
= Definitions
4 ]J\ Geometry1 Extrude fram: | Work plane
B Work Planel (wpl) Work plane: | Work Plane 3 (wp3)
[} Bxtrude fext]) ) —
& Work Plane 2 (wp2) Input objects:
[T Extrude 2 (et [onm) wp3
4 & Work Plane 3 (wp3) . _
4 );\ Plane Geometry Active e

() Circlel (c1)
Copy1 (copy1)
1 Viewd
Extrude 3 (ext3)
% Form Union (fin)
228 Materials
X Electric Currents (ec)
|1 Heat Transfer in Solids (ht)
4?3. Multiphysics
£ Mesh1
~o Study 1

” Distances (m)
@ Results m |-2"tbb ‘

Input object handling: | Unite with -

~ Distances

Specify: | Distances from plane - |

The geometry and geometry sequence should match the figures below. Click
the Save button i and name the model busbar.mph.
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Creating Parts and Using the Part Libraries

After setting up the busbar or other geometry model, it is convenient to be able
to save it for future use, avoiding unnecessary work. In the steps you have just
completed, the geometry was stored directly in the COMSOL model file that will
also be used to set up the complete busbar model. Instead, you can also create a
reusable and parameterized part that can serve as a building block of a more
complex COMSOL model geometry, which is stored in a separate file accessible
through the Part Libraries.

While building the busbar geometry, you were using features from the Geometry
and Workplane tabs. A Parts menu is located in the Other group in these tabs.

— Gz

Parts |Programming Measure

A Create Part
% Load Part

= [fiif Part le.ra.rles . S .

Through the Parts menu, you can choose to create or load a part, or add a part to
the model geometry by selecting one from the Part Libraries. Several Part
Libraries are already provided with the software by default. When new parts are
created, they are added under a part’s parent node in the Global Definitions section
of the model tree.

160 |



The figure below shows an Internal Helical Gear part from the part library of the
Multibody Dynamics Module. The part comes with 18 Input Parameters that
control the dimensions.

= Pocd
-~ naAE kEEE Be 4 e

(e

For additional information on working with parts and the Part Libraries, see the
Reference Manual.

To continue with the busbar tutorial, return to the section “Materials” on
page 65.

| 161



Appendix B— Keyboard and Mouse Shortcuts

These shortcuts are primarily applicable to the Model Builder and the Graphics
window. For information on shortcuts in the Application Builder, see the
Introduction to Application Builder.

SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

FI (Fn+FI on certain tablets)

Ctrl+FI

F2

F3
F4
F5

Fé6

F7

F8

Del

Left arrow (Windows); Shift +
Left arrow (Linux)

Fl

Command+Fl

F2

F3
F4
F5

Fé6

F7

F8

Del

Left arrow

Display help for the selected node
or window

Open the COMSOL
Documentation front page in an
external window

Rename the selected node, file, or
folder

Disable selected nodes
Enable selected nodes

Update the Data Sets Solutions with
respect to any new Global
Definitions and Definitions without
re-solving the model

Build the preceding node in the
geometry branch or plot the
previous plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Build the selected node in the
geometry and mesh branches,
compute the selected study step,
compute the selected node in the
solver sequence, or plot the next
plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Build the geometry, build the mesh,
compute the entire solver sequence,
update results data, update the plot,
or run a method call.

Delete selected nodes or objects

Collapse a branch in the model tree
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Right arrow (Windows); Shift
+ Right arrow (Linux)

Up arrow

Down arrow

Alt+left arrow

Alt+Right arrow

Ctrl+A

Ctrl+C
Ctrl+D

Ctrl+Shift+D

Ctrl+F
Ctrl+K

Ctrl+N
Ctrl+O
Ctrl+P

Ctrl+S
Ctrl+V
Ctrl+X
Ctrl+Y
Ctrl+Z

Ctrl+Up arrow

Right arrow

Up arrow

Down arrow

Ctrl+left arrow

Ctrl+Right arrow

Command-+A

Command+C

Command+D

Command-+Shift+D

Command+F

Command+K

Command+N
Command+O

Command+P

Command+S
Command+V
Command+X
Ctrl+Shift+Z

Command+Z

Command+Up arrow

Expand a branch in the model tree

Move to the node above in the
model tree

Move to the node below in the
model tree

Move to the previously selected
node in the model tree

Move to the next selected node in
the model tree

Select all domains, boundaries,
edges, or points; Select all cells in a
table

Copy text or objects

Clear the selection of domains,
boundaries, edges, or points

Duplicate the selected node in the
model tree

Find a search string

Create shortcut for use in the
Application Builder

New model
Open a model file

Print the contents of the plot
window

Save a model file

Paste copied text or object

Cut copied text or object

Redo the last undone operation
Undo the last operation

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,
study step node, or results node up
one step
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctrl+Down arrow

Ctrl+Tab

Ctrl+Shift+Tab

Ctrl+Alt+A
Ctrl+AR+M
Ctrl+Alt+Left arrow

Ctrl+Alt+Right arrow

Ctrl+Alt+Up arrow

Ctrl+Alt+Down arrow

Shift+F10 or
(Windows only) Menu key

Ctrl+Space or Ctrl+/

Left-click and hold down the
mouse button while dragging
the mouse.

Right-click and hold down the
mouse button while dragging
the mouse.

Middle-click outside model and
hold down the mouse button
while dragging the mouse.
Press Ctrl and left-click. While

holding down the key and
button, drag the mouse.

Command+Down
arrow

Ctrl+Tab

Ctrl+Shift+Tab

Not available
Not available

Command+Alt+Left
arrow

Command+Alt+Right
arrow

Command+Alt+Up
arrow

Command-+Alt+Dow
n arrow

Ctrl+FI10

Ctrl+Space

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,
study step node, or results node
down one step

Switch focus to the next window on
the desktop

Switch focus to the previous
window on the desktop

Go to Application Builder
Go to Model Builder

Switch focus to the Model Builder
window

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Open the context menu.

Open list of predefined quantities
for insertion in Expression fields.

Rotate the scene around the axes
parallel to the screen’s x- and y-axes
with the origin at the scene rotation
point.

Move the visible frame on the image
plane in any direction.

The scene is zoomed in/out around
the mouse position where the
action started.

Tilt and pan the camera by rotating
about the x- and y-axes in the image
plane.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Press Ctrl and right-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and middle-click.
While holding down the key
and button, drag the mouse.

Press Ctrl and middle-click.

Press Ctrl+Alt and left-click.
While holding down the keys
and button, drag the mouse.
Press Alt and left-click. While
holding down the key and
button, drag the mouse.

Press Alt and right-click. While
holding down the key and
button, drag the mouse.

Press Alt and middle-click.
While holding down the key
and button, drag the mouse.

Middle-click on model.

Press X, Y, or Z and left-click.
While holding down the key
and button, drag the mouse.

R

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

R

Move the camera in the plane
parallel to the image plane.

Move the camera into and away
from the object (dolly infout).

Zoom to the area around the point
on the model determined by the
mouse position.

Rotate the camera around the axis.

Rotate the camera about its axis
between the camera and the scene
rotation point (roll direction).

Move the scene in the plane
orthogonal to the axis between the
camera and the scene rotation
point.

Move the camera along the axis
between the camera and the scene
rotation point.

Set the center of rotation.

Rotate around the X Y, or Z-axis,
respectively.

Toggle between manual and
automatic rotation center.
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Appendix C — Language Elements and Reserved Names

Building a model tree in COMSOL Multiphysics is equivalent to graphically
programming a sequence of operations. Using the Record Code functionality in
the Application Builder or saving as a model file for MATLAB® or Java® outputs
the sequence of operations as a list of traditional programming statements. In this
section, we will give an overview of the following element categories as defined by
the underlying COMSOL language:

» Constants
e Variables

e Functions
» Operators

» Expressions

These language elements are built-in or user-defined. Operators cannot be
user-defined. Expressions are always user-defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be redefined by the
user. If you try to use a reserved name for a user-defined variable, parameter, or
function, the text where you enter the name will turn orange and you will get a
tooltip error message if you select the text string. Reserved function names are
reserved only for function names, which means that such names can be used for
variable and parameter names and vice versa. In the following pages, we list the
most commonly used built-in elements and hence those reserved names. A more
exhaustive list of built-in elements can be found in the Programming Reference
Manual and the Application Programming Guide.

VARIABLES USED IN APPLICATIONS

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of'a parameter. In addition, variables
to be used in applications can be defined in the Application Builder under the
Declarations node. Such variables are available globally in form objects and
methods but cannot be used in the Model Builder.
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Constants and Parameters

There are three different types of constants accessible from the Model Builder:
built-in mathematical and numerical constants, built-in physical constants, and
parameters. Parameters are user-defined constants, which can vary over parameter
sweeps. Constants are scalar valued. The tables below list the built-in
mathematical and numerical constants as well as built-in physical constants.

Constants and parameters can have units.

BUILT-IN MATHEMATICAL AND NUMERICAL CONSTANTS

DESCRIPTION NAME VALUE

Floating point relative accuracy for double eps 2752 (~2.2204-1 0"6)

floating point numbers, also known as

machine epsilon

The imaginary unit i, j i, sqrt(-1)

Infinity, oo inf, Inf A value larger than what
can be handled with
floating point
representation

Not-a-number NaN, nan An undefined or
unrepresentable value,
such as the result of 0/0
or inf/inf

T pi 3.141592653589793
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BUILT-IN PHYSICAL CONSTANTS

DESCRIPTION NAME VALUE

Acceleration of gravity g_const 9.80665[m/s"2]

Avogadro constant N_A const 6.02214129e23[1/mol]
Boltzmann constant k_B_const 1.3806488e-23[J /K]
Characteristic impedance ~ Z0_const 376.73031346177066[ ohm]
of vacuum (impedance of

free space)

Electron mass me_const 9.10938291e-31[kg]
Elementary charge e_const 1.602176565e-19[C]
Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant
Gravitational constant

Molar volume of ideal gas
(at 273.15 Kand | atm)

Neutron mass

Permeability of vacuum
(magnetic constant)

Permittivity of vacuum
(electric constant)

Planck’s constant

Planck’s constant over 2 pi
Proton mass

Speed of light in vacuum

Stefan-Boltzmann
constant

Universal gas constant

Wien displacement law
constant

alpha_const
G_const

V_m_const

mn_const

muO_const

epsilon0_const

h_const
hbar_const
mp_const
c_const

sigma_const

R_const

b_const

7.2973525698e-3
6.67384e-11[m"3/(kg*s"2)]
2.2413968e-2[m"3/mol]

1.674927351e-27[kg]
4*pi*1e-7[H/m]

8.854187817000001e-12[F/m]

6.62606957¢-34[J*s]
1.05457172533629¢-34[J*s]
1.672621777e-27[kg]
299792458[m/s]
5.670373e-8[W/ (M*2*K"4)]

8.3144621[J/ (m01*K) ]
2.8977721e-3[m*K]

PARAMETERS

Parameters are user-defined constant scalars in the Global Definitions branch in the
model tree. Example uses are:

» Parameterizing geometric dimensions

» Parameterizing mesh element sizes
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» Defining parameters to be used in parametric sweeps

A parameter can be defined as an expression in terms of numbers, parameters,
built-in constants, and built-in functions of parameters and built-in constants.
Parameters should be assigned a unit, using [], unless they are dimensionless.

Variables

There are two types of variables used in the Model Builder: built-in and
user-defined. Variables can be scalars or fields. Variables can have units.

Note: Spatial coordinate variables and dependent variables are user-defined
variables of special interest. These variables have default names based on the space
dimension of the geometry and the physics interface, respectively. As a result of
the names chosen for these variables, a list of built-in variables will be created by
COMSOL Multiphysics: the first- and second-order derivatives with respect to
space and time.
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BUILT-IN VARIABLES

NAME

curv

curvi,curv2

dom

dvol

freq

lambda

linearizedelem

numberofdofs

meshtype

meshelement
meshvol
nx,ny,nz

phase

qual

realdetjac

DESCRIPTION
The curvature of a boundary in 2D

The principal curvature components of a
boundary in 3D

The domain number for a domain, boundary,
edge, or point

Volume scale factor variable; This is the
determinant of the Jacobian matrix for the
mapping from local (element) coordinates to
global coordinates.

Frequency

Mesh element size (length of the longest edge of
the element)

Eigenvalue

Elements forced to be linear

Number of degrees of freedom

Mesh type index for the mesh element; This is the
number of edges in the element.

Mesh element number
Volume of the (linearized) element
Normal component for boundaries

Phase angle

Mesh quality

The determinant of the Jacobian matrix for the
mapping from a straight mesh element to the
possibly curved element used when solving. Use
this variable to measure the difference in shape
between a curved element and the
corresponding straight element.

Field
Field

Field

Field

Global
variable

Field

Global
variable

Field

Global
variable

Field

Field
Field
Field

Global
variable

Field
Field
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realdetjacmin A scalar field variable for each element defined as  Field
the minimum value of the reldetjac variable
for the corresponding element.
A reldetjacmin value less than zero for an
element means that the element is wrapped
inside-out; that is, the element is an inverted
mesh element.
s,s1,s2 Curve and surface parameterization variables Field
t Time Global
variable
tcurvx,tcurvy,tcurvix, Tangential directions for the corresponding Field
curvily,tcurviz,tcurvax, curvature variables
tcurv2y,tcurv2z
tx,ty,tix,t1y,t1z, Tangent vector components corresponding to the  Field
tex,t2y,t2z curve and surface parameterizations
qual A mesh quality measure between O (poor quality)  Field
and | (perfect quality)
USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES
DEFAULT NAME DESCRIPTION TYPE
X, ¥,z Spatial coordinates (Cartesian) Field
r, phi, z Spatial coordinates (Cylindrical) Field
u, T, etc. Dependent variables (Solution) Field

Example: T is the name for the temperature in a 2D, time-dependent heat transfer
model; x and y are the spatial coordinate names. In this case, the following built-in
variables will be generated: T, Tx, Ty, Txx, Txy, Tyx, Tyy, Tt, Txt, Tyt, Txxt, Txyt,
Tyxt, Tyyt, Ttt, Txtt, Tytt, Txxtt, Txytt, Tyxtt, and Tyytt. Here, Tx
corresponds to the partial derivative of the temperature T with respect to x and Ttt
corresponds to the second-order time derivative of T, and so on. If the spatial
coordinate variables have other names — for example, psi and chi — then Txy
would be Tpsichi, and Txt would be Tpsit. (The time variable t is built-in; the
user cannot change its name.)
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Functions

In the Model Builder, there are two types of functions: built-in and user-defined.
Functions can be scalar valued or field valued depending on the input
argument(s). Some functions can have units for both input and output arguments.

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION SYNTAX EXAMPLE
abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)
acosh Inverse hyperbolic cosine acosh(x)
acot Inverse cotangent (in radians) acot (x)
acoth Inverse hyperbolic cotangent acoth(x)
acsc Inverse cosecant (in radians) acsc(x)
acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)

asec Inverse secant (in radians) asec(x)
asech Inverse hyperbolic secant asech(x)
asin Inverse sine (in radians) asin(x)
asinh Inverse hyperbolic sine asinh(x)
atan Inverse tangent (in radians) atan(x)
atan2 Four-quadrant inverse tangent (in radians) atan2(y,x)
atanh Inverse hyperbolic tangent atanh(x)
besselj Bessel function of the first kind besselj(a,x)
bessely Bessel function of the second kind bessely(a,x)
besseli Modified Bessel function of the first kind besseli(a,x)
besselk Modified Bessel function of the second kind besselk(a,x)
ceil Nearest following integer ceil(x)

conj Complex conjugate conj (x)

cos Cosine cos(x)

cosh Hyperbolic cosine cosh(x)

cot Cotangent cot(x)

coth Hyperbolic cotangent coth(x)
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NAME DESCRIPTION SYNTAX EXAMPLE
csc Cosecant csc(x)
csch Hyperbolic cosecant csch(x)
erf Error function erf(x)
exp Exponential exp(x)
floor Nearest previous integer floor(x)
gamma Gamma function gamma (x)
imag Imaginary part imag(u)
log Natural logarithm log(x)
log10 Base-10 logarithm log10(x)
log2 Base-2 logarithm log2(x)
max Maximum of two arguments max(a,b)
min Minimum of two arguments min(a,b)
mod Modulo operator mod(a,b)
psi Psi function and its derivatives psi(x,k)
range Create a range of numbers range(a,step,b)
real Real part real (u)
round Round to closest integer round (x)
sec Secant sec(x)
sech Hyperbolic secant sech(x)
sign Signum function sign(u)
sin Sine sin(x)
sinh Hyperbolic sine sinh(x)
sqrt Square root sqrt(x)
tan Tangent tan(x)
tanh Hyperbolic tangent tanh (x)
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BUILT-IN OPERATOR FUNCTIONS

These built-in functions behave differently than the built-in mathematical
functions. They may not belong in an introductory text but are listed to complete
the list of reserved names. For more information, see the Reference Manual.

NAME NAME NAME NAME
adj dtang mean timeavg
at emetric noenv timeint
atlocal env noxd timemax
attimemax error pd timemin
attimemin fsens ppr treatasconst
atxd fsensimag pprint try_catch
atonly if prev uflux
ballavg integrate reacf up
ballint isdefined realdot var

bdf isinf residual with
bndenv islinear scope.atenti withsol
centroid isnan scope.ati

circavg jacdepends sens

circint lindev setconst

circumcenter linper setind

d linpoint setval

depends linsol shapeorder

dest lintotal side

dflux lintotalavg sphavg

diskavg lintotalpeak sphint

diskint lintotalrms subst

down linzero sum

dtang nojac test
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USER-DEFINED FUNCTIONS

A user-defined function can be defined in the model tree under the Global

Definitions node or, for each Component, under the Definitions node. Select a
template from the Functions menu and enter settings to define the name and
detailed shape of the function.

TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Analytic

Elevation

Gaussian Pulse

The function name is its identifier:
for example, ant.

The function is a mathematical
expression of its arguments.

Example: Given the arguments x
and vy, its definition is
sin(x)*cos(y).

The function has an arbitrary
number of arguments.

The function name is its identifier;
for example, elev1.

Used to import geospatial elevation
data from digital elevation models
and map the elevation data to a
function of x and y. A DEM file
contains elevation data for a portion
of the earth’s surface. The resulting
function behaves essentially like a
grid-based interpolation function.

The function name is its identifier;
for example, gp1.
The Gaussian pulse function defines
a bell-shaped curve according to the
expression
—(x—x0)”

26°

1
(x)= e
Y oJ2n

It is defined by the mean parameter,
xg, and the standard deviation, .

The function has one argument.

The name of the function with
comma-separated arguments within
parentheses. For example:

ani(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

elevi(x,y)

The name of the function with a
single argument within parentheses.
For example:

gp1(x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Image

Interpolation

Piecewise

Ramp

The function name is its identifier:
for example, im1.

Used to import an image (in BMP,
JPEG, PNG, or GIF format) and map
the image's RGB data to a scalar
(single channel) function output
value. By default the function’s
output uses the mapping
(R+G+B)/3.

The function name is its identifier;
for example, int1.

An interpolation function is defined
by a table or file containing the
values of the function in discrete
points.

The file formats are the following:
spreadsheet, grid, or sectionwise.

The function has one to three
arguments.

The function name is its identifier;
for example, pw1.

A piecewise function is created by
splicing together several functions,
each defined on one interval. Define
the argument, extrapolation and
smoothing methods, and the
functions and their intervals.

This function has one argument with
different definitions on different
intervals, which must not overlap or
have any holes between them.

The function name is its identifier;
for example, rm1.

A ramp function is a linear increase
with a user-defined slope that begins
at some specified time.

The function has one argument. It
can also be smoothed.

The name of the function with
comma-separated arguments within
parentheses. For example:
im1(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

int1(x,y,2)

The name of the function with a
single argument within parentheses.
For example:

pw1(x)

The name of the function with a
single argument within parentheses.
For example:

rmi(x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Random

Rectangle

Step

Switch

The function name is its identifier:
for example, rnt.

A random function generates white
noise with uniform or normal
distribution and has one or more
arguments to simulate white noise.

The function has arbitrary number
of arguments.

The function name is its identifier;
for example, rect1.

A rectangle function is 1 in an
interval and O everywhere else.

The function has one argument.

The function name is its identifier;
for example, step1.

A step function is a sharp transition
from 0 to some other value
(amplitude) at some location.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, swi.

A switch is used to switch between
global functions during a solver
sweep. You add the functions as
subnodes under the Switch node.
The switch for functions acts
essentially as a switch statement in a
programming language; that is, it
dynamically chooses one of its
underlying branches depending on a
parameter that can be controlled
from the solvers using a Function
Sweep study. You can also add a
Switch node under Materials and
then use a Material Sweep to sweep
over a discrete set of materials.

The name of the function with
comma-separated arguments within
parentheses. For example:
rnt(x,y)

The arguments x and y are used as
random seeds for the random
function.

The name of the function with a
single argument within parentheses.
For example:

rectl(x)

The name of the function with a
single argument within parentheses.
For example:

step1(x)

Switch is a container node for
functions.
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Triangle

Waveform

External (Global
Definitions only)

MATLAB®
(Global
Definitions only)

The function name is its identifier:
for example, trit.

A triangle function is a linear
increase and linear decline within an
interval and O everywhere else.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, wv1.

A waveform function is a periodic
function with one of several
characteristic shapes: sawtooth, sine,
square, or triangle.

The function has one argument. It
can also be smoothed.

An external function defines an
interface to one or more functions
written in the C language (which
can be a wrapper function
interfacing source code written in,
for example, Fortran). Such an
external function can be used, for
example, to interface a user-created
shared library. Note that the
extension of a shared library file
depends on the platform: .dll
(Windows), .so (Linux), or .dylib
(macOs).

A MATLAB® function interfaces
one or more functions written in
the MATLAB® language. Such
functions can be used as any other
function defined in COMSOL
Multiphysics provided LiveLink™ for
MATLAB® and MATLAB® are
installed. (MATLAB® functions are
evaluated by MATLAB® at runtime.)

The name of the function with a
single argument within parentheses.
For example:

trit(x)

The name of the function with a
single argument within parentheses.
For example:

wv1(X)

The name of the function and the
appropriate number of arguments
within parentheses. For example:

myextfunc(a,b)

The name of the function and the
appropriate number of arguments
within parentheses. For example:

mymatlabfunc(a,b)
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Unary and Binary Operators

In the Model Builder, the following table contains the unary and binary operators
that can be used in expressions.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

| ) {} . Grouping, Lists, Scope

2 . Power

3 -+ Unary: Logical NOT, Minus, Plus

4 [1 Unit

5 * Multiplication, Division

6 + - Binary: Addition, Subtraction

7 < <= > >= Comparisons: Less-Than, Less-Than or
Equal, More-Than, More-Than or Equal

8 == I= Comparisons: Equal, Not Equal

9 && Logical AND

10 || Logical OR

Il s Element Separator in Lists

Expressions

PARAMETERS

A parameter expression can contain: numbers, parameters, built-in constants,
built-in functions of parameter expressions, and unary and binary operators.
Parameters can have units.

VARIABLES

A variable expression can contain: numbers, parameters, constants, variables,
functions of variable expressions, and unary and binary operators. Variables can
have units.

FUNCTIONS

A function definition can contain: input arguments, numbers, parameters,
constants, functions of parameter expressions, including input arguments, unary
and binary operators.
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Appendix D — File Formats

COMSOL File Formats

The COMSOL Model MPH file type, with the extension .mph, is the default file
type containing the entire model tree and application tree from the Model Builder
and Application Builder, respectively. The file contains both binary and text data.
The mesh and solution data is stored as binary data, while all other information is
stored as plain text.

The COMSOL binary and text file types, with the extension .mphbin and
.mphtxt, respectively, contain either geometry objects or mesh objects that can be
imported directly to the Geometry or Mesh nodes in the model tree. Note that if
one of the products CAD Import Module, Design Module, or one of the
LiveLink™ add-on products for CAD was used to create a geometry model then
the same product may be required to open the corresponding file. The reason is
that the geometry model may require features that are only available in one of the
add-on products.

The Physics Builder file type, with the extension .mphphb, contains one or more
user-defined physics interfaces that you can access from the Model Builder. See the
Physics Builder Manual for more information.

See Supported External File Formats for more information about all the other
formats supported by COMSOL Multiphysics.

FILE TYPE EXTENSION READ WRITE
COMSOL Model and Application -mph Yes Yes
Binary Data .mphbin Yes Yes
Physics Builder .mphphb Yes Yes
Text Data .mphtxt Yes Yes

Supported External File Formats

CAD

The CAD Import Module and Design Module allow for import of a range of
industry-standard CAD file types. Additional file types are available through the
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bidirectional functionality of the LiveLink products for CAD as well as with the
File Import for CATIA® V5 add-on.

The DXF (2D), VRML (3D), and STL (3D) file types are available for import with
COMSOL Multiphysics and do not require any add-on products. Unless noted
otherwise in the table below, import of the listed file types is available on all
supported versions of Linux®, macOS, and Windows® operating systems.

FILE TYPE EXTENSION READ WRITE
AutoCAD®12:3 .dwg Yes Yes?
Inventor®1-2:3 .ipt,.iam Yes Yes?
Nx@! 4 .prt Yes  No
PTC® Creo® Parametric™ 13 prt,.asm Yes Yes?
PTC® Pro/ENGINEER®L-3 .prt,.asm Yes  Yes
Revit® Architectures’S .rvt Ye59 Ye59
Solid Edge®3-° .par, .asm Yes”  Yes”
SOLIDWORKS®12:3 .sldprt,.sldasm Yes  Yes®
DXF (3D1? and 2D) .dxf Yes  Yes!O
Parasolid®! X_t,.xmt_txt,.x_b,.xmt_bin Yes  Yes
ACIS®L .sat,.sab,.asat,.asab Yes Yes
S.TEP1 .step, .stp Yes No
IGES! .iges, .igs Yes  No
CATIA® v52.7 .CATPart, .CATProduct Yes No
VRML, vI8 .vrml, .wrl Yes No
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FILE TYPE EXTENSION READ WRITE

STL .stl Yes Yes

1Requires one of the LiveLink™ products for AutoCAD®, Revit®, PTC® Creo® Parametric™,
Inventor®, PTC® Pro/ENGINEER®, Solid Edge®, SOLIDWORKS®, CAD Import Module, or
Design Module

2Import supported on Windows® operating systems only

3Synchronization of files between COMSOL Multiphysics and a linked CAD program
supported on Windows® 7, 8, 8.1 and 10 operating systems only

4Import supported on Windows® and Linux operating systems only
5Requires LiveLink™ for Revit®
6Requires LiveLink™ for Solid Edge®

7Requires the CAD Import Module (or the Design Module or one of the LiveLink™ products
for AutoCAD®, PTC® Creo® Parametric™, Inventor®, PTC Pro/ENGINEER®, Solid Edge®, or
SOLIDWORKS®) and the File Import for CATIA® V5

8Limited to a single geometric domain

From/To file using linked CAD package, provided the original CAD geometry is created in the
CAD package

eriting to file is supported for 2D geometry only

ECAD

The ECAD Import Module allows for import of 2D layout files with automatic
conversion to 3D CAD models. The Touchstone file type is used for exporting
S-parameters, impedance, and admittance values from simultaneous port and
frequency sweeps. The SPICE Circuit Netlist file type is converted at import to a
series of lumped circuit element nodes under an Electrical Circuit node.

FILE TYPE EXTENSION READ WRITE
NETEX-G! .asc Yes  No
IPC-2581 " .cvg, . xml Yes  No
ODB++! .zip, .tar,.tgz,.tar.gz Yes No
ODB++(X)! .xm1 Yes  No
GDS! .gds Yes No
Touchstone? .s2p, .s3p, .s4p, ... No Yes
SPICE Circuit Netlist® .cir Yes  No

IRequires the ECAD Import Module
2Requires one of the AC/DC Module, RF Module, MEMS Module, or Wave Optics Module

3Requires one of the AC/DC Module, RF Module, MEMS Module, Plasma Module, or
Semiconductor Module
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MATERIAL DATABASES

The Chemical Reaction Engineering Module and the Plasma Module can read

CHEMKIN® files to simulate complex chemical reactions in the gas phase. The
Plasma Module can read LXCAT files for sets of electron impact collision cross

sections.

FILE TYPE EXTENSION READ WRITE
CHEMKIN®! .dat, .txt,.inp> Yes  No
CAPE-OPEN! (direct connection) n/a n/a n/a
LXCAT file? .1xcat, .txt Yes  No

IRequires the Chemical Reaction Engineering Module or the Plasma Module. The Plasma
Module only supports thermodynamic and transport data.

2Requires the Plasma Module
3Any extension is allowed; These are the most common extensions

MESH

The NASTRAN® Bulk Data file types are used to import a volumetric mesh. The
VRML and STL file types are used to import a triangular surface mesh and cannot
be used for creating a volumetric mesh. If imported as a geometry, VRML and
STL files can be used as a basis for creating a volumetric mesh for a single
geometric domain.

FILE TYPE EXTENSION READ WRITE
NASTRAN® Bulk Data .nas, .bdf,.nastran,.dat  Yes  Yes
STL .stl Yes Yes
VRML, v .vrml, .wrl Yes No
VTK vtu No  Yes

IMAGES AND MOVIES

Results visualization can be exported to a number of common image file types; See
the table below. Images can also be read and used as interpolation functions for
physics modeling. Animations can be exported to one of the Animated GIF,
Adobe® Flash®, and AVI file types.

FILE TYPE EXTENSION READ WRITE
Adobe® Flash® .swf No Yes
Animated GIF .gif No Yes
Avi! .avi No  Yes
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FILE TYPE EXTENSION READ WRITE

BMP .bmp Yes Yes
EPS (ID graphs only) .eps No Yes
GIF .gif Yes Yes
JPEG -Jpg, - ipeg Yes  Yes
MP42 .mp4 Yes  No
oGV? .ogV Yes No
PNG .png Yes Yes
TIFF Ltif, L tiff No Yes
WEBM? .webm Yes  No

| Available for Windows® only
2Available in the Application Builder, for Windows® only, in the video form object

PROGRAMMING LANGUAGES AND SPREADSHEET

Model files for Java® are editable files with the extension . java that contain
sequences of COMSOL commands as Java® code. Edit the files in a text editor to
add additional commands. You can compile these Java® files into Java® Class files
with the extension .class and run them as separate applications. Program code
used in model files for Java® is essentially identical to that of the Method editor in
the Application Builder. However, the Method editor comes with an integrated
Java® compiler.

Model files for MATLAB® are editable script files (M files), similar to the model
files for ]ava®, for use with MATLAB®. These model files, which have the
extension .m, contain a sequence of COMSOL commands asa MATLAB® M file.
You can run the model files in MATLAB® like any other M file scripts. It is also
possible to edit the files in a text editor to include additional COMSOL
commands or general MATLAB® commands. Running model files in the M file
format requires LiveLink™ fo MATLAB®.

With a license for LiveLink™ for Excel®, you can save models on the Visual Basic
for Applications (VBA) format for use with Excel®.

Compiled C-code can be linked with a model or application in several ways
including the External Material and External Function interfaces in the Model
Builder and as the External Library interface in the Application Builder.

FILE TYPE EXTENSION READ WRITE
MATLAB®: Model file for MATLAB® .m No Yes
MATLABR®: Function I .m Yes No
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FILE TYPE EXTENSION READ WRITE

Java®: Archive file . jar‘6 Yes No
Java®: Compiled model file forJava® .class Yes No
Java®: Model file forJava® .java No Yes
C: Function .dll3, .804, .dylib5 Yes No
Fortran7: Function .dll3, .so4 Yes No
Excel®? .x1sx, .vba Yes Yes

IRequires LiveLink™ for MATLAB®

2Requires LiveLink™ for Excel®, available for Windows® only

3 Available for Windows® only

4Available for Linux® only

3 Available for macOS only

®Can be linked to a method in an application using the Application Builder

7Requires a C-wrapper to the Fortran code and to include the C-code DLL as an External C
Library in the Application Builder: Alternatively, you can include a Fortran DLL directly as an
External C Library in the Application Builder. Note: You need to consider the naming
convention for exported Fortran function names. For example, in Windows®, it is typically
required that Fortran function names are in uppercase.

NUMERICAL AND INTERPOLATION DATA FORMATS

The grid, sectionwise, and spreadsheet file types can be read for defining
interpolation functions. The sectionwise and spreadsheet file types can
furthermore be read and used for defining interpolation curves and written for
exporting results. In addition, tables can be copy-pasted on spreadsheet format.

Parameters and variables can be imported and exported to the plain text,
comma-separated values, or data file types.

The continuous and discrete color table text file types are used for user-defined
color tables for results visualization.

Digital elevation model (DEM) files can be read and used as a parametric surface
for defining a geometry.

FILE TYPE EXTENSION READ WRITE
Copy and paste spreadsheet format n/a Yes Yes
Excel® spreadsheetl .x1sx Yes Yes
Table .txt, .csv, .dat Yes Yes
Grid Ltxt Yes Yes
Sectionwise .txt, .csv, .dat Yes Yes
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FILE TYPE EXTENSION READ WRITE
Spreadsheet .txt, .csv, .dat Yes Yes
Parameters .txt,.csv,.dat Yes Yes
Variables .txt, .csv, .dat Yes Yes
Continuous and Discrete color table Ltxt Yes No
Point data for Cut Point data sets Ltxt Yes No
DEM .dem Yes No
VTK -vtu No Yes
®

IRequires LiveLink™ for Excel®, available for Windows™ only
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Appendix E— Connecting with LiveLink™ Add-Ons

The following table shows the options to start COMSOL and the different linked
partner software using the LiveLink™ add-on products.

COMSOL® Can Start COMSOL Can Start Partner Software Can Connect
Software from Partner Software  from COMSOL Running Sessions
LiveLink™ Yes! Yes? No

for Excel®

LiveLink™ Yes3 Yes* Yes®

for MATLAB®

LiveLink™ No No Yes

for AutoCad®

LiveLink™ No No Yes

for Revit®

LiveLink™ No No Yes

for PTC®Creo®
Parametric™

LiveLink™

for Inventor®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

LiveLink™ No No Yes
for PTC®
Pro/ENGINEER®

LiveLink™ No No Yes
for Solid Edge®

LiveLink™
for SOLIDWORKS®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

'When you open a model from Excel®, a model window starts and a link is established
automatically. The model window is an output window that displays geometry, mesh, and results.

2A model that includes a table reference to an Excel® spreadsheet automatically starts an Excel®
process in the background when the model is run in the COMSOL Desktop environment.
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3 You can start a COMSOL Multiphysics server from a MATLAB® seSS|on using the system
command and then connect to it using mphstart in the MATLAB® command prompt.
“The - COMSOL with MATLAB®” desktop shortcut starts a COMSOL Muttiphysics server and
MATLAB® , then connects them automatically. When you run a COMSOL Muttiphysics model in
the COMSOL Desktop interface that includes a MATLAB® function (Global Definitions >
Funcﬂons) a MATLAB® engme and connection is started automatically.

3You can connect a MATLAB® SeSSIOh to a running COMSOL Multiphysics server using the
command mphstart in the MATLAB® command prompt.
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CAD Import Module 146, 180
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183
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command sequence 93
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overview 6
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opening 3/
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default feature 70
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Derived Values

defined 18
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Design Module 146, 180
DirectX 13
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documentation, models 26
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expressions
P sequence |46

Boolean 46 settings window 8

manual entry 48, 59
replacing 46, 82, 84

Geometry node 29
Global Definitions node 17, 20

units, specifying 48 functions 59

user-defined 45 parameters 59

External Process window 9

scope 22, 59
fillet 146 variables 2/
find global parameters 20, 37, 49, 59
parameters and variables 6/ expression 20
finite element graphics
mesh 42 rendering and hardware /3
preconditioning 5/ graphics object 89, 91
tetrahedra 42 Graphics toolbar
Fixed Constraint node 39 default view button 39, 45, 75, 84
Floating Network License /41 image snapshot button 86
Form editor 10, 90 zoom extents button 64, 8/
form objects 87 Graphics window 7, 9, 25
form union, geometry 63 geometry, and 35
frequency response |9 plot 43
frequency-domain study 18 rotate geometry 39, 80, 81
Full MPH files 27 selecting boundary 39, 40, 75
functions toolbar 7
advanced topics 98 using 35, 64
built-in 26 zoom box 40
mathematical 26 Ground, boundary condition 74
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H Heat Transfer in Solids interface
defining boundary conditions 71
multiphysics 58, 75
overview 70

Heat Transfer Module 115
Help window 10
opening |7
high performance computing 140
Home tab 15
HPC 140
hybrid parallelism 142

I Image Snapshot button 86
images, creating thumbnails 86
importing geometry 33, 34
infinite elements 30
information windows 7, 9, 25
initial conditions 8
Initial Values node

Electric Currents interface 7/
Heat Transfer in Solids interface 71
Solid Mechanics interface 38
input fields 88
Input Parameters
for part 161
Insert Object menu 92
Isosurface plot 79, 139
iterative solver

preconditioning 5/

) Javafile 30, 184
Joule heating
equations 70
multiphysics coupling 75
multiphysics interface 57

L Laminar Flow interface |18
Linux version |7
LiveLink™ add-ons 187
loft 146
Log window 9, 43

192 |

M Mfile 30, 184

macOS version |7
Material Browser
defined 10
material contents section 36, 67
material interface
mechanical contact 4/
materials
appearance, color and texture 69
copper 54
domains, assigning 67
model tree 29
settings window 8
steel 36, 45
titanium alloy 54
Materials node 36, 65
mathematical constants and functions
26
MATLAB® |84
Max/Min Volume plot 48
Maximum and minimum values table 85
MEMS Module
thermal expansion, and 106
mesh
convergence analysis, and 47
density 49
finite element 42
model tree, and 30
parameterizing 49, 77
physics-controlled, default 77
refining 49
settings 42
unstructured tetrahedral 77
user-controlled 50, 77
mesh element size
parameters, defining 20, 77
settings 42
message passing interface 142

Messages window 9, 43



method 95
application /|
model |1, 22
Method editor 10, 95
midsurface 146
modal tab 16
Model Builder ¢, 87
defined 10
example 29
expanding sections 70
geometry import 34
node sequence example 38
the ribbon, and 16
toolbar 6
window 24
model history 30
model method |/, 22
model tree 6, 24
building 17
defined 59
example 29
geometry 29
Global Definitions node 18, 37, 59
Materials node 29, 36
Model Builder 10
nodes |7
Results node 18
ribbon /6
root node |7
Study node 18, 30
Model Wizard
adding physics 18, 32, 57
Component node, and 18
creating a new model |3
custom studies 33, 58
opening 32, 56
preset studies 33, 58
space dimension 32, 56
study 18, 58

models
defining 10
discretization 42
documentation 26
saving 65
structural mechanics 3/
symmetry 81
workflow 29
MPH file 180
full and compact 27
saving 65, 87
MPHBIN file 180
MPHPHB file 180
MPHTXT file 180
MPI 142
multicore processors |40
multiphysics interface 58
multiphysics models 54
Multiphysics node 70, 71, 76, 108
multiphysics phenomena 54

Multislice plot 79

New Form wizard 87
no solutions stored, message 28
nodes |7

default feature 38

reordering 30

OpenGL 13
Override and Contribution 38, |14

parallel computing 140
parameters 20, 89
defining 49, 59
editing 63
expression 20, 49
global 20
meshes, and 49
name 49
range of values 5/
results 21, 138
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scope 59
using, referencing 73
Parameters node 59, 98
parametric geometry model 146
parametric study 59
parametric sweep 20
example 50
meshes, and 49
range, defining 5/
part 160
Input Parameters /61
Part Libraries 160
perfectly matched layer (PML) 30
physics
adding 57
boundary conditions 70
electromagnetic heating 57
heat transfer 57
Joule heating 54, 70
laminar flow [ 18
model tree 30
physics interface 14, 58
Electric Currents 58
Heat Transfer in Solids 58
Joule Heating 57
Laminar Flow 118
Solid Mechanics 32
Plasma Module 183
player 140
plot group /8
3D, adding 45
Plot window 24
plots
expression, user-defined 45
max/min volume 48
model tree 30
regenerating 49
surface 44, 46

windows 9

points, variables scope 22
Poisson’s ratio 67
polynomial functions 42
preconditioning 5/
preferences |2
preset studies 58
principal stress | /3
program code
model file for Java 30
model M-file 30
progress bar 10, 25

Progress window 9, 43
Quick Access Toolbar 6, 8, 16, 24

Record Code 97
renaming plot groups 46
rendering options 3
reports, defined /8
reserved name 26
resolution of curvature, mesh 78
results

color table range 80, 82

derived values 47, 51, 86

displaying 44

parameters 21/, 138

surface settings, modify 80

units, changing 44
Results node

3D plot group 48, 82

busbar defaults 79

subnodes /8

surface node, adding 82
ribbon 6, 24

Add Material 36, 69, 117

Build All 63

Build Mesh 78

Compute 51, 111, 127

defined 8, 15

example 6



importing geometry 34
Model Builder 16
Physics tab 39, 108
Windows 10, 44, 150
Work Plane 148

root node
default units 130
defined 17
model thumbnails 86
Model Wizard 32

running simulations 79

saving files 65, 87
scope
global definitions 59
parameters and variables 22
parameters and variables, defined 20
variable name 23
search
parameters and variables 6
Select Study window /5
selecting
multiple boundaries 109
selecting internal surfaces 42
selection 109
empty 40
Selection List window 10, 150
selection of geometry objects, domains,
boundaries, edges, and points 4/
Settings window 6, 8, 17, 24
shared memory parallelism /40
simulation, running 79
software rendering 13
Solid Mechanics interface 32
add-on modules 106
solvers
configurations 51
iterative 50, 51
stationary 43, 51
using 43

T

space dimension |4
Stationary study 33, 43
steady-state study 18
structural analysis 3/
structural displacement field 42
structural mechanics
design 47
plastic deformation 45
stresses and strains 54, 67
von Mises stress 44
Structural Mechanics Module
application library 3/
mechanical contact 4/
thermal expansion 106
studies
computing solutions 51, 79
defining 43
example, multigrid iterative 5/
example, stationary 43
model tree 30
preset 58
types 18
Study node 18
solution sequence 79
Surface plot
busbar results 79
color table range 83
deformation 44
electrical current density 81
replace expression 82
settings 46
updating 81, 82

table

Maximum and minimum 85
Table window 9

graph plot 52

wrench results 48
Tables node 18

tables, evaluating 52
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temperature 79, 127

temperature, average |3/

Test Application 91

tetrahedron, polynomial functions 42
thermal expansion 54, 67

thicken 146

thumbnail image 86

time-dependent study /8

torque, applied 31/

unit, changing 44, 112
update COMSOL Application Libraries
28
user interface
COMSOL Desktop 6
overview 6

user-controlled mesh 50

variables
advanced topics 98
built-in 26
example, built-in 52
expression 2/
scope 59
scope, limit 22
Variables node 21, 59
visualization 9
color table 80, 82
Volume Maximum, evaluating 48, 84, 86

von Mises stress 44, |13

Windows list 44, 150
wizard
New Form 87

workflow 26

yield stress 3/, 45

Young's modulus 67

zoom 128

Zoom Extents command 94
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